Picture-Perfect Macintosh Charts

Microsoft's powerful new Chart program makes one picture worth a thousand numbers. An in-depth review and tutorial.

The Lisa 2 Connection

Macintosh Goes to College

Working with a Single-Drive Mac
First there was the Starwriter 40 CPS by C. Itoh, one of the world's most popular letter-quality printers. And deservedly so. Because it gives you more of just about everything than any other printer in its price range (mid teens). And it churns out copy at a very brisk 40 characters per second, or about half a minute for an average business letter.

Now, there's the Starwriter 18 CPS. It takes after its father, in that it's simply the finest printer you can buy for anywhere near the price—which in this case is just about half what Daddy charges.

The only major difference is speed. Instead of 40 characters per second, this Starwriter trouts along at just over 18 cps—which costs you about 30 seconds per average business letter.

But it retains the rest of the family resemblance: like low profile and low noise, plug-in compatibility with just about any serial or parallel microcomputer on the market, making it a perfect companion in a typical office environment.

And perfect for typical office chores: like letters, memos, announcements... in fact the vast majority of stuff that can afford to wait a few seconds to get typed.

Enough said?

If not, then this the Starwriter 18 CPS gives you crisp, letter-quality copy including boldface, underlining, sub and superscripts with your choice of friction feed or optional tractor feed for precise print positioning of tabular and graphic data, using easily available industry-standard ribbon cartridges and long-lasting plastic daisy wheels.

But it also gives you something that's far from industry-standard.

A full-year warranty.

And for a mere half-a-minute per letter.

We think it's well worth the wait.

Marketed exclusively by Leading Edge Products, Inc., 225 Turnpike Street, Canton, MA 02021, 1-800-343-6833 in Massachusetts (617) 828-8150.
TECMAR’S CANDY™ APPLE LINE
BEGINNS HERE WITH PERIPHERALS FOR MACINTOSH®

APPLE JACK™ WINCHESTER
Relax with more disk storage.
5 MByte Removable Cartridge Winchester.

APPLE FRITTER™ MODEM
A delicious addition to your Apple.
300 or 300/1200 baud modem with touch-tone decoding, pulse/tone automatic dialer and full voice interface so all the features of a full-feature telephone and modem are provided in one MacIntosh peripheral.

APPLE COBBLER™
PRINT BUFFER
To sweeten the end of a job.
The user no longer needs to wait for a print-out before beginning to program again.

CANDY APPLE™ IEEE488
Interface to the GPIB.
For use in industrial control applications.

*Trademark of Apple Computer, Inc.

Above products will be available in the spring of 1984.
Getting Started

28  The Compleat Disk Juggler
    Andrew Fluegelman
    These practical work routines will help you use your single-drive Mac more efficiently.

38  Clean Up Your Electronic Desktop
    Daniel Farber
    Tips for organizing and managing disks and files on the Mac.

48  Get Info
    Lon Poole
    Macworld's tutor answers questions from readers about the Mac.

State of the Art

52  The Lisa Connection
    Lon Poole
    How Apple retooled the Lisa series and made it compatible with the Mac.

66  Redefining User-Friendly
    Edited by Daniel Farber
    The Macintosh user education team discusses the theories behind the Mac's manuals and Guided Tours.

Review

72  Exploring Microsoft Chart
    Andrew Fluegelman
    This in-depth review takes you through the first presentation graphics program to run on the Mac.

86  Macintosh Pascal Preview
    Lon Poole
    A look at a new, instant Pascal, the likes of which you've never seen.

92  Macware News
    Edited by Bertie Nielsen
    Announcements of the latest developments in Macintosh hardware and software.
Hands On
96 Presentation Graphics Primer
Steve Lambert
Learn how the components of a chart can clarify your thinking and influence your audience.

104 Creating a Custom Chart Format
Andrew Fluegelman
A tutorial that takes you beyond Chart's preformatted options.

110 How the Macintosh Works
Cary Lu
An excerpt from The Apple Macintosh Book explains how the Mac processes information.

116 Open Window
Edited by Daniel Farber
An exchange of Macintosh discoveries.

Columns
8 The Macintosh Magazine
Andrew Fluegelman

11 The Next Wave
David Bunnell

12 Note Pad
Charles Spezzano
An IBM PC Lover Meets the Mac

19 Letters

22 Macworld View
Edited by Janet McCandless
News and notes for the Macintosh community.

143 World Events
Edited by Erfert Nielson
A calendar of regional and national events.

Index
144 Advertisers Index

Unlock the Mac's secret characters and add special graphics to your work. See "Open Window" on page 116.

Photo/illustration credits
Jeffrey Aaronson, 23; Apple Computer, Inc., 22-26, 125; David Bishop, 111; Susan Kare, 39; Ed Kashi, 8, 11, 48, 67, 123; Bruce McAllister, 12; Will Mosgrove, 29; Jeffrey Newbury, 26, 68-69, 131, 135; Fred Stinson, cover, 53-60, 128-129; Mick Wiggins, 24.
CUSTOMER CLOSING STRATEGIES

WHAT TO EXPECT:

- You will find many interactions with Mr. J.R. difficult. You are involved with plans and ideas. Mr. J.R. is concerned with his own inadequacies. You perform well under stress while his performance deteriorates markedly. You think upon projects and use initiative to carry them through. He will worry excessively over difficulties and be unable to take action.
- You welcome the opportunity to be creative and work independently. Mr. J.R. prefers to work under an authority with daily routines involving concrete details. You enjoy status and monetary rewards. He prefers to be recognized for hard work.
- Exercise caution when dealing with this person. Behave in a reserved manner, use a soft voice and always avoid threats or criticism. Remember, Mr. J.R. is uncomfortable in groups. He is a hard worker, but needs quiet praise.
- CUSTOMER PREPARATION STRATEGY

PREPARE INFORMATION IN DETAIL:

- You tend to focus on the "big picture" while Mr. J.R. is more concerned with details. Prepare to give a relatively detailed presentation. The actual amount of detail you present depends on the level of detail Mr. J.R. introduces in the needs analysis phase of your meeting.
- CUSTOMER CLOSING STRATEGIES

IT'S THE LITTLE THINGS:

- Get your customer to agree on the details and minor points of the sales agreement. It is not necessary to ever mention the sale itself. Focus on delivery, service and color choice as a way to close the deal.
- The reason for using the "it's the little things" strategy with Mr. J.R. is that he is very sensitive to establishing a sense of agreement. By agreeing, even on a relatively small aspect of your business, he will feel more secure and more ready to close.
- Additionally, because Mr. J.R. becomes over-anxious in response to smaller decisions, working on peripheral details will help him be more relaxed...

Personal power in a printout.

That's what Human Edge™ Software gives you (see full story at right).

This typical excerpt from The Sales Edge™ gives you specific strategies to make every sales call count. The complete printout is a detailed 3–10 page analysis of your business situation.

The Sales Edge is available for the Macintosh® computer.

*Human Edge and The Sales Edge are trademarks of Human Edge Software Corporation.

**Macintosh is a registered trademark of Apple Computer Inc.
Introducing Business Strategy Software: Personal power with a stroke of genius.

It takes more than hard work to stay on the fast track. It takes personal power. Power to communicate. Negotiate. Manage. Power to be a leader.

Personal power isn't just a job skill. It's a career necessity.

**Tactics, not numbers.**

Introducing Human Edge,™ the first software family that builds your personal power. Because it helps you manage people, not just words and numbers.

Guided by a vast bank of research on people management, Human Edge asks pertinent questions about you and those your business decisions will involve. It can actually evaluate the human factors that affect your decisions. And give you the best tactics to stack those factors in your favor.

**Can software get you a raise?**

It even lets you practice with simulated situations, testing different tactics and comparing their outcomes. For the first time, your IBM® or Apple® personal computer becomes an expert consultant, preparing you to get exactly what you want. Whether it's asking for a raise, negotiating a contract, or boosting employee performance.

**You can't get personal with a cassette.**

Human Edge isn't just the floppy disk version of a one-time seminar, management text or cassette.

It's a highly creative career tool you tailor to your own management style, your own real-life problems. To guide you through the business jungle with step-by-step strategies. In plain English. In minutes.

Human Edge Business Strategy Software. Because personal power is the way to make your mark.

Call (800) 624-5227, in California (800) 824-7325, for the dealer nearest you. It's the next step on the fast track.

**HUMAN EDGE**

Human Edge Software Corporation, 2445 Faber Place, Palo Alto, CA 94303

---

The Communication Edge™ Find strengths and weaknesses, improve performance.

The Leadership Edge™ Improve powers of group leadership and motivation.

The Management Edge™ Evaluate and improve supervisory skills.

The Negotiation Edge™ Analyze critical factors. Develop "how to" plan.

The Sales Edge™ Sharpen techniques, sensitivity to prospects.
Apple's new baby has

It's called Macintosh™. And it has our brains and a lot of our personality.

We're called Microsoft.® And our part of Macintosh is five new programs that are bright, intuitive, outgoing, understanding and born to perform.

Our pride, your joy.

Taking advantage of Macintosh's mouse and rich graphics, we've designed software that works like you, even thinks like you.

All our programs share the same plain English commands. So what once took days to learn, now takes hours or minutes to learn with Macintosh.

Meet the family.

Our financial whiz is MULTIPLAN,® an electronic spreadsheet that actually remembers how you work. Even offers suggestions on spreadsheet set-up.

When it comes to writing, nothing travels faster...
our best features.

than our WORD. Using the mouse, it lets you select commands faster than you can say "cheese."

Our most artistic child is CHART. It gives you 40 presentation-quality chart and graphic styles to choose from.

FILE is our most manageable child, an advanced personal record management program.

And BASIC, the language spoken by nine out of ten microcomputers worldwide, is the granddaddy of them all. Now enhanced to take advantage of the Macintosh mouse, windows and graphics.

We'll be adding more to the family soon. So call 800-426-9400 (in Washington State call 206-828-8088) for the name of your nearest Microsoft dealer.
Andrew Fluegelman

The Macintosh Magazine

The Mac lends a hand in publishing.

During the days when we were planning this magazine, a number of my publishing and computer colleagues asked me whether Macworld would be different from other computer journals. I never hesitated to respond affirmatively. Macworld could not help being influenced by the unique computing style of the Macintosh; it would certainly be “different.”

To be honest, that response came more from my gut than from my head. I could sense the direction a Mac magazine should take, but I knew that any real publishing innovations would have to evolve as we made discoveries about the machine. We did, of course, sit down to create an editorial and graphic structure for Macworld, but our guiding principle was, “Stay open. See what ideas emerge from playing with the Mac.”

Now that we have completed our second issue, we realize that Macworld is already unlike any magazine we’ve worked on. Some of the new ideas should be apparent as you flip through these pages, but other changes have gone on behind the scenes. As predicted, the prime mover has been the Mac itself.

First, the obvious: you’ll notice that Macworld is a bit wider than most magazines. We didn’t choose our 9-by-10½-inch format just to be different—we wanted to have the option of reproducing Mac screens in their full size. And our matte-finish paper has caught many eyes. The decision to use it was inspired by the clean, black-and-white look of the Mac screen, as well as by our commitment to quality graphic reproduction.

Good intentions would be futile without good tools, however. Fortunately, Apple gave us a fantastic tool in the Macintosh and, in particular, the Mac’s “snapshot” system. Reproducing screen images on previous computer systems was a major chore that never resulted in satisfactory images. With the Mac, producing quality images of the screen requires no more than a simple keystroke combination (Shift-96-3, if you haven’t discovered it). What’s more, those snapshots are MacPaint files that can be edited and ultimately sent to a typesetter and returned as razor-sharp “repro” copy. This feature has revolutionized our work as writers and editors.

We quickly saw the value of including screen shots to document our written tutorials and to support the text of product reviews. They convey information much more accurately (in a pictorial language all Mac users understand) than lengthy descriptions of keystroke sequences.

Producing those snapshots has become a new editorial skill. It’s no longer necessary (or acceptable) for a writer or an editor to leave illustrations to the art department. We still stress good, clear writing, but all our editors and authors are instructed to “think graphics.”

We also try to find uses for new Macintosh tools as soon as they become available. A striking example is Microsoft...
Chart, just released and covered in depth in this issue. While writing my review, I found the program so compelling that I used it to create the charts that illustrate some points in my article on working with a single-drive Mac. The idea for those charts arose directly from access to the tool used to make them.

As the editorial department has assumed greater responsibility for graphics, the art department has become more involved with the computer. Our art director, Bruce Charonnat, now uses the Mac as his primary graphics tool, and you can see the results on virtually every page.

After only two issues, *Macworld* is integrating text and graphics in a way that has not occurred in a magazine before. I'm not referring just to integration on the printed page, but to integration of our editorial and production processes. For example, we editors used to submit the copy for cover type to the art department as a printed list. Now we can use *MacPaint* to create a dummy of the entire cover. We play with type possibilities right on the dummy and produce instant cover composites for final review by the publisher, editor, designer, and newsstand sales director. This practice not only facilitates tailoring the type to the cover's graphic design—it has resulted in closer working relationships among the various departments of our magazine.

In the premier issue of *Macworld*, I predicted that the Macintosh would change the way we think about written communication. We're witnessing that change firsthand. *Macworld* has become "The Macintosh Magazine" in process as well as subject matter. And we've just begun. □
Learn to use your Macintosh almost as fast as you can eat one.

Soon after Macintosh joins the Apple family tree we'll have an ATI training program ready to teach you how to use it. ATI's "How to Use Your Macintosh" training disk and handbook will join our rapidly growing "how-to" series. We'll also have training programs for all the best software available for Macintosh.

All ATI training programs take you through the basics, step-by-step. Our interactive simulation method lets you practice as you learn. It's simple and fun!

Congratulations Macintosh! Together we'll help users- and dealers- bear fruit fast.

Contact ATI, 12638 Beatrice Street, Los Angeles, CA 90066 (213) 546-5579.
Dealers: Call (213) 546-4725.

ATI Training Power™ is a trademark of American Training International

 ATI Training Power™ Learn software the natural way.
In the brief but eventful history of personal computing, the introduction of a new product has never generated such massive publicity as that of the Macintosh.

First there was Apple's "1984" commercial, a risky but masterful stroke of showmanship that will go down as one of the most effective television commercials of all time. As someone told me, if Apple hadn't done the commercial, "they would have missed $60 million worth of free publicity."

The Mac has been featured on at least a dozen magazine covers. Virtually every publication from the New York Times to Computerworld has reported on it with keen interest.

Then came announcement day at the annual stockholders' meeting on January 24, when the Mac was officially unveiled. Being in that auditorium in Cupertino, California, seeing Steve Jobs coolly unzip the Mac's carrying bag, remove the machine, and plug it in, and seeing it operate publicly for the first time was being in on the action.

According to Steve Jobs, on the day following the Mac's announcement, over 200,000 people went to computer stores nationwide to check out the machine. In some locations, they even waited in lines outside stores crowded to capacity.

Much of the attention given to the Mac is inspired by the machine itself, though it is also focused on the battle between Apple and IBM for the personal computer market. Does the Mac present a threat to the dominance of the IBM Personal Computer? Will Mac sales eat into PC sales, or will the Mac simply inspire a new market? The Apple/IBM "battle" is interesting copy; however, the actual bloodletting is elsewhere.

This year's real personal computer battle is between IBM and the so-called PC-compatible companies, as Big Blue gears up to crush its many imitators. The recent introduction of a portable IBM PC is aimed more at them than at the Mac.

The current configuration of the Mac makes the machine attractive to personal computer buyers who have different needs than those of IBM PC owners. For example, the IBM PC seems destined to capture the desktops of Fortune 1000 companies, while the Mac seems destined to become the computer of choice in American universities.

If Apple is to share the personal computer pie with IBM, there will have to be rapid creation of a substantial Mac software library. Otherwise, the PC's huge software base will compensate for its slow processor speed and less than perfect screen resolution.

The Mac offers software authors exciting new challenges. In using Mac icons, for instance, they will be creating a new icon language. If the icon language becomes reasonably standardized, the symbols may conceivably be intermingled with standard alphanumeric characters to form a new hybrid language. Fantastic as it may seem, possibilities of this magnitude exist.

Besides the lack of a broad software base, one initial shortcoming of the Mac is that the print quality of its currently one-and-only printer may not prove suitable for business letters. And its relatively slow print speed may be a problem in a busy work environment.

The Mac will have to be interfaced to a daisy wheel letter quality printer if it is to get a share of the personal computer pie. A print buffer is also in order, as well as 512K of internal RAM and other upgrades and additions.

We can expect all these Mac additions. One thing is certain: the Mac has inspired an army of programmers, engineers, and writers who will give Apple the initial momentum it needs to create the next wave of personal computing.
Since IBM introduced the PC in 1981, I have paid little attention to the world of Apple computing, and I have probably displayed more than my share of PC snobbery—based, of course, on the reasonable conclusion that I owned a state-of-the-art machine and that the Apple II was merely an expensive toy.

When I started shopping for a personal computer, I was looking for a lean, mean, professional machine. I wanted a computer for connoisseurs, the kind made by the company that took over the mainframe market 20 years ago with "the world's best sales force, all dressed in white shirts and blue suits," as Tracy Kidder described it in *The Soul of a New Machine* (Avon, 1982). That narrowed it down to IBM and IBM. So I bought a PC and turned my back on the enormous base of application software available for the Apple II line.

For a long time, I had no regrets. Oh, there were moments when laughter and a feeling of light-heartedness drifted my way from the Apple corner of my local computer store while I examined the growing software selection on the IBM wall. That was mildly attractive. After all, there is nothing funny about anything from IBM. The original PC didn't even come with a graphics monitor. All business. But as a professional psychologist, I can choose my rationalizations to fit any occasion, and I just told myself that the laughter was no more than the childlike exuberance of game-playing Apple owners who would never know the adult pleasures of putting 1-2-3 through its paces with keyboards on their laps.

Even the Lisa didn't sway me. Sure, she had power, versatility, and great moves, but at $10,000 no one was laughing. Then one day in late January, I wandered into a computer store and had almost strolled by the Lisa, when I noticed that she had shrunk. She was also smiling at me—a cute, little iconish face on a black-and-white screen. Assured that no one from my local PC users' group was watching, I slunk down into the empty chair and took my first look at the Macintosh.

Within 20 minutes I realized that I was only 10 feet from the door and that the little machine I had been enjoying didn't weigh more than 20 pounds. No, I didn't steal it, but the point is I wanted to. For the first time since sitting down in front of those crisp, clean characters on my PC's monochrome monitor, I had been seduced by a competitor.

**Entering the Cool Zone**

By this point, all you Apple II and Ile owners who are considering a Mac are supposed to have forgiven me for looking down my nose at you for those two years. And you PCers who have this magazine hidden in-
side your copy of *PC World* are lusting to know what it was that stole my heart that day. Well, I won't be coy. It wasn't the mouse.

It was the coolness. During the past two years, I have spent a lot of time in front of green, amber, and color monitors. They make me hot. I'm not talking about excitement or eye-strain. I'm talking about a whole-body sensation, the kind you get from sitting in a Fourth-of-July weekend traffic jam in a convertible with black upholstery. That's what those bright little characters against dark backgrounds do to me after a couple of hours.

After the first half hour with the Mac, I thought something was wrong. Somewhere around the 90-minute mark, I realized that what was wrong was that nothing was wrong. No heat rising behind my eyes, no tight back muscles, no fantasies of Finnish ice baths distracting me. I was cool. An hour and a half in front of a computer monitor, and I was still fresh, excited, and ready for more. That light gray screen with its crisp black text is worth three color monitors.

**Flashdancing with the Mac**

Someone had actually taken the time to think about what might make a human being feel good while working with a personal computer. That someone had also put a lot of thought into making me a potential buyer. So far, all I had done was try my hand at writing a report with *MacWrite*. That's right, with an electronic easel and a brand-new mouse at my fingertips, I had gone straight to work. A dyed-in-the-wool workaholic, I figured I might as well get a report or two out of the way while familiarizing myself with yet another word processor. Having reviewed ten IBM PC word processors over the past year, each one accompanied by more over-hyped promotional literature than a John Travolta movie, the last thing I expected to get a thrill out of was the Mac's writing tool.

Forgive my jaded ignorance. Writing with the Mac is not word processing at all. It's "flashdancing" for writers. Your words are fully alive on the screen the way they are in a well-designed magazine. And it's more than being able to see margins, indents, line spacing, underlining, and boldfacing the way they appear on paper. You realize that you are the architect and interior designer of every page of text, arranging and rearranging the shape, the style, and the placement of your words, and even fusing them with pictures until they convey the exact meaning and emotional tone you intend.

**Fake Right, Go Left**

If I always knew ahead of time where my writing was going, I probably wouldn't use a personal computer at all. I'd dictate my articles while driving to the health club and save my fingers for caressing my wife and hugging my kids. My style, however, is to write five words and then change seven, as Dorothy Parker described writing.

How a word processor deletes is as fundamental to me as how it lets you enter text. You can judge the personality of a computer writing system by how it removes what you no longer want. Some restrict you to picking lint off a blue blazer—letters have to be erased one by one with the delete or destructive backspace key, because the only other option is to kill whole lines at a time. This is usually impractical, since many lines contain text from the end of one sentence and the beginning of another. With other systems, your only alternative to nitpicking is to clean away large mistakes like a sentence or a paragraph and then reenter a whole new one, when all you want to do is quickly replace a descriptive phrase or a subordinate clause with a tighter, more clever expression that just popped into your head. *MacWrite* gives you unlimited control over the deletion process.
To Change or Not to Change

Another example of the Mac's impact on your writing attitude is the way it handles a typical writer's constant indecision about whether to delete something in the first place. Many professional writers and writing professionals are not sure whether they like the new phrase better than the old one until they see it in context. With many word processors, however, once you see the new words, the old ones are gone forever. Some PC word processors have an "Oops" key, which lets you restore the text you have just deleted, but they often have an additional rule that you may not press any keys between deleting characters from the screen and pressing the "Oops" key. This kind of system does not allow you to be so cavalier about making changes. MacWrite avoids these inhibiting "no backs" limitations with an unusually versatile Undo command combined with equally versatile cut and paste functions. You can restore a recent cut, take back an insertion in midstream, or even Undo your last Undo.

Gallery One

My artist wife has been toying with the idea of expanding from pen-and-ink sketches to computer-generated art for a year, but shopping for the right combination of drawing device, software, and printer for our PC has proven to be quite a job. If we'd had a Mac and MacPaint for two years instead of a PC, by now she'd have produced enough art to have opened Jill's Black-and-White Gallery, and the Mac comes with everything we'd need to team up for a renaissance in illuminated manuscripts. It would be ironic if we started writing parts of our IBM PC software newsletter on a Mac just to liven it up with creative fonts and illustrations.

Not All Fun and Games

The Mac is a lot more fun than my businesslike PC. It is not priced like a toy, however. It costs more than $3500 with a printer and a second disk drive, and when Apple offers upgrades to 256K RAM chips (which would add greatly to the system's flexibility) and 800K disk drives, we will be talking about a $5000 investment. The only toy I would spend four or five grand on, however, is a car—maybe a well-kept old Alfa.

When I raised that issue with a local Mac salesperson, she quickly produced the Mac version of Multiplan, Microsoft's popular electronic spreadsheet. Nothing makes a personal computer look less like a toy and more like a business tool than a spreadsheet.

Spreadsheets, however, are my least favorite type of software. They conjure up images of Bob Cratchit slaving away late into Christmas Eve, balancing Scrooge's accounting ledgers. They intimidate me, partly because I generally prefer playing with big words rather than big numbers, but also because whenever I have tried one on my PC, I have always come away feeling that I missed something.

Multiplan à la Mac is the spreadsheet I have come closest to genuinely understanding. The pull-down menus, the mouse-selected cells, and the dialog boxes that "talk" to me when I am in trouble—all these features unique to Mac spreadsheeting changed my image of this category of software from intimidator to helper.

Love and Money

I am the kind of person who thinks about buying a new car as soon as the payments are made in full on the last one. Owning an IBM PC did not preclude my ogling the hundreds of new systems released during the past two years. Becoming a two- or even three-computer family is right up my inflationary alley, but aside from the Radio Shack Model 100, there hasn't been anything different enough from my PC to tempt me to add another monthly payment to my list of debts.

Meeting the Mac did not make me want to trade in my PC. In fact, I'd like to upgrade it to an XT to make it even more businesslike. It will, however, remain on my work desk in a quiet corner of the house. The Mac will probably sit in the living room where everyone can fall in love with it. □
Whether you own an Apple® Macintosh™ or are thinking about buying one, The Apple® Macintosh™ Book provides you with a unique insider's view to this historic advance in computer technology.

Cary Lu, formerly executive editor of High Technology magazine, takes you behind the scenes with this step-by-step guide to how the Mac and its software work. You see exactly what you get— all in the friendly visual style of the Mac itself.

Cary observed the development of the Mac firsthand, sharing the excitement of its evolution with its designers and programmers at Apple and at Microsoft. In The Apple® Macintosh™ Book he reveals the secrets of the Mac philosophy. And invites you to share the Mac experience.

The Apple® Macintosh™ Book from Microsoft Press: 10700 Northup Way Bellevue, Wa. 98004

$18.95 at book and computer stores everywhere.
Introducing

MACWORLD

The Macintosh Magazine

The Exciting New Magazine for the World's Most Creative Personal Computer—The Macintosh

At Special Charter Subscriber Rates
Save Up to 54% Off the Newsstand Price*
(*when you subscribe for 3 years)

Personal computing took a giant leap into the future when Apple introduced the Macintosh. We've created Macworld as your passport into this incredible new realm of computing. Each issue we'll bring you everything you need to explore and get the most out of your Macintosh. From the latest product news to innovative business applications, from amazing graphics to personal productivity tools and games, each issue of Macworld will be packed with interesting, practical, readable information written by skilled, perceptive writers.

Each month we'll be creating a Macworld community; sharing ideas, problems, and creative solutions while we explore the world of Macintosh together.

So why take a chance on missing a single exciting issue? For a limited time only you can subscribe to Macworld at special Charter Subscriber rates of only $24 for 1 year (12 issues)

That's a savings of 20% off the regular $30 subscription rate and 50% off the newsstand price!

And you can save even more by subscribing for 2 or 3 years at Special Charter Rates. Don't Wait...Subscribe Today and Save!
I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ________________________________

Company ________________________________

Address ________________________________

City, State, Zip ________________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S., subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

$24
Special Charter Offer

Order Now to Take Advantage of This Limited Time Offer!
VISA and MasterCard Accepted! Call TOLL FREE: 800-247-5470 (in Iowa 800-532-1272)

Macworld will be published in May, July, and September 1984 and will begin monthly publication in November 1984.
How to get your Macintosh programs to market. Quickly.

Call Data Encore. We’re already duplicating 3½″ microdisk software for the Apple® Macintosh™ system. So we’re up to speed and ready to go.

As a subsidiary of Verbatim, the world’s leading producer of flexible disks, we’re one of the few companies with 3½″ duplication capabilities. From raw materials to disks to packaging to delivery to your customers. This total responsibility ensures you of a quality product you’ll be proud to call your own.

Why not call us toll-free at 800-872-8778. In California or outside the U.S., call collect (408) 720-7400. Or write us at 585 N. Mary Avenue, Sunnyvale, CA 94086. Because if you want to harvest profits from the new Macintosh faster, you’ll want to get your software to market fast.

Data Encore™
a Verbatim Company
The Maccessories SWIVEL  
is a light weight, durable lazy susan that fits neatly under your Macintosh. The SWIVEL revolves a full 360° and lets you adjust the viewing angle of your Macintosh with the touch of a finger. Since the SWIVEL attaches to the bottom of your Macintosh computer, it goes everywhere your Macintosh goes, even inside the Macintosh carrying case.

The Maccessories SURGE SUPPRESSOR  
protects your Macintosh against power problems. Its circuitry stops surges and spikes, and filters out aggravating line noise. Simply replace your Macintosh power cord with the Maccessories SURGE SUPPRESSOR and you’re ready to go.

Maccessories STARTER PACK. Start your Macintosh off right with this money-saving kit containing the SWIVEL, SURGE SUPPRESSOR plus an anti-static DUST COVER to keep your Macintosh dust-free.

More on the way!  
If you like the Maccessories we’ve come up with so far, wait till you see what we’ve got in the works.

Maccessories are exclusive products of Kensington Microware, at Apple dealers everywhere.
Letters

Programmer's Praise
I want to congratulate you on your new magazine. Macworld has an attractive layout; I especially like its wide format and larger-than-usual type. It's nice to see a computer magazine that has such a generous ratio of editorial content to ads, but maybe you're not as pleased as I am with that.

As a would-be software developer, I enjoyed reading about Apple's efforts to attract developers. It's a welcome idea to provide a user interface—in ROM no less. Your report on the desktop environment made me want to run out and try it ["A 'Tour of the Mac Desktop"].

A standard user interface will make a big difference in writing programs, but as your writer admits [Lon Poole, "The 64K Treasure Chest"], one really needs a Lisa too to create a large software program because the Macintosh has no programming languages of its own yet. Any idea when they'll start showing up?

Barry Rapf
Baltimore, Maryland

For a look at one new programming language for the Mac, see "MacPascal Preview" in this issue. Future issues of Macworld will report in depth about programming on the Mac and the Lisa 2s—Ed.

Multiplan Warning
There appears to be a serious bug in version 1.00 of Micro­soft's Multiplan. Don't use the "shortcut" method to save your document: if you choose Quit from the File menu and rely on the alert box to ask to save changes, your worksheet will be permanently garbled.

Danny Goodman
Pacifica, California

We contacted Microsoft and they confirmed this bug. The company has released a new version (1.01) of the program, in which the bug has been fixed. Purchasers of version 1.00 who returned their registration cards should have been notified by Microsoft about the procedure for updating to version 1.01. If you're still using version 1.00, you can avoid corrupting your worksheets when saving them by following these steps:

• Make sure the Clipboard is empty by selecting an insertion point and choosing the Cut command.
• Save the worksheet using the Save or Save As command from the File menu.
• Do not save the worksheet by using the Quit, New, or Open command.—Ed.

Hacker's Lament
Apple sure has its nerve! What are they trying to do here? I have spent years becoming a Lord High Hacker. I tweaked the front panel switches, learned the mysteries of PIP, format/s/B, init hello,s6,d2, Debug or DDT for WordStar patches, and the assembly of many strange numbers. My friends and neighbors looked upon me with awe. I almost learned octal, of all things.

And now people are doing useful work with this Mac after only a few minutes, with absolutely no training. I think this computer stinks.

By the way, please enter my subscription.
James F. Shobert
Commack, New York

A Dearth of Software
I am using my Macintosh in my daily work as a technical writer and sincerely regret the immediate lack of software. I still have to use my old TRS-80 Model 100. I hope the software becomes available soon. Otherwise, I am sure this lack will have an impact on Macintosh sales in the future when the bloom is gone.

Fred Wilkinson
Santa Clara, California

More than 100 software companies received Macs from Apple before release, and major companies currently working on software for the Mac include Microsoft, Lotus Development, Software Publishing, Continental Software, Ashton-Tate, and Sorcin. More software will be appearing during the next few months.—Ed.

A Mac Drawback
I had never used a computer (never needed or wanted to) before I recently tried out a friend's brand-new Macintosh. He had been telling me how "friendly" the machine was supposed to be, but he is fond of computers anyway. Only when I turned the pages of the first issue of Macworld did I start getting interested.
The “impressions of a novice” [in Note Pad] appealed to me, and Jeffrey Young is right—the Mac’s desktop does arrange things the way we “pre-computer” types do.

I’m a writer and have almost finished a rough draft of a book on American history. After familiarizing myself with the Mac, I put my prospectus into a file. Revising it—moving the insertion point with the mouse and erasing typos with the Backspace key—was a snap, since I didn’t have to type and retype or use that messy correction fluid. And by mixing fonts and styles, I created a very artistic format.

The major drawback for my purpose is the lack of storage on the Mac’s single-sided disks. Although I can split the work up by chapters (or smaller files), it would be nice to carry the whole book around on one little disk.

Still, I’m sold on the Mac as a personal word processor. And I can’t wait to find a way to sneak MacPaint into my work.

Glen Epstein
Iowa City, Iowa

See “The Compleat Disk Juggler” in this issue for some solutions to your problem.—Ed.

Mac CAD
My primary interest in any computer is its use in CAD (computer-aided design). I have some questions regarding the use of peripherals such as digitizer boards and plotters.

At the present time, the Apple II and III series has available any number of those units. However, they are not totally menu-driven; all drawing must be originated using X-Y coordinates.

The discussion of the Mac’s graphics (“MacPaint: the Electronic Easel”) seems to indicate infinite possibilities with present software; however, there was no indication that the screen image could be transferred to a specific scale (e.g., imperial architectural, imperial engineering, or metric) to produce “scaled” printouts or plots.

In addition to the graphics available, a CAD program would also require a menu for windows, walls, toilets, appliances, etc. Can those symbols be created or are software companies anticipating them in the near future?

Combined with the mouse, a digitizer board, and a plotter, the system could provide a powerful tool at a minimal cost.

E. "Manny" Abraben
Fort Lauderdale, Florida

Apple’s forthcoming MacDraw (second quarter 1984) will enable you to draw the architectural symbols you mention and will provide on-screen rulers that can be set to specified scales. We know of no other architectural or engineering programs under development at this time, but watch Macware News for previews of Mac software and peripherals.—Ed.

User Groups
I realize that the Macintosh is hot off the assembly line, but I’d like to know if there are any user groups in my area. I found your premier issue interesting and informative, but I want to have more direct contact with my fellow Mac users. Do you have any information on this?

Susan McPhee
Chicago, Illinois

To assist individuals in locating Macintosh clubs, the International Apple Core will send current listings for clubs that have formed or are being formed. To obtain information on clubs in your area, or information on setting up a Macintosh club, send a self-addressed, stamped envelope to Macintosh, International Apple Core, 908 George St., Santa Clara, CA 95050, 408/727-7652. Macworld will report on user group activities in future issues. We encourage user groups to submit copies of their newsletters, article suggestions, hands-on tips, and drawings.—Ed.

Letters should be mailed to Letters, Macworld, 555 De Haro St., San Francisco, CA 94107, or sent electronically to CompuServe 74055.415 or Source STE908.
If you're looking for a premium modem without a premium price, here's a word of advice: Apple.

Introducing the Apple Modem 300. And, to keep up with the business world, our faster Apple Modem 1200.

Inside, they're packed with all the technical wizardry you would want in an intelligent modem. Auto-dial. Auto-answer. Built-in error diagnostics. And compatibility with all the latest advanced communications software.

But the real message is located outside, due north of the little green light.

That one familiar symbol tells you as much as a gigabyte of specs. It says Apple quality, Apple technology. And in the unlikely event you should need it, Apple service.

It also means total compatibility with whatever Apple you own. Particularly since we include the right accessory kit to get any system in our line on line. Immediately.

We even give you a subscription offer to THE SOURCE™ and a free demonstration of Compu-Serve®. Together, they let you access almost any subject known to mainframes.


And since the computer age happens to coincide with the plastic age, you can charge your Apple Modem with an Apple Credit Card.

Which, along with the low price, makes buying an Apple Modem as much fun as using one.

That's something no modem has been able to say before, either.

Soon there'll be just two kinds of people. Those who use computers. And those who use Apples.
Macworld View

News and notes for the Macintosh community

Edited by Janet McCandless

Macworld View reports on new developments in Macintosh technology. We will cover items of interest to Mac users and predict industry trends. We've been talking with programmers and hardware developers, attending trade shows, and generally keeping an ear out for Mac-related news. Macworld View welcomes contributions from readers. We'll pay up to $50 for the items we use. Please include your name, address, and phone number with your contributions; send them to Macworld View, 555 De Haro St., San Francisco, CA 94107.

Fat Mac

Memory expansion for the Mac depends on commercial availability of 256K chips. Until the quantity shipped into the United States from Japanese manufacturers increases and the price drops, Apple will continue to produce the 128K Mac. According to John Rizzo, Apple's hardware product manager, "We have been telling people to expect the upgrade early in 1985."

"Each 128K Mac has the capability of being upgraded to 512K once the 256K chip is inserted," says Steve Scheier, market communications manager at Apple. Rizzo adds that neither the user nor the dealer can go into the Mac and put chips onto the system board; they are soldered in place. Apple will supply dealers with new system boards to swap with the 128K boards.

Rizzo expects that double-sided drives will be incorporated when the system boards are upgraded. Although the technology for double-sided drives exists, Rizzo says, "We can't obtain enough in sufficient production quantities to meet our requirements."

Alice

If you like fast-paced video games and know how to play chess, you'll want to try a three-dimensional animated chess game called Alice. This new game by Macintosh programmer Steve Capps takes Alice out of Wonderland and puts her on the Mac screen.

We looked at a prerelease version of the game, which opens on a woodcut graphic of a medieval figure playing chess and then shifts to a chessboard. Six chess pieces zoom to the front of the board, and you select a piece to indicate which powers Alice will adopt (for example, if you choose the Queen, Alice can move in any direction, any number of squares). You have only one piece, Alice, to play against the game's complement of chess pieces.

Your score is posted above the board. When you take a chess piece, your score increases; it decreases when a piece takes Alice. To obtain a perfect score of 999, you must capture all the chess pieces, never let Alice get captured, and let all the pawns move to the front row and become queens before capturing them.

Capp's future plans for Alice incorporate the construction trend in software games—letting users access programs and redraw the game figures as well as redefine their functions. In Alice the user will be able to redraw the chess pieces or change the expression on the faces as the pieces move.

Apple estimates that Alice will be released in May, for under $40.

New Life for Lisa

According to many dealers, the Lisa 2 line is Apple's answer to the negative reaction customers have to the Mac's 128K of memory and one disk drive. Keith Sharp of the CompuShop of Georgia in Atlanta explains the boost in Lisa sales: "People who liked the Lisa technology were scared away by its price. Now they see this technology in a $2500 machine, and then they say they need more memory and a hard disk. After comparing benefits and features, they're more willing to pay the price."

None of the dealers we spoke with believes that the Mac will cut substantially into Apple II sales. As John Byren of Jonathan's Computer Centers in Marlton, New Jersey, sees it, "The educational software world will stay zeroed in on the IIe, which will remain in the home and the kindergarten-to-12 market." Although the
Mac is predicted to replace the Apple II in the business market, Sharp adds. "Apple II is still an excellent value, with two disk drives and 128K for under $2000. It can handle data bases, mailing lists, and form letters—functions that are not available on the Mac and won't be for many months."

Dealers agree that the Mac's introduction has increased overall sales of personal computers. A more significant impact, suggests John Merson of the Computer Factory in New York City, is that the Mac is bringing into the market "people who had never thought of a personal computer as something they would use."

User Group Report
Now that the Mac has been out for a few months, we expect Macintosh user groups to begin springing up or emerging from existing Apple II groups. We want to hear from all Mac user groups and clubs so that we can share your impressions, opinions, and experiences. Excerpts from club newsletters that offer new insights into the Mac will be published for the benefit of other users.

To locate a club in your area or to find out how to set up your own user group, send a self-addressed, stamped envelope to Macintosh, International Apple Core, 908 George St., Santa Clara, CA 95050, 408/727-7652.

Macworld Screen Dumps
The Macintosh screen images you see in Macworld have been reproduced through an advance in typesetting technology. Screens, a program designed by Apple and Len Schafer at George Lithograph in San Francisco, uses a high-resolution, bit-mapped transcription process to reproduce file contents.

The process begins with a snapshot of the screen taken by holding down the 8 and Shift keys while pressing the 3 key. This creates a MacPaint document of the screen image. These MacPaint documents can be transmitted via modem to a CRT typesetter or a laser printer. Until now, the end user has had to rely on either camera equipment, plotters, or dot matrix printers to generate hard copy of screen contents. The new process produces camera-ready output that eliminates distortion caused by the curvature of the video screen.

The user can select any portion of a page or a file to be typeset; images can be reproduced from 10 to 100 percent.

MacLore
In the early 1800s a Canadian settler named John McIntosh discovered 19 apple trees on a tract of land he'd purchased. Twenty years later a traveling journeyman taught John and his son Allan to graft fruit-bearing branches onto their one surviving apple tree. The McIntoshes became known for producing a bright red, thin-skinned, juicy eating apple with a delightful aroma and white flesh.

Almost 200 years later Jef Raskin, a computer designer at Apple, developed the concept of a revolutionary personal computer that he called the Macintosh. Reference to the apple is obvious, but the misspelling leads to another Macintosh. According to Webster's Ninth New Collegiate Dictionary, macintosh or mackintosh is a
lightweight, waterproof fabric originally made of rubberized cotton and named for its inventor, Scottish chemist Charles Macintosh. The term came into public use about 1836 when Macintosh designed a waterproof cape that became popular. Expect the Mac to have an entry in a future edition of Webster's: Macintosh/mak-entosh (1984): a compact, graphics-oriented personal computer developed by Apple Computer.

Twelve-Foot Mac
A 12- by 8- by 8-foot Mac greeted visitors entering the Softcon trade show in New Orleans (February 21-23). A brainchild of James Ferris and Steve Jobs, the giant Mac was designed from the housing blueprints for the Mac and used the Mac's calculator to rescale the model. Elkan, a model shop near Apple's offices in Cupertino, California, constructed the huge replica. Carpenters built a wooden framework, applied a styrofoam base, and covered it with auto-body putty, which they then sanded, enscribed, and spray-painted to replicate the Mac. Inside the model they connected a General Electric light valve projector with a cable interface to a regular Mac. Through a series of mirrors set up for rear-screen projection, images being created on the Mac by the person demonstrating it were also shown on the giant screen. The GE projector was originally developed for the Mac road show that preceded the Mac's introduction.

The Mac Factory
From the project's inception, the Mac design team agreed to build a personal computer that could be manufactured by the Ford plants. The Mac, said Jobs, will emerge as the Ford of personal computing for the '80s—dependable and inexpensive. Like those early automakers, the Mac group has designed a true mass-market product. Indeed, the factory has the capability to produce a Mac every 27 seconds.

The plant achieves large-volume production by relying on 95 percent automation, the machine's design (the Mac contains only one 10- by 10-inch digital board having 50 chips), a "just-in-time" inventory supply system, and quality-control procedures that result in a less than 1 percent chance of defects during the product's entire life.

Inside the 160,000-square-foot factory, automated material handling and delivery systems bring parts to workstations for assembly. An overhead parts delivery system and vehicles guided by automation (monitored by a microprocessor-based traffic manager) criss-cross the factory floor. A computer-controlled crane retrieves small parts from the factory's tote stackers and sends them to the workstations via a conveyor network. Workers return empty totes along the network. The system automatically recognizes the empty totes, replenishes the supplies, and returns them to the workstations. Apple plans to automate further, introducing robotics and surface-mounted device technology. Even now, Macs are used in the factory to test digital boards.

MacWrite Update
A new version of MacWrite should be available from your dealer soon. It includes superscript and subscript options in the Style menu and revisions to the header and the footer.

Joe Selton's demonstration of the Mac at Softcon was accompanied by a giant working replica of the Mac.
Macintalk

BIHFOH2R (NAY5NTIYN EY5TIY FOH5R) means "Before 1984" in Macintalk, a phoneme program written by Mark Barton and Joseph Katz and licensed by Apple. For several years Barton has been developing software simulations of hardware speech synthesizers. He created SAM (software automatic mouth), a program for the Apple II. "I ran so close to real time on SAM that I took the challenge to make it run in real time on the Mac."

The authors not only succeeded but also improved the program's voice quality and pronunciation.

The authors offer two options for making the Mac talk: learn the code, or write the text in English and convert it. "The main program takes phonetically coded speech and its simple ASCII code, which requires about a day to get used to, and turns that into the spoken output," Barton explains.

To create intonation, users assign a value from 1 to 9 to each part of speech and specify the rate of speech in words per minute and the baseline pitch of the voice in hertz. The other approach "takes English text and converts it into those codes, but at the expense of some errors," he continues. Approximately 90 percent of the words are properly translated, but the computer "doesn't know how you want the sentence said in terms of intonation patterns."

Programmers can use either BASIC or Pascal. According to Barton, they have to "specify a string and call the program, and the string will be spoken. The driver works on the sentence level."

Barton based Macintalk on newscaster English (nonregional standard American English). The program can be adjusted to reproduce dialects, but the necessary numeric data on phoneme tunings and durations require extensive research. "I'm presently working on simulating a female voice at a UCLA phonetics lab, but there's no release date yet," he says.

Apple plans to use Macintalk to replace the audio cassettes in the Guided Tours, and software developers for the Mac will be able to use Macintalk to create on-line tutorials. The authors also envision Macintalk games and software for the handicapped.

Words from Woz
We recently spoke with Steve Wozniak, co-founder of Apple Computer and creator of the Apple II. Although he didn't work directly on the Mac, he influenced the design philosophy of the Mac development team.

In the olden days, before 1984, not very many people used computers, for a very good reason. Not very many people knew how, and not very many people wanted to learn. After all, in those days, it meant listening to your stomach growl while sitting through computer seminars.

"Most of the people working on the Mac were old-timers like Burrell Smith, Andy Hertzfeld, and Bill Atkinson. They didn't need a lot of outside assistance," says Woz.

"We found out that building a machine from the ground up is about a three-year project, so we have a lead of several years in this area. Of course, there will be many skin-deep Macs that have the appearance (pull-down menus, windows, icons, etc.) of an authentic Mac, and they may seem to run easily, but they won't have the foundation of an entire operating system and a user interface."

Wozniak believes that the Mac-style user interface will predominate by the end of the '80s.

Steve Wozniak
"1984" in 1983
The Macintosh became an overnight TV sensation without ever being seen. Apple made the ad agency Chiat/Day responsible for its "tease" campaign. Brent Thomas, associate creative art director at Chiat/Day, reports, "We wanted to come up with a real blockbuster.

It had to be eye-catching while using Apple's idea of democratization of computer power." In a brainstorming session with Thomas and Chiat/Day's creative director Lee Clow, associate creative director Steve Hayden remembered a phrase he'd written for a corporate ad: "Why 1984 won't be like 1984." Thomas immediately responded, "That's our TV spot."

They engaged Ridley Scott, a well-known English commercial and feature film director whose credits include Alien, Blade Runner, and The Duellists. Scott directed a cast of 200 at Sheperston Studios in London.

The 60-second commercial cost $500,000 to shoot and had been slotted for a limited viewing schedule—10 spot markets in January and one national showing during the Super Bowl (that one spot cost $900,000). To Apple's surprise, the networks and local TV stations picked it up as a news story. "Even the BBC ran it," says Thomas.

Here's a bit of trivia we uncovered: the first showing of the "1984" commercial was in 1983 on channel KMVT in Twin Falls, Idaho, on December 15 at 1 a.m. By televising the commercial in 1983, Apple qualified it as a nominee for the 1984 Cleo awards.

Sand
In January 1982, two years before the Mac's release, Microsoft assembled a team of software developers and assigned them the code name SAND. The name for this top-secret project is not an acronym. It represents a vision Steve Jobs had in which sand (from which silicon comes) is placed in one end of a factory, and a finished computer comes out the other end.

Command Key
You'll notice that all keys except one on the Mac keyboard are labeled with standard symbols. In an effort to avoid computer jargon and excessive apple imagery, the Mac team decided to label the Command key with the symbol ⌘. Susan Kare, a Mac team graphics designer, discovered the symbol (used to signify campgrounds in Sweden and Norway) in a book of pictorial symbols. To Scandinavians, the symbol also means "remarkable feature."

Immortalized in Plastic
One unique aspect of the Mac is invisible to users. The signatures of 47 Mac team members involved in the project as of June 1982 are inscribed on the plastic casing at the rear of the Mac system unit. You won't be able to see it unless you have the special 10-inch screwdriver needed to open the Mac system unit, so we've provided an inside look.

Hand Correction
You might have noticed that Jeffrey Young's review of MacPaint in our premier issue referred to the hand-shaped tool in the tool palette as the "hand." We want to emend that reference to the grabber, which is what Apple calls the hand that moves your MacPaint document. ☰
Once again we have the seal of approval from Apple.

First we were certified as the diskette duplication service available for authorized Lisa™ software developers.

Now our Software Publishing Service is Apple-endorsed to copy Macintosh™ software.

And not only are we certified to copy Macintosh microdisks, but we use the only automatic microdisk duplication system available today—ours.

We offer top quality, high-volume, fast turn-around software services for Macintosh software developers. This includes everything from copying to packaging and shipping.

With our 6 years of expertise and unmatched quality in the diskette copying business, it is no wonder Apple labels us among the best—we are.

Get involved with quality, give MST a call today.

Media Systems Technology, Inc.,
16950 Armstrong Avenue
Irvine, CA 92714
Phone: (714) 863-1201
or 1-800-443-8515

I want to get involved with Quality...
Contact me about your introductory offer for diskette duplication for Apple Macintosh...

Name: ____________________________
Title: ____________________________
Company: ____________________________
Address: ____________________________
City: __________________ State: ______ Zip: ______

Mail to: Media Systems Technology, P.O. Box 1023, Langhorne, PA 19047 or call 1-800-535-3232 MA101

© 1984 Media Systems Technology
Apple, Lisa, and Macintosh are trademarks of Apple Computer, Inc.
The Compleat Disk Juggler

Andrew Fluegelman

Producing a large volume of work on a one-drive Macintosh can become tedious and time consuming, but it doesn't have to be. By planning ahead and adopting some practical work routines, you can use your single-drive Mac more productively and efficiently to create and store a variety of documents and programs. This article shows you how.

Does the following scenario seem familiar? You have just brought your new Macintosh home from the local computer emporium, where you managed to resist the salesman's efforts to sell you an additional disk drive. You flip on the power switch, pop the Write/Paint disk into the drive, and in a few minutes are happily producing electronic MacPaint drawings and composing MacWrite letters in every imaginable combination of fonts and type styles. After about 20 minutes of work, you are rudely greeted with a beep from the Mac and an alert box that proclaims: "This disk is almost full. Delete some documents or change disks."

Or how about this one? You decide to create a disk with some extra storage space, so you initialize a fresh disk and drag only the MacPaint program onto it. The disk now has 340,000 bytes available, but every time you use MacPaint, you're presented with a seemingly endless series of instructions asking you to swap disks. As your wrists grow weary, your work session grinds to a frustrating halt.

You don't have to curse those alert boxes or dread the appearance of the "Insert disk" message. You don't even have to return to the computer store to shell out more money for a second disk drive. All it takes are a few minutes to prepare your working disks and the willingness to follow a few standard procedures. The result will be a one-drive Macintosh with vastly improved performance.

Meet the Finder

The first step in optimizing your Mac is understanding what the various files on the disk do and how much space they take up. If you insert a Write/Paint disk and open the disk icon, you'll see an icon labeled "System Folder." Within that folder are six icons in the form of tiny Mac outlines (see Figure 1). These files are what the Mac uses to manage its work load. The most important of these files is Finder; in fact, it's so crucial to the workings of the Mac that it is usually referred to as the Finder.

The files in the System Folder take up about 216K of the 400K available.

If you're familiar with other computers, you'll recognize that the Finder is the Mac's operating system equivalent. It's a collection of programs and routines that keeps track of the names of all files on a disk and controls how files are moved around the desktop, in and out of folders, and to other disks. The Mac would not work at all without the Finder. This file occupies 45,568 bytes on the disk or, using the symbol K to represent approximately 1000 bytes, about 46K. (In the computer world, the amount of space that files and programs take up is measured in bytes. The symbol K commonly refers to 1024 bytes, so 45,568 bytes would be 44.5K. The Get Info option in the File menu does not follow this convention, however, so this article uses the K amounts that the Mac reports.)
Getting Started

The immediate solution for creating more disk space is to produce separate work-disks for MacWrite and MacPaint.

The Scrapbook File contains about 8K. If you like the images there, keep them. Otherwise, you can clear a little more disk space by cutting the images you don't want. You can do this by choosing the Scrapbook from the Apple menu, scrolling through the Scrapbook screens, and choosing Cut from the Edit menu to remove unwanted images from the Scrapbook.

Following the steps above will free up 71K on the disk. (You can see the results posted below the title bar by emptying the Trash.)

Font Mover

You can clear even more space, and that's where Font Mover comes in. (The Font Mover utility was added to the Mac software after the first printing of the owner's manual. Future printings of the manual will document this feature.) You can see from Figure 3 that the Macintosh fonts take up a good deal of space on the disk. For most writing applications, you won't need all those fonts. Font Mover provides you with a way to remove them from the System file.

Select the Font Mover icon, and open that application either by double-clicking on the icon or by choosing Open from the File menu. You'll see a screen similar to the one in Figure 6. By clicking on the names of the various fonts, you can see a sample of each font and how many bytes it occupies on the disk. You can also select more than one font by dragging or by holding down the Shift key and selecting additional fonts. (Clicking on the button labeled "Help" in the dialog box gives you a clear explanation of how to use Font Mover.)

Font Mover offers two options. You can remove a font from the System file entirely (similar to disposing of it in the Trash), or you can extract the font from System and copy it to a separate file called Fonts, which you can then move to another disk for storage. Since the disk you're creating will be a working disk and you already have a backup copy of the original Write/Paint disk, there's really no reason to copy any of the fonts.

However, you're better off using Copy instead of the Remove option. If you mistakenly remove a font, Font Mover gives you no way to restore it, and it will be deleted when you Quit the application. It's safer to copy the fonts to the separate Fonts file and dispose of that file later.

How do you decide which fonts, if any, you want to remove? That depends on the sort of writing you normally do. For general text, Geneva, New York, and Toronto are the three fonts that work best, usually in 9 or 12 point, but two are probably sufficient. You can keep just the Geneva and New York series and dispose of all the Toronto fonts. The rest of the fonts are better suited for headings and titles, though Chicago-12 is also a readable font.

If you like to print in high resolution, you'll also want the 18- and 24-point versions of your text font. That's because high-resolution printing uses the point size at twice the size you see on the screen and com-

![Figure 2](image_url)

This chart shows how the Write/Paint disk storage is allocated. You'll have enough room for only a short paper and a few sketches. However, you can optimize your disk space by creating separate Write and Paint disks and by taking advantage of the Font Mover utility.

![Figure 3](image_url)

A large part of the System file—about 86K—is taken up by the 22 subfiles that contain the information needed to display and print the different fonts. The Desk Accessories take up the remainder of the System file—about 57K.
I want to subscribe to Macworld. Please send me 12 issues. 
12 issues for $48 $24!
I’ll save 50% off the single copy price and 20% off the regular subscription rate.

Payment enclosed □ Please bill me.
Charge my □ Visa □ MasterCard interbank #——

Card # ___________________________________________ exp. date

Signature __________________________________________

Or call toll-free: 800/247-5470

Name ____________________________________________

Company __________________________________________

Address __________________________________________

City, State, Zip ____________________________________

□ This is a renewal (attach mailing label above)

Macworld will be published in May, July and September of 1984 and will begin monthly publication in November 1984.

Please allow 6-8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail.
presses it to produce higher quality printed letters. If you want to print New York-12 in high resolution, for example, you’ll need New York-24 on your disk.

Finally, the Finder requires that certain fonts always be available to it for creating the various menus, dialog boxes, and labels: Geneva-9, Monaco-9, New York-12, and Chicago-12 are preceded by an asterisk to signify that you cannot remove them.

A rational choice might be to eliminate San Francisco, London, Athens, and Venice because they’re decorative fonts not likely to be used in regular writing applications. Monaco-12 is very similar to Geneva-12 and therefore dispensable unless you have special need for a monofont (in which all the letters occupy the same amount of space).

Choosing which fonts (if any) to remove is, of course, up to you, but by removing all of the above-named fonts and quitting the Font Mover application, you can reduce the size of the System file by about 40K. Since you have several backups of the original Write/Paint disk, you can drag the newly created Fonts file into the Trash. And because you are also finished with the Font Mover utility, you might as well drag that into the Trash and save another 13K.

These deletions free an impressive net amount of 124K of additional space, for a total of 174K of storage for your letters and memos. Compare the chart shown in Figure 7 with the one in Figure 1.

**Paint Workdisk**

You can make similar savings on your Paint Workdisk, although you’ll probably want to retain a more complete selection of fonts. Keep in mind, however, that you’re not prohibiting yourself from ever using the fonts you discard from that disk. They will still be available to you on the W/P Workdisk; you’ll just need to copy them to the specified disk. What you’re doing is optimizing a working disk for the type of work you’ll be doing most often.

When removing files from your Paint Workdisk, you’ll save a bit of disk swapping by ejecting the current disk in the machine and restarting the Mac using the Paint Workdisk.

On the subject of reducing the size of the System file, one can’t help noticing that the desk accessories also take up valuable space. Most of us probably do not need the Puzzle or the Control Panel on every disk. Perhaps someday we’ll be provided with a full-featured resource mover utility that lets us add or remove desk accessories at will.

**Using the Workdisks**

Now that you have created working versions of *MacWrite* and *MacPaint* that each have expanded storage capacity, how do you put them to use? Here are a few guidelines that can help your work proceed smoothly.

The most efficient way to use the Write and Paint workdisks is to store all your text or picture files on them. You’ll be able to edit or print a file directly without having to do any disk swapping.

**Because the Finder can transfer only part of a disk at a time, swapping is a fact of life with a one-drive Mac.**
Getting Started

### Tales of the Finder

**Daniel Farber**

You probably noticed an icon in the premier issue of *Macworld* that you didn’t find on your Mac desktop. Lon Poole’s “Tour of the Mac Desktop” in that issue mentioned the “Alternate Disk,” and several of the screen shots in *Macworld* displayed this now-defunct icon below the Write/Paint icon on the Mac desktop. You’ll also see this icon in the first printing of the owner’s manual, and it turns up as the “Unknown Disk” on the Macintosh Guided Tour disks.

This species of icon was devised to represent any disk that the Finder has never seen. It was to serve as a temporary destination disk for files that the user wanted to copy to an off-line disk. “We put the Alternate Disk in at the last minute because Steve [Jobs] thought that the copy process as designed was convoluted and counter-intuitive,” reports Macintosh programmer Andy Hertzfeld. Jobs thought there should be a proxy disk on the desktop to initiate the copy process.

This Alternate Disk created some complications. “We were running out of time we needed to debug and document the new copy feature, and some people didn’t think it was the best way to go. The week before the software was due to be sent out for duplication, we scrapped it,” Hertzfeld adds.

The Mac software team managed to come up with a more practical way to facilitate the copy process between disks without having a proxy disk icon on the desktop. In effect, the destination disk (the disk onto which you want to copy a file or the contents of an entire disk) is an “alternate” disk. Simply ejecting a disk and inserting the disk onto which you want to copy files starts the process.

Unfortunately, due to production schedules, the user manuals had already been typeset with the Alternate Disk in place. According to Chris Espinosa, Apple 32 user education manager, “We had manuals at the printer’s in the blue-line stage. The only changes you are supposed to be making are for bad reproductions of the art boards. At that point we put a major feature, the Alternate Disk, into the owner’s guide and documented it fairly well, but it never made it into the software. We will be revising the user manuals so that they match the software and document new features that are being put into the software.”

Apple, of course, issued an update (errata sheet) to the manuals and Guided...
Four to advise Mac owners to ignore the references to the Alternate Disk and to explain the improved disk-copy procedure.

"There are always deadlines and trade-offs that you have to make," says Herzfeld. "We're perfectionists—we kept working on it as long as we could to make it as good as we could. We knew we would have to make some compromises and eventually ship it; our dreams would be impotent if we didn't get machines out into the world. Now we have time to tune up the software. We've minimized the number of swaps and made other improvements on the Finder."

**Finder Update**

Bud Colligan, Mac software product manager, informs us that a new version of the Finder should be available at Apple dealers by the time you read this issue. Mac programmer Bruce Horn explains that Finder version 1.1 decreases the number of swaps required for normal file copying by increasing the size of the buffer.

Apple has also included an additional application that reduces by more than half the number of swaps required for copying an entire disk. According to Mac programmer Steve Capps, "It copies one-fourth of the disk into memory, so any disk takes only eight disk insertions [four swaps] to copy." He adds, "Some other things we improved are how long it takes to get back to the Finder after exiting an application, and how long it takes to boot the system. We have improved those procedures by 20 to 30 percent each."

The revised Finder will also include an option in the Special menu that enables users to specify an initial program load. "You will be able to boot right into an application such as MacPaint. When users exit the application program, they will return to the Finder," explains Capps.

Although the Mac software team members have initially turned their attention toward improving the Finder, they do not intend to spend all their time fine-tuning it. They are currently developing new applications and productivity tools. Espinosa reports, "We're updating the Finder once a year and synchronizing revisions with new hardware releases such as hard disks."

With hardware revisions planned for 1985, we can expect that additional revisions to the Finder will take advantage of the 256K chip upgrade to a 512K system board and double-sided drives offering users 800K of disk storage.

**Data Disks**

The aforementioned system for storing data files on the application workdisks is the most convenient in terms of avoiding disk swaps, but it doesn't use your disks' storage capacity very efficiently; more than half of every disk is filled with copies of the System and application files. If you want to economize on disks, or if you want to store a great amount of data, adopt a system that uses separate data disks.

To create a data disk, simply eject one of your workdisks, insert a fresh disk, and initialize it. Give it a name, such as Data Disk 1, or a more specific name that helps you identify its contents.

You can also insert a disk you have already used and choose Erase Disk from the Special menu. Be sure that you don't need any information on that disk and
that you rename the disk to indicate that it's now a data disk. (Again, make sure that each disk has a distinctive name.)

Because you'll be using data disks to store files that you create, you can take advantage of the full 400K capacity of the disk. You do, however, have to run your applications from your workdisks. The following is a sample procedure using MacWrite:

1) Insert the Write Workdisk and open MacWrite.
2) If you are creating a new document, just start typing.
3) If you want to edit an existing document, choose Close from the File menu and then immediately choose Open from the File menu. Now click the Eject button and insert one of your data disks. You'll see a list of all the MacWrite files on that disk. Click on the name of the file you want to edit, and click the Open button. MacWrite will read that file into memory and then prompt you to reinsert the Write Workdisk.
4) When you're finished working on that document, choose Save from the File menu. You'll be prompted to switch disks again while the Finder saves your edited file to your data disk.

A Combination Storage System

If you intend to produce several documents, you might find it more convenient to create and save each one on your Write Workdisk and then transfer those files to a data disk for permanent storage. This procedure is also convenient for making backup copies of files. A sample procedure is as follows:

1) Use MacWrite to create several documents and save them on the Write Workdisk.
2) Quit MacWrite to return to the desktop.
3) Eject the Write Workdisk and insert a data disk.
4) Select the files you want to transfer from the Write Workdisk window. You can select several files at once by dragging a rectangle around all of them or by holding down the Shift key and clicking on each one.
5) Drag one of the selected icons from the Write Workdisk window onto the icon for the data disk. (If you've selected more than one file, you'll see an outline of all the selected icons fly across the screen as if in formation.)
6) Follow the prompts for switching disks until all the files have been copied.
7) To free up space on your Write Workdisk, select the transferred files and drag them into the Trash.

The Finder has eccentricities that you may want to keep in mind. You have to eject the workdisk in step 3 before you can select the files in step 4. The Eject command works on what is selected, and you can't eject a selected file.

You must reselect the files you copied to remove them to the Trash. Although it would be a bit more convenient (and equally logical) if the Finder kept the original files selected, it just doesn't work that way. If you drag one or more files into the Trash and then eject the disk, the files in the Trash will be automatically removed, without warning, even though you never emptied the Trash.

There's no question that if you need to manage a large amount of data, purchasing an additional disk drive would be an investment that would quickly pay for itself in time savings and convenience. But if you are on a budget or want the convenience of an easily transportable computer, a Macintosh with one internal drive can serve you well. By experimenting with variations on the above storage plans, you should be able to devise your own work routines that will maximize your disk storage capacity, minimize disk swapping, and make your one-drive Mac a more productive tool.

The Cut and Paste commands in the Edit menu enable you to combine text and graphics from separate MacWrite and MacPaint workdisks.

Figure 6

The Font Mover utility lets you free up space on your disks by removing fonts you don't use from the System file. You can either delete a font completely or copy it to a separate Fonts file, which you can subsequently move to another disk for storage.

Figure 7

You can increase the space available on your Write workdisk by more than 120K by eliminating the MacPaint application, the Scrapbook file, Sample Memo, and unnecessary fonts. Compare this chart with the one in Figure 2.
The Macintosh has a new ring.

The ARTSCI MAGICphone™ creates an entirely new aspect to the APPLE Macintosh™, that provides a spectrum of voice/telephone communications.

Software is provided to manage and dial hundreds of phone numbers and will record and print the details (time, number, and charge) of each call. The phone log can be printed on a daily, weekly, or monthly basis. The mouse is used to select and dial any phone number, and MAGICphone uses TONE dialing to any of the lower-cost telephone carriers like SPRINT and MCI.

The MAGICphone also allows control of two separate phone lines. A "hold" feature for each line with lighted indicators is provided. You can then call someone to the phone or pick up an extension and continue the call. The MAGICphone can temporarily stop incoming calls, and the caller will hear a busy signal.

The MAGICphone can be used as a stand alone telephone without Macintosh control. Tone dialing and last number redial are standard features.

Installation is a snap. You simply plug the MAGICphone into your Macintosh speaker jack, and into your phone line.

Available now. $199.95.

ARTSCI, INC.
5547 Satsuma Avenue
North Hollywood, CA 91601
818/985-2922

MAGICphone was developed for ARTSCI by Digital Matrix Inc.
MAGICphone is a trademark of ARTSCI, Inc.
Macintosh is a trademark of APPLE Computer, Inc.

Circle 8 on reader service card
Clean Up Your Electronic Desktop

Tips for organizing your files and folders on the Mac

Daniel Farber

Is your desktop a disaster area? Is the document you need never in the folder it should be in? Did you long ago stop placing files in your filing cabinet in any logical order? Are your calculator, memo pad, and appointment book buried under mounds of papers?

If keeping your desk orderly and managing your files is an uphill battle, using a Macintosh should help relieve some of the difficulty and the clutter. All the objects you need to accomplish your work exist on the Mac's electronic desktop and can be accessed easily by a click of the mouse. If you use another type of personal computer to create and manage your files, you'll find that the Mac is a different breed, providing you with more than a "computerized" directory of cryptic file names.

Whether you use a Mac for maintaining business and personal records, for writing and illustration purposes, or for running sophisticated programs for data base management, financial analysis, or communications, you'll need to adopt some new procedures for keeping track of your files and programs. The following suggestions should help you use your Mac more efficiently.

What's in a Name?

Keep your file names short and concise. Unless you have only a few files on your desktop, you'll have to move some of your file icons around to make the names legible (see Figure 1). If you have your files arranged by icon on the desktop, lengthy names tend to overlap when your icons are put in orderly rows and columns (see Figure 2).

Disk icons can have names of up to 27 characters, but shorter names will make your desktop appear less cluttered. Because you'll often be displaying your files by icon (you can't move files around on the desktop when they are displayed by name, date, size, or kind), you'll have to adjust to working within the 9-inch diagonal space of the Mac screen. File names of about 12 characters are optimal for managing several files on the desktop. Using lowercase letters will help you squeeze more characters into a file name because the Mac's fonts are proportionately spaced. If you can't easily shorten a name, make sure to place the unique part of it at the front (see Figure 3).

When a disk or folder directory is arranged by name, date, size, or kind, file names of about 17 characters are fully visible. The same is true when you access an application directory. The owner's manual says that file names can be up to 63 characters long (such a name would string out across more than half of the Mac's screen) and also notes that dragging around an icon with a long name can be unwieldy. At best, that is an understatement. The Get Info command in the File menu provides an information box about objects on the desktop, so you won't need to depend on the name alone for information about your files, programs, and disks.

By giving your disks, files, and folders distinctive names, you can minimize the need to open files or disks to see what they contain. If you are writing a book, for example, name the disk (or disks) containing the book with the book title or an appropriate abbreviation. If you need to indicate that the disk contains a specific draft, use a notation system that is simple and easy to remember. Don't title each file with a cryptic name that you might forget six months after you have created it; use the chapter number and section (for example, Chap. 4-6). You won't necessarily have to include the date in the name because all files, folders, and disks are date-stamped by the Finder. (The Finder is the set of programs that manages files, application programs, and disks on the Mac.) The Get Info command and the View menu options (except By Icon) will inform you of a file's most recent update.

Give each disk a different name to eliminate confusion during multiple-disk work sessions.
Joe is a freshman in college, and he uses his Mac for all his schoolwork. Unfortunately, his Mac desktop looks like his dormitory room. It is cluttered because his files are placed randomly on the desktop and the names are too long. The documents listed by name in the window named “Expository Writing Assignments” are abbreviated by the Finder because they are longer than the space allotted for file or folder names.

Choosing the Clean Up command from the Special menu arranges the icons in orderly rows and columns, but because the names of Joe’s files and folders are more than about 12 characters in length, they overlap on a crowded desktop. He’ll have to drag some of the icons to an open space to figure out what they are called.

Labeling Your Disks
One of the most basic and important techniques for keeping track of files is labeling micro-floppy disks clearly with the files or type of files they contain. Otherwise, you’ll be starting up disks and checking their contents unnecessarily. Give your work disks and data disks concise names to indicate their contents (the more specific the better), and give each disk a different name to eliminate confusion during multiple-disk work sessions.

File Catalog
You might find that you don’t have enough room on your disk label to write all the information you need to give an accurate and useful account of its contents. This problem can be overcome by printing paper copies of your disk or folder directories. First, arrange your files or folders by name, date, size, or kind on the desktop. Each of these View options displays the same information in different ways. A fully expanded directory window can display information on up to 17 files, including size (amount of K), name (in boldface type for easy reference), kind (file types such as folder, application, or MacPaint document), and the last date each file was modified. Arranging directories By Name will provide an alphabetical listing of the contents (see Figure 4).

To get a printout of the entire screen (which includes the name of the folder or disk in the title bar), engage Caps Lock, hold down the ⌘ and Shift keys, and press 4. If you have more than 17 files stored on a disk or within a folder, simply scroll a new set of files into the window and repeat the procedure for printing the contents of the window. This technique is especially useful for detailing the contents of backup disks and data disks that contain numerous files.

Get Info
Make use of the Get Info command in the File menu. When you select a disk icon, file, or folder and choose the Get Info command, a window will appear containing information about the selected object, including kind, size, name, and location of the disk the file is on, the date the file was created, and the date of its last modification (see Figure 5).

If you select several objects on the desktop simultaneously (choosing Select All from the Edit menu selects every file on the desktop) and choose the Get Info command, Get Info windows will zoom out
one on top of another on the desktop (see Figure 6). Clicking on the title bar or any exposed area of a window makes it the active window. This feature gives you information about your files quickly and efficiently, and demonstrates some of the visual flash of the Finder. You can have up to seven Get Info windows displayed on the desktop at once.

The Locked box indicates whether a disk is write-protected. The term write-protect means that the contents of a disk are frozen—you can't alter the documents in your files or folders. If you slide the red tab on the corner of a disk toward the edge, start up the disk, and choose Get Info, the Locked box will have an X in it, indicating that the disk is locked (write-protected). Some applications, such as MacPaint, do not work if the disk is locked, while others, including MacWrite, allow you to open a file even though you can't make any changes. The owner's manual notes that changes made on the desktop are not saved and that desktop accessories may not work properly if your startup disk is locked.

The Locked feature also functions at another level. You can protect files, folders, or application programs when a disk is not locked. When you click on the empty Locked box in a Get Info window pertaining to objects on the desktop other than disk icons, an X will appear. This tells the Finder that the particular object cannot be disposed of in the Trash and that its name can't be changed; however, you can move, modify, or duplicate it. This option is especially useful if the kids decide to play with your machine and drag all your files in the Trash.

Each Get Info window has a box at the bottom for user comments. Using it is one of the best ways to identify the contents of a file or a disk—what you can't relate in a short title can be conveyed in the user comment box. It also enables you to keep this layer of information off the desktop unless you need it. If you forget what a file contains, you won't have to go into the particular application to look at the file. You'll quickly learn to take advantage of this feature when you accumulate numerous files and need more specific details about a file or a folder. You can type about three lines of text (about 30 words) in the comment box, and you can edit the text using the standard Macintosh techniques.

---

**Figure 3**
Here are Joe's files and folders renamed and arranged on the desktop. He has learned how to optimize the space available on the desktop for displaying icons. Each file has a distinctive, concise name so that Joe can see at a glance what each file contains.

---

**Figure 4**
Arranging Icons By Name gives you an alphabetical directory of your files, and the name of each file is in boldface for easy reference. You cannot move files by View menu arrangements other than By Icon, but you can open, duplicate, or rename them. You can also get a printout of the entire screen so that you have an informative disk directory on paper.
Getting Started

Kind: disk
Size: 46,440 bytes available, 35,394 bytes used
Where: internal drive
Created: Sunday, April 1, 1984 at 1:58 PM
Modified: Sunday, April 12, 1984 at 3:06 PM

Herein lay notes for the week April 9-13, expository writing papers for the spring quarter, EuroNovel stuff, and my exorbitant expenses for the month.

Figure 5
The Get Info command in the File menu is one of the most useful features of the Finder. Every object on the desktop has a Get Info window that contains information about the selected object, and a user comment box allows you to include information that won't fit in a brief name.

Figure 6
When you select several objects on the desktop at once and choose the Get Info command, Get Info windows zoom out on the desktop, one after another, demonstrating the visual flash of the Finder. Joe is checking to see if his class notes are worth reading.

Folders
As a general rule, you should organize your files logically and hierarchically using the iconographic folders provided by the Finder. Because the Mac desktop mimics the way you use ordinary files and folders, you should easily adapt to working on the Mac desktop. When you accumulate a group of interrelated files, drag them into a folder and give the folder a concise name that reflects its contents. For example, you could place files containing your class notes for particular courses or monthly business expense reports in folders.

(To create folders, select the Empty Folder and choose Duplicate from the File menu. This procedure places a copy of the Empty Folder on the desktop. Then give the second folder a new name and place your files in it. Because the Empty Folder is a permanent fixture on the Mac desktop, you can create new folders as you need them.)

You might want to display your files within folders as text (by name, date, size, or kind) rather than as icons. These arrangements provide you with more information than an icon can and, as a directory of information, are easier to read. A directory of files listed alphabetically (By Name) is a more practical arrangement than a group of icons randomly placed on the desktop. Although you can't move files displayed as text, you can open them by choosing Open from the File menu or by double-clicking an entry in the window. You can also duplicate or rename them. On the other hand, you can display up to 32 icons in a fully expanded window, as compared to up to 17 items by the other View options. Of course, you can always scroll the contents of any window to display more files.

You can also place folders within folders. This type of layered structure will help keep your desktop from being cluttered with icons or lengthy directories (see Figure 7). You can use the comment box in the Get Info window to explain the hierarchical structure of your folders. Because your workdisks, such as MacWrite, have limited disk space, you probably won't need to create an elaborate file-handling system involving layers of folders within folders unless your files are very small and interrelated.
Three layers of folders within folders are probably adequate for managing large quantities of interrelated files on data disks that contain document files only. More than three layers will necessitate an inordinate amount of digging to access a file.

File Handling

Because the Mac's desktop is basically an electronic filing cabinet, don't get in the habit of leaving icons strewn across the desktop as in Figure 1. The Clean Up command from the Special menu will rearrange icons in orderly rows and columns, but it is up to you to do the real cleaning up. Otherwise, your Mac desktop will be just as disorganized and cluttered as your pre-electronic desktop.

If you have several short memos, lists, or reports in separate files that can be consolidated, move them into a single file whenever possible using the cut and paste techniques common to all Macintosh applications. Be sure to dispose of the empty files from which the contents have been deleted.

Get into the habit of transferring files to the appropriate disks or folders. Here's an example of a typical situation in which this strategy comes up. While you are working on a report in MacWrite, you get a phone call from your boss giving you detailed statistics pertaining to a report that you have stored on another disk. You can write the information either on the Note Pad or in your current document. If you leave the information where you originally wrote it, you might forget about it or include it in the wrong report. Instead, cut it from its original location and paste it into a new MacWrite file. Then save it with the name Stats adding some special characters (such as >>>) at the end as a visual cue to remind you that this file needs to be properly stored. Return to your current project by closing the newly created file and opening the file that contains your current report.

When you get back to the desktop, the file labeled Stats>>> will be displayed. The >>> at the end of the file name should alert you to move that file to the appropriate off-line disk. Be sure to dispose of the copy on the original disk to save disk space unless you need it for backup purposes. "The Compleat Disk Juggler" in this issue offers techniques and advice on moving files to off-line data disks with a single-drive system.

Joe finally discovered how to keep his desktop neat and orderly. He created a folder for each class he attends and placed the files with his class notes within the appropriate folders, such as EuroNov (European Novel). Another folder within the EuroNov folder contains papers recently written for the course. This hierarchical structure is essential for maintaining an efficient work environment.

Joe was getting ready to cut and paste some drawings created in MacPaint into his paleontology class notes, but he needed a short diversion.
With Odesta Helix, you can now manage any information with easily created forms. Begin using Odesta Helix immediately, without having to set "field parameters" or learn a programming language. You can type in a free-form report, or a table of calculated numbers. You can even use pictures from MacPaint to illustrate your inventory or teach language skills. Odesta Helix is a new program, not an old program made to work on a new machine. Odesta Helix lets you experience the real power and flexibility of windows, pull-down menus, icons, and mouse interaction because it takes a new approach to information and knowledge formation.

Set up your own forms (or customize provided forms) and then input information only once. Here is just one example: Enter an order, and watch Odesta Helix generate an invoice, adjust inventory, update customer records, and keep track of receivables. Everything you enter can be easily modified, redefined, and interrelated. There are no barriers placed between you and the way you want to do things.
Visual building blocks let you set up even the most complicated statement or calculation and use it whenever you want. Move its icon within and between forms, tables, or embed it in another "tile". The magic of the tiles and arrows has to be seen to be believed – ask your dealer for a demo.

Odesta Helix automatically creates icons to represent every piece of your information. Make them appear if you wish, and re-arrange them within or between forms. Define and restrict them if you wish, for data checking and security. But most of the time, just let them stay hidden "behind" the form.

No special commands to learn in order to search through your "ocean" of information. Simply ask a question by pointing to a spot on a form, or by filling in spaces with your own questions – Odesta Helix will search and sort at the click of a mouse. Example: "Find all books published before 1940, that are first editions costing more than $13.00, and that are about World War I and are illustrated." Imagine the possibilities.
Macworld's tutor
answers questions about using the Mac

Lon Poole

Each month this column will answer questions about the Macintosh and how it works. While it seems certain that most inquiries will center on working with applications, no topic is too elementary or too advanced. Expect to see discussions ranging from setting up the Mac to programming in BASIC and Pascal. Next time you have a question about using the Mac, drop me a line.

This month's column investigates six issues. One reader discovered an error in the Guided Tour disk. Another asks about the anomalous behavior of desk accessories in MacPaint. A few readers have written about seemingly spurious disk full messages when they open MacPaint documents. Someone else needs a way to avoid accidentally disposing of valuable documents in the trash. Another reader is puzzled by contradictory claims about BASIC features. And several readers want to know about using printers other than the Imagewriter with the Macintosh.

Windows do not function in MacPaint as they do in most applications. At first glance, you may think that MacPaint has four windows. However, the three palettes — tools, line widths, and patterns — are stationary. There is one large document window in which you create and edit pictures. It has a title bar and a close box, but lacks scroll bars or size boxes. Despite the title bar, you cannot move the MacPaint document window around on the desktop, and the lack of a size box means you cannot resize it.

Clicking on the MacPaint document window when a desk accessory is on the desktop does not make it active; that would leave the desk accessories still on the desktop, possibly buried alive beneath one of the fixed MacPaint windows. To activate the MacPaint document window after choosing desk accessories from the Apple menu, close all the desk accessories, either by clicking on the close box in the upper-left corner of the accessory or by choosing Close from the File menu. When you have closed all the desk accessories, the document window automatically becomes active.

Desks Accessories in
MacPaint

Q. MacPaint lets me use desk accessories such as the Scrapbook, the Note Pad, and the Alarm Clock, but I can't figure out how to get back to editing my picture. With MacWrite, all I do is click on the document window. That puts the desk accessories away and reactivates the document. What do I do in MacPaint?

Philip Campbell
Duluth, Minnesota

A. First of all, let's clear up a misconception. Although clicking on a MacWrite document window with desk accessories present does activate the document window, it does not put the desk accessories away. They are still on the desktop, hidden beneath the document window. Activating any window puts it on top of all other windows on the desktop. Since the MacWrite document window is usually larger than any of the specially shaped desk accessory windows, it covers the other windows when you activate it. You can prove this by dragging the document window toward the bottom of the desktop or by resizing it until the hidden desk accessories come into view.

This month's column investigates six issues. One reader discovered an error in the Guided Tour disk. Another asks about the anomalous behavior of desk accessories in MacPaint. A few readers have written about seemingly spurious disk full messages when they open MacPaint documents. Someone else needs a way to avoid accidentally disposing of valuable documents in the trash. Another reader is puzzled by contradictory claims about BASIC features. And several readers want to know about using printers other than the Imagewriter with the Macintosh.
Guided Tour Detour

Q. The first thing I did when I took my Macintosh home was start up the Write/Paint disk and try MacPaint. After I finished using my Write/Paint disk I decided to take a look at the Guided Tour. When I inserted the Guided Tour disk, I got a message: “Repairing this disk. All folders were lost; their contents have moved back to the disk window.” I clicked OK; then it asked me to insert the Write/Paint disk, followed by the Guided Tour disk. Why did this happen?

L. R. Pikin
Boulder, Colorado

A. Though you didn’t say so, you must have ejected the Write/Paint disk by choosing Eject in the File menu (or by typing ⌘ E), then inserted the Guided Tour disk. If you had switched your Mac off and on before inserting the Guided Tour disk, the “Repairing this disk…” message would not have appeared. By clicking OK, you may have ruined your Guided Tour disk. Had you switched off your Mac when that message appeared, your Guided Tour disk would still be intact.

The fault here lies not with the Mac, MacPaint, or the Guided Tour. You are a victim of Finder incompatibility. It seems that some copies of the Guided Tour disk were inadvertently fabricated with an early version of the Finder, and you got one of those. To be safe, you should always restart the Mac (power off, then on) before inserting the Guided Tour disk and after ejecting it.

The disk you use when you switch on the Mac becomes the startup disk, and its Finder reigns supreme. Even if you eject the startup disk and insert another, the Mac continues to use the Finder from the startup disk. You used a Write/Paint disk to start up the Mac. Its Finder could make no sense of the Guided Tour disk, which was created using an earlier version of the Finder.

The “Repairing this disk…” message can occur for other reasons too. For example, if the disk is spinning and the power goes off, the disk contents can become scrambled. The next time you insert that disk, the Finder will recognize the disarray and offer to repair it. You may click OK to proceed with the repairs or switch off the Mac and try restarting. The disk may work the next time you insert it. If the “Repairing…” message appears again, you will have to click OK and let the Finder repair the disk.

MacBASIC

Q. I read somewhere that BASIC on the Mac will let me run more than one program at a time and that it doesn’t use line numbers. But a dealer told me that it is compatible with IBM BASIC. How can that be?

Walter A. Nevins
Charleston, South Carolina

A. You read about one version of BASIC and heard about another. Your dealer was referring to Microsoft BASIC, because it is available. It is compatible with other versions of BASIC, including IBM BASIC. (Look for a review of Microsoft BASIC in an upcoming issue of Macworld.)

Apple has its own dialect of BASIC under development, one that attempts to combine the best features of Pascal with the familiarity of BASIC. This interpreted BASIC is being designed especially for the Mac and should be available sometime this summer. It will be a while before we’ll see a complete review on Apple’s Macintosh BASIC, but I arranged for a sneak preview.

Every time you run a MacBASIC program, a new output window appears. You can have any number of output windows stacked up; moving newer ones aside reveals older ones beneath. Clicking on the close box closes and removes an output window. You can also have more than one program listing window present on the screen. MacBASIC listing windows are independent. Each window can contain a different program, and all the programs can be run simultaneously. (Of course, the profusion of windows can become confusing if many programs are running at once.) The number or the size of programs running at once is limited, however, because the programs must share the Mac’s available memory.

In keeping with the Mac’s uniform working environment, the techniques for editing MacBASIC programs are similar to those for editing MacWrite documents. You can cut and
paste, copy and paste, insert, and delete any part of a program, ranging from one line to a whole program. The Undo command gives you the option of changing your mind about your previous editing or typing action. In addition to the usual find and replace capabilities, you will be able to search for a match to whatever is in the Clipboard or is currently selected on the screen.

In a radical departure from standard BASIC, MacBASIC will not require line numbers. You may use a mnemonic label, a line number, or nothing at all at the beginning of each program line.

Nonstandard MacBASIC statements offer flexible conditional execution, new loop structures, extensive screen formatting, and four-voice sound. Other statements let you draw lines, rectangles, ovals, and even pictures made up of those shapes. Limited control of windows, menus, dialog boxes, buttons, and dials is also available.

MacBASIC is a hybrid language made up of ideas taken from several other languages and grafted onto a BASIC stalk. Its enhancements and unusual features make programming easier, but they wreak havoc with compatibility. Programs written in other BASIC dialects may run under MacBASIC with only a few changes, but the reverse is unlikely.

**Imagewriter or Nothing**

Q. I already own an Epson MX-80 printer. Can I use it with the Mac instead of Apple's Imagewriter? 

William R. Sterling  
Decatur, Georgia

A. Some people already own printers that they understandably want to use with their Macs. Others, who think that today's dot matrix printers print no better than those of a decade ago, dogmatically refuse to accept anything but daisy wheel output. Today, you have two choices when it comes to printing a Mac document: use an Imagewriter or don't print.

The folks at Apple are presently studying the best way to accommodate other printers. Their first priority was to develop a low-cost printer that could print anything displayed on the screen, and the Imagewriter fills that need. Eventually, about 80 percent of the printers on the market should work on the Mac to some degree. The Mac will probably be able to utilize the full capabilities of only a few. Some will be able to print only text, while others will be able to approximate pictures with millions of overlapping periods, like the Apple Daisy Wheel printer does with Lisa documents. But don't expect any daisy wheel to reproduce displayed Mac images as well as the Imagewriter can.

You might think that another dot matrix printer will work, since many of them can print graphics and fancy type fonts as well as the Imagewriter can. Forget it. The Mac uses a program called a printer driver to send information to the Imagewriter in a form it can interpret. Every other brand of printer requires the same information but in different formats, so none will work with the standard Mac printer driver. Perhaps some programmer will develop an alternate printer driver for another brand of dot matrix printer. Are there any volunteers?

Even if dot matrix printing bothers you categorically, don't dismiss the Imagewriter until you've seen what it can do with a good ribbon on high-rag-content paper in high-resolution mode. After all, the screen image is made up of dots, and most modern typesetting equipment composes type from lots of tiny dots. (The type in this magazine is set that way.) It's all a matter of dot size, and the Imagewriter actually prints twice as many dots per inch as the Mac screen displays.

**MacPaint Disk Full**

Q. When I open a MacPaint document just to look at it, with no intention of changing even one dot, I get a disk full message. I know that my disk has 20K or 30K available. What's going on? 

Ruth Feldman  
Hollywood, Florida
A. *MacPaint* needs lots of elbow room on the disk. Because pictures can get very large—occupying more than 50K in extreme cases—*MacPaint* makes no attempt to keep one picture entirely in the Mac's memory. At any time, the only part in memory is the part currently visible within the document window. When you use the grabber tool or the Show Page command to move a different part of the document under the window, *MacPaint* copies the new part into memory from the disk. It also copies onto the disk the part that has gone out of view. Your changes will still be there when you move the edited part back into view.

*MacPaint* does not copy directly to and from your document, however. If it did, you could never use the Revert command from the File menu to start over again with the last saved version, because that version would be corrupted with your changes. *MacPaint* uses copies of your document, which it stores in a scratchpad on the disk.

To provide this scratchpad on the disk, *MacPaint* secretly opens two extra documents, named Paint1 and Paint2, right after it opens your document. It copies your whole document to Paint2 immediately. Paint1 stays blank for the time being. The first time you move the picture under the document window, *MacPaint* copies the whole document to Paint1, including any changes you may have just made.

From Paint2, *MacPaint* copies into memory the newly visible part of the picture, and displays it in the document window. Paint1 will contain the most recent version and Paint2 the next most recent version. As you move the picture around under the document window, *MacPaint* continues to keep the two most recent versions of your picture in Paint1 and Paint2. If anything happens to the scratchpad document, *MacPaint* can revert to the other. When you quit *MacPaint*, it automatically removes Paint1 and Paint2 from the disk.

Your *MacPaint* disk needs enough space available for both scratchpad documents. Paint2 always occupies at least as much disk space as the original document. Paint1 initially occupies 2K, but it expands to match Paint2 as soon as you move the picture around under the document window. As a rule of thumb, figure on needing free space on your *MacPaint* disk at least twice the size of your original document.

*MacPaint*’s use of scratchpad documents also prevents you from using it on a locked (write-protected) disk. It tries to create Paint1 and Paint2, but the lock stymies it.

Accidentally Deleting Documents

Q. A couple of times I have accidentally dragged the wrong icon into the trash and clicked Empty Trash on the Special menu. Sometimes the Mac throws up a dialog box, and I have to click OK before I can delete a file, but not always. Is there anything I can do to keep from accidentally losing my work?

George Mizuno
New Bedford, Massachusetts

A. The Mac asks you to confirm icon removal when the icon represents an application or system document. It provides no automatic safeguard for your own documents. However, you can protect valuable documents by locking them. To lock a document, select its icon and choose the Get Info command in the File menu. Doing that will open an information window for the document. Each Get Info window has a check box labeled “Locked.” To lock the document, click on that check box. When you do, a cross will appear in the check box to signify a locked document. If you try to remove a locked document, the Mac will report, “That item is locked or in use and can’t be removed.” To unlock a document, click again on the Locked box in its information window.

Send your questions to Get Info, Macworld, 555 De Haro St., San Francisco, CA 94107.
Apple Computer faced a real problem: what to do with its flagship, the Lisa, when it introduced the Macintosh. The Lisa was a trendsetter, but an expensive one. Launched with fanfare in January 1983, the Lisa was the first microcomputer to have a mouse-controlled pointer, windows, multitasking, and cut-and-paste integration of application software. Its five-figure price tag made it a luxury liner, chiefly for corporate accounts and certainly not for plain folks. The Mac would contain most of the Lisa's style and at least two-thirds of its power at one-fourth of the Lisa's original $10,000 price. Apple had already cut the Lisa's price once in the face of lackluster sales; further reduction might be misconstrued as a fire sale.

The Lisa was foundering all on its own, but every fresh Mac rumor seemed a salvo aimed at the Lisa's weakening hull. It began to look as if the Mac would sink the Lisa before the Lisa's first birthday. The intramural rivalry was just as real inside Apple, where the Mac team, housed across the street from the Lisa team, hoisted a skull-and-crossbones flag over its building.
Apple strips the Lisa, transplants the micro-disk drive, juggles hard disks, and comes up with heavyweights for the new 32 Super-Micro line: the Lisa 2, essentially a super-Macintosh; the Lisa 2/5, most like the original; and the Lisa 2/10, the internal hard disk champ.
How to save the Lisa from an ignominious end? Apple's answer: make the Lisa and the Mac allies, not enemies. Promote their many similarities and minimize their differences. Eliminate the major disparity—the disk drives—by substituting a Macintosh-style drive for the Lisa's twin nonstandard drives. Give the Lisa the ability to run Mac software. At the same time, retool the Lisa's software to run two or three times faster. And instead of insisting that people buy a main-deck Lisa or none at all, let them choose from among a lower deck, a main deck, or a promenade deck. Furthermore, let them start with a lower-deck Lisa and move up later.

The result of this detente between the Lisa and the Mac is the four-member Apple 32 SuperMicro family (see "Macintosh and Lisa 2 Specifications"). All four models feature a very high resolution black-and-white screen, a mouse, a single 3½-inch microdisk drive, the same arrangement of keys on the keyboard, and the MC68000 16/32-bit microprocessor. At $2495, the Mac has the lowest price; its small size and light weight make it fully transportable. The Lisa models range in price from $3495 to $5495. They are more than twice the size and weight of the Mac, have larger screens (12 inches vs. 9 inches, diagonally) and more memory (512K vs. 192K), and can be expanded with additional memory and hard disk drives. (In the near future, a hard disk and other peripherals will be available as Mac add-ons.) All the new Lisa models can run Mac software.

The Lisa 2 ($3495) is essentially a bigger, more powerful, expandable Mac. Its larger memory (512K) accommodates larger spreadsheets and word processing documents, and its larger screen lets you see more of those documents at once. Its expandability enables it to grow along with your needs.

The Lisa 2/5 ($4495) adds a 5-megabyte external hard disk to the Lisa 2, making it most like the original Lisa. It can run many applications created by independent developers for UNIX-like operating systems. By adding more memory, you can use the Lisa Office System, with its simultaneous operation of multiple Lisa applications in the Lisa Desktop Environment.

The Lisa 2/10 ($5495) gives you everything the 2/5 has and twice as much hard disk space, built into the cabinet rather than housed externally.

A complete Mac screen image fits on the Lisa screen with room to spare.

To use Mac software such as MacPaint, MacWrite, or Multiplan on the Lisa, you must first start the Mac desktop environment. Right now, that procedure is accomplished by inserting a special disk labeled "MacWorks" (Apple may change that name) and switching on the Lisa. If your Lisa 2 has a hard disk, you must listen carefully for a click from the speaker, then simultaneously press the Apple key (same as the Mac [ ] key) and the 2 key. Pressing those two keys tells the Lisa to start from the microdisk, not the hard disk. Although Mac software can presently support only 3½-inch micro-floppy disks, plans are underway to give it access to the hard disk by summer.

The Lisa goes through several seconds of self-tests and then begins to copy information from the MacWorks disk into memory. Since it hasn't the 64K ROM of the Mac, it must copy the equivalent of that ROM from disk into its regular memory each time you start it. The MacWorks disk comes with the Lisa 2 but costs $195 extra with the Lisa 2/5 and 2/10.

After about 5 seconds, the Lisa ejects the MacWorks disk and displays the same disk icon with a flashing question mark that you usually see when you first switch on a Mac without a disk inserted. From this point on, everything works the same as if you were using a Mac. Insert a Mac system disk or some other start-up disk.

Soon the Mac desktop appears on the Lisa screen. You notice a difference immediately. The disk and trash icons are nearer the center of the screen than the right edge, and everything looks lanky, like a wide-screen movie shown through a conventional lens (see Figure 1).

A Big Desktop

A complete Mac screen image fits on the Lisa screen with room to spare. There are 22 extra dots at the bottom of the screen (about 0.4 inch) and 208 extra dots at the right of the screen (about 2.3 inches). This space is available for larger windows, more icons, wider word processing lines, more spreadsheet columns, and so on. However, not all application programs are designed to take advantage of the extra screen space. Some, like MacPaint, have fixed-dimension windows, and others, like early versions of Multiplan, do not allow enlarging the window past the dimensions of the Mac screen. Microsoft Chart has been written so that it can take advantage of the Lisa's larger screen. The program detects whether it is being run on a Lisa and adjusts its display accordingly (including scaling the screen aspect ratio).
The El Greco Effect

Macintosh images measure about 25 percent taller and 14 percent thinner on the Lisa, making squares look like rectangles and circles look like ovals (see Figure 2). Although text is distorted in the same way as graphics, the difference is not as noticeable (see Figure 3).

This distortion is due to different dot (pixel) shapes of the Mac and Lisa screens. The Mac has square dots, and the Lisa has rectangular dots. A full-screen image on the Mac, which comprises 512 dots across and 342 dots down, occupies exactly the same number of dots across and down when drawn on the Lisa screen. Although the number of dots is the same on either screen, the distance covered is not. Because the Mac packs more dots per inch down the screen, the 342 dots that take about 4.75 vertical inches on the Mac screen take about 5.9 inches on the Lisa screen. And because the Mac fits fewer dots per inch across the screen, the 512 dots that take about 7.1 inches across the Mac screen take only about 6.1 inches across the Lisa screen.

Without a doubt MacPaint suffers most from this distortion. Every drawing you create on the Mac and later view on the Lisa looks elongated, as if El Greco had redrawn it. Those same drawings will print correctly on the Imagewriter, however, since it has the same proportions as the Mac screen. Conversely, drawings that look correct on the Lisa will look squashed when later displayed on the Mac or printed on the Imagewriter. Unfortunately, the Lisa’s benefits—its larger screen and memory—do not help MacPaint, with its fixed window and single-size drawing. If you plan to use MacPaint extensively, the Lisa 2 is the wrong machine for you.

Text-oriented applications such as MacWrite and Multiplan also suffer from this distortion, but not as badly. Text proportions are fixed. Large or small, all text has the same height-to-width ratio, which you cannot change as you can shapes in a drawing. It’s simply a matter of getting used to the new look. If you need an incentive to do that, think about how many more spreadsheet columns or characters on a printed line you will be able to see at a glance on the larger electronic desktop. Think about the larger spreadsheets and longer reports you can create in the Lisa’s extra memory. (At present, not all software takes advantage of these capabilities, but new versions are in the works.)

Big Memory and Speed

A typical application program and document will not fit completely in the memory available on a Macintosh. To solve that problem, the computer breaks the program and document into segments. At any given time, only some of the segments must reside in memory. The others can be kept temporarily on the disk. As circumstances change (you choose a certain command or move to another part of the document), different segments are needed. The computer copies idle segments from memory to disk and replaces them in memory with other segments that meet your demands. This transferral explains why you hear the disk drive activate in MacPaint when you choose the Show Page command to move a different part of your drawing into view.

Because the Lisa has four times as much memory as the Mac, more program and document segments will fit at the same time. In fact, because many applications can reside entirely in memory, you can avoid having to swap disks. In addition to saving time, the program can be a great deal more efficient. Once in memory, however, Mac software does not seem to execute quite as quickly on the Lisa as on the Mac. Because this degradation balances out the improvement due to less disk swapping, Mac software performs about the same on either machine.

The Lisa’s extra memory is also available for documents larger than the Mac can handle, but the application software must be designed to take advantage...
of it. MacWrite, for example, can create documents of up to 85 pages on the Lisa, compared with about 20 on the Mac. Multiplan can handle larger, more complex worksheets too. But there is a price. Larger documents take longer to save on disk and longer to open. The longer a MacWrite document, the more time it takes to scroll from beginning to end. Multiplan spends more time recalculating a large worksheet than a small one.

The Lisa Office System

Original Lisa users had a choice of application software: the Lisa Office System or nothing at all. Not a bad choice, since it offered seven applications in an electronic desktop environment and could run all those applications simultaneously. The Lisa Office System survives, though it will not run on any of the Lisa 2 models out of the box. It requires a hard disk and at least \( \frac{3}{4} \) megabyte of memory (768K), and it works better with a full megabyte. To any Lisa 2 you must add memory, and to the plain Lisa 2 you must also add a hard disk drive.

People familiar with the Mac desktop environment will find that they know how to use about 95 percent of the Lisa Office System desktop environment. The other 5 percent will come naturally. Although some icons on the Lisa desktop have different shapes and titles, they are easy to recognize. For example, the Trash can on the Mac desktop has its lid on, while the Wastebasket on the Lisa desktop has its lid ajar (see Figure 4).

The Lisa 2 runs Office System software two to three times faster than the original Lisa. The legendary waits for the Lisa to start an application for the first time after being switched on have been trimmed considerably. For example, starting LisaDraw on the original Lisa takes about 50 seconds, while on the Lisa 2 it takes less than 30 seconds. On the original Lisa there was sometimes a noticeable lag when typing text in LisaWrite: the display screen just couldn't seem to keep up with moderate typing speed. That lag, while still perceptible, is no longer onerous.

Users of the Lisa Office System can choose among the original seven applications still available from Apple: LisaWrite (word processing), LisaCalc (financial modeling), LisaDraw (free-form presentation graphics), LisaGraph (business graphics), LisaProject (project management), LisaList (list management), and LisaTerminal (terminal emulation). In addition, independent developers have announced more than 20 additional software applications for the Lisa Office System, covering tax and estate planning, relational database management, investment and loan analysis, general accounting, graphic image libraries, legal billing and accounting, personal financial decision assistance, word processing, time management, financial modeling, and statistics.

UNIX

Two UNIX operating systems, XENIX by Microsoft and UniPlus by UniPress, add multuser capability to the Lisa 2/5 and 2/10. The multuser capability means that the Lisa can act as a host for other computers and terminals, giving users in different locations access to the software and the data that reside in the host Lisa. However, UNIX is not compatible with the Lisa Office System. It replaces the Lisa desktop environment with a conventional keyboard-command, line-oriented environment, which means no mouse, windows, icons, or cut-and-paste integration.

Figure 2
A MacPaint drawing (created on a Mac) displayed on Mac and Lisa screens. The images measure about 25 percent taller and 14 percent thinner on the Lisa. Squares look like rectangles, and circles look like ovals. The screens in this figure are shown in the same proportion to each other as they are in real life.
**State of the Art**

*Figure 3*
A MacWrite document shown in several font, size, and style variations (created on a Mac) displayed on Mac and Lisa screens. Text is distorted in the same way as graphics, but not as noticeably.

*Figure 4*
A typical Lisa Office System desktop. Some Lisa icons have shapes and titles different from the Mac's, but they are easy to recognize. Notice the Waste-basket, Lisa's equivalent to the Mac Trash can.
Independent developers have announced more than two dozen software applications for the XENIX environment. Topics include tax preparation, general accounting, relational data base management, word processing, financial modeling, accounting for specific kinds of businesses, and computer programming in COBOL and FORTRAN.

Other independent developers have announced software applications for the UniPlus environment. They cover relational data base management, financial modeling, word processing, and computer programming in FORTRAN, COBOL, BASIC, C, and Pascal.

The Lisa 2 System Unit

A typical Lisa 2 consists of a system unit, a mouse, and a keyboard. It may also include one or more hard disk drives, a printer, and a modem. The system unit weighs 55 pounds, compared with the Mac's 16.5 pounds. The Lisa 2 system unit houses the display screen, a single 3½-inch microdisk drive, a power supply, video circuitry, four electronic circuit boards, and sockets for four more circuit boards. The keyboard jack and power switch are located on the front, beneath the overhanging disk drive and display screen. Sockets at the rear let you connect the power cord, a mouse, an external video monitor, two serial devices such as a printer and a modem, and (on models 2 and 2/5) an external hard disk drive (see Figure 5). Unlike the Mac, the Lisa has no jack for connecting an external speaker or sound system. Two control knobs, one for screen brightness and the other for focus, protrude from the back cover.

Unlike the Mac, the Lisa permits access to its inards for service and upgrades. The face plate snaps off, exposing the disk drive chassis. Removing it is a matter of loosening a knurled knob, sliding the chassis out, and disconnecting a couple of cables. Access to the rest of the parts is through the rear and involves unplugging cables from their sockets, loosening two knurled knobs, and lifting off the back panel. Once that is done, you can simply slide out the power supply module, the main computer and memory module, and the expansion slot module. The circuit boards that plug into the main and expansion modules have specially designed fasteners that make removal and installation virtually foolproof. None of this requires tools or special knowledge. Only the video circuitry, with its dangerous residual high voltages, disassembly of the disk drive and power supply modules, and components on the circuit boards require the services of a trained technician.

The Mouse

The mouse connects to a special socket at the back of the Lisa. Aside from the style of its plastic case, the shape of its single button, and the design of its plug, it is identical to the Mac mouse. The Mac and Lisa mouses are interchangeable.

Figure 5
Sockets on the back of a Lisa 2 let you connect the power cord, a mouse, an external video monitor, two serial devices, and an external hard disk drive (on the 2 and the 2/5).
The Keyboard

A lightweight keyboard attaches to the front of the Lisa with a coiled cable. The keyboard stows underneath the protruding screen and disk drive, or it can be placed anywhere within about five feet of the system unit.

Key layout on the Lisa exactly matches the arrangement of keys on the Mac and follows the standard set by Selectric typewriters (see Figure 7). Shift keys are large and set where touch-typists expect them to be. The Caps Lock key, located directly above the left Shift key, locks in the down position to let you know it's engaged. The Lisa keyboard includes a numeric keypad that has the same key layout as the extra-cost Mac accessory keypad. The Lisa and the Mac keyboards may look alike, but they do not feel the same. The Lisa keyboard takes a somewhat heavier touch, especially near the bottom of a keystroke, when spring resistance stiffens to tell you that you've struck the key. Rating keyboard feel is highly subjective. What one person likes, another may hate, but I prefer the Mac keyboard. I say this knowing that the Lisa engineers went to an outside supplier for their keyboard because they did not like the feel of the Apple keyboards.

The Screen

The Lisa has a built-in black-and-white screen that measures 12 inches diagonally. Text and graphics are displayed in black letters and lines against a light gray background. Images are extremely sharp and well defined; the screen has a resolution of 364 dots (pixels) vertically by 720 dots horizontally. Screen contrast is under program control and can be set to dim automatically after the computer remains untouched for a length of time, thereby guarding against permanently etching the currently displayed image into the phosphor.

The Disk Drives

All three Lisa 2 models have the same built-in 3½-inch variable-speed microdisk drive as the Mac. The drive has no door or eject button because disk ejection is completely under software control. This new drive can store 400K of formatted information on each disk, compared to 860K on each of the original Lisa's twin disk drives. In exchange for the loss of disk capacity, Lisa 2 owners get smaller, more convenient, and sturdier disks, not to mention complete compatibility with Mac software. Look for an add-on external micro-
Access Information

The following is a list of prices and manufacturers for Lisa 2 products.

### Prices

**Basic Units**
- Lisa 1.0 $6995
- Lisa 2 $3495
- Lisa 2/5 $4495
- Lisa 2/10 $5495

**Upgrades from Lisa 1.0**
- To Lisa 2/5, free until June 1, 1984, $595 thereafter
- To Lisa 2/10, $2495 until June 1, 1984, $2795 thereafter

**Application Programs and Peripherals**
- Lisa Desktop Environment $195
- LisaList $195
- LisaWrite $295
- LisaCalc $295
- LisaTerminal $295
- LisaGraph $295
- LisaProject $395
- MacWorks $195
- Profile with access kit $1895
- 512K memory card $1495

**Printers**
- Apple ImageWriter $595
- Apple Daisy Wheel printer $2195

**Operating Systems**
- XENIX $795
- UniPlus $495

### Manufacturers

**The Lisa series**
Apple Computer, Inc.
20525 Mariani Ave.
Cupertino, CA 95014
800/538-9696
In California 800/622-9238

XENIX
Santa Cruz Operations, Inc.
500 Chestnut St.
Box 1900
Santa Cruz, CA 95061
408/425-7222

UniPlus
UniPress Software, Inc.
1164 Raritan Ave.
Highland Park, NJ 08904
201/985-8000

---

disk drive from Apple later this year. Sony, maker of the microdisk drive, has been showing a double-sided drive at recent trade shows, which means that 800K per 3½-inch disk is just around the corner.

Apple’s 5-megabyte hard disk drive, the Profile, is standard equipment on the Lisa 2/5. It can be retrofitted to a Lisa 2, and as many as six additional Profile drives can be added to any Lisa. Each 5-megabyte hard disk stores nearly 13 times as much information as a single 3½-inch microdisk and operates faster.

The Lisa 10-megabyte hard disk that comes with the Lisa 2/10 can be retrofitted to a Lisa 2 or 2/5. Expect to see larger capacity hard disk drives, both external and internal, from third parties who specialize in accessory disk drives and possibly from Apple, but don’t hold your breath while you wait.

**Memory**

All three Lisa 2 models have space for two memory cards. They are shipped with one memory card that contains 512K (½ megabyte) of RAM (random access memory). That’s enough to run any Mac software and some software written especially for the Lisa. To run Lisa Office System software, you need another memory card. Theoretically, the Lisa Office System will run with reduced efficiency in as little as ½ megabyte of memory, but right now memory cards are available only in ½-megabyte denominations. Although memory chips that hold 256K each (four times the 64K of
## Macintosh and Lisa 2 Specifications

<table>
<thead>
<tr>
<th></th>
<th>Mac</th>
<th>Lisa</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Memory</strong></td>
<td>128K RAM</td>
<td>512K RAM (expandable to 1M)</td>
</tr>
<tr>
<td></td>
<td>64K ROM</td>
<td>16K ROM</td>
</tr>
<tr>
<td><strong>Processor</strong></td>
<td>MC68000</td>
<td>MC68000</td>
</tr>
<tr>
<td></td>
<td>32-bit</td>
<td>32-bit</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>9-inch diagonal screen 512 by 342 dots</td>
<td>12-inch diagonal screen 720 by 364 dots</td>
</tr>
<tr>
<td><strong>Interfaces</strong></td>
<td>2 RS-232C/RS-422/AppleBus serial ports</td>
<td>Lisa 2, 2/5:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 RS-232C serial port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 RS-232C/RS-422/AppleBus</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lisa 2/10:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>parallel port internal to hard disk</td>
</tr>
<tr>
<td><strong>Keyboard</strong></td>
<td>58 keys, optional 10-key numeric keypad</td>
<td>58 keys, plus 10-key numeric keypad</td>
</tr>
<tr>
<td><strong>Floppy disk</strong></td>
<td>400K microdisk drive 3½-inch media</td>
<td>400K microdisk drive 3½-inch media</td>
</tr>
<tr>
<td>storage options</td>
<td>Available from third-party developers</td>
<td>2/5:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>external 5M hard disk drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2/10:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>built-in 10M hard disk drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lisa 2 can be upgraded to 2/5 with an external hard disk or 2/10 with an internal hard disk</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>Main unit: 16.5 lb.</td>
<td>Main unit: 55 lb.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Main unit: 9.7W by 10.9D by 13.5H inches</td>
<td>Main unit: 18.5W by 15.25D by 13.75H inches</td>
</tr>
<tr>
<td></td>
<td>Keyboard: 13.2W by 5.8D by 2.6H inches</td>
<td>Keyboard: 18.5W by 6.5D by 2.5H inches</td>
</tr>
<tr>
<td><strong>Power requirements:</strong></td>
<td>Line voltage: 105 to 125 volts AC</td>
<td>Line voltage: 115 or 230 volts AC</td>
</tr>
<tr>
<td></td>
<td>Frequency: 50 or 60 Hz</td>
<td>Frequency: 48 to 68 Hz</td>
</tr>
<tr>
<td></td>
<td>Power: 60 watts</td>
<td>Power: 150 watts max.</td>
</tr>
<tr>
<td><strong>Environmental requirements:</strong></td>
<td>Operating temperature: 50° to 104°F</td>
<td>Operating temperature: 40° to 108°F</td>
</tr>
<tr>
<td></td>
<td>Humidity: 5% to 90% relative</td>
<td>Humidity: 15% to 80% relative, noncondensing</td>
</tr>
</tbody>
</table>
the Lisa's) already exist, they are costly and limited in availability. Someday they will make 4-megabyte Lisas a reality.

In addition to large amounts of RAM, the Lisa 2 has 16K of ROM (read-only memory). It contains permanent software that knows how to get the Lisa 2 started when you switch on the power.

The Microprocessor

All Apple 32 SuperMicros use the same microprocessor, the Motorola 68000. It handles twice as much information at one time as the Intel 8088, the microprocessor used by the IBM PC and most of its compatibles, and four times as much as the Intel 8080 or

The Lisa keyboard includes a keypad that has the same layout as the Mac accessory keypad.

the Zilog Z-80 used in CP/M machines. On top of that, the 68000 in the Lisa 2 or the Mac processes information 60 percent faster than the 8088 in an IBM PC or its workalikes. It outpaces most 8080 and Z-80 computers by an even larger margin.

Serial and Parallel Ports

The Lisa has two serial ports (sockets) in back. Plug a modem into one for telecommunications or perhaps to connect the Lisa to a local network, and plug a printer into the other. Each of the two serial ports provides full-duplex, asynchronous mode RS-232C or RS-422 communications at rates between 300 and 57,600 bits per second. They work just like the ones on the Mac, with one important difference: the Lisa serial sockets require 25-pin plugs, and the Mac sockets take 9-pin plugs.

The parallel port on the back of the plain Lisa 2 or Lisa 2/5 is for attaching an external hard disk drive. The Lisa 2/10 has no built-in parallel socket because it uses the circuitry for the internal hard disk.

Expansion Slots

The Lisa 2 has three expansion slots into which you can insert accessory cards. At the present time, only one kind of accessory card is available, a parallel card with two ports. Its primary use is for attaching additional Profile external hard disk drives. The future may see accessory cards for an external 3 1/2-inch microdisk drive, more serial ports, a color monitor, a high-speed arithmetic processor, and third-party hard disk drives.

Upgrades

Owners of existing Lisa systems can upgrade to a Lisa 2/5 or 2/10. The upgrade to a 2/5 is free until June 1, 1984, after which it will cost $595. Authorized Apple dealers can perform the hardware upgrade in less than half an hour—it involves replacing the existing 5 1/4-inch drives with a single 3 1/2-inch drive and exchanging some ROM chips. Also included are microdisk versions of all the Lisa Office System software that you currently own.

Upgrading to the Lisa 2/10 involves switching from 5 1/4-inch disk drives to microdisk drives, and includes a 10-megabyte hard disk drive mounted above the microdisk drive, behind the louvered front panel. Instead of a simple ROM switch, the entire motherboard must be replaced. You will need an accessory parallel card to plug in your existing external hard disk (list price $195). Upgrading from an original Lisa to a 2/10 costs $2495 until June and $2795 thereafter.

The New Choice

Apple has managed to rescue the Lisa from oblivion by offering it in various stages of undress, thereby forming an upper end to the new SuperMicro line, which is anchored by the Mac. Compared to the Mac, the Lisa is bulkier, heavier, shorter on charisma, and bigger in price. But it does offer considerably more memory, a larger screen (albeit flawed by distortion when running Mac software), a hard disk drive, expandability, and a broader software base. Among the four members of the Lisa-Macintosh family, no value leader stands out. More money buys more features. Let your budget and a fair assessment of your needs be your guide. □
Introducing

MACWORLD

The Macintosh Magazine

The Exciting New Magazine for the World's Most Creative Personal Computer—the Macintosh

At Special Charter Subscriber Rates
Save Up to 54% Off the Newsstand Price* (*when you subscribe for 3 years)

Personal computing took a giant leap into the future when Apple introduced the Macintosh. We've created Macworld as your passport into this incredible new realm of computing. Each issue we'll bring you everything you need to explore and get the most out of your Macintosh. From the latest product news to innovative business applications, from amazing graphics to personal productivity tools and games, each issue of Macworld will be packed with interesting, practical, readable information written by skilled, perceptive writers.

Each month we'll be creating a Macworld community; sharing ideas, problems, and creative solutions while we explore the world of Macintosh together.

So why take a chance on missing a single exciting issue? For a limited time only you can subscribe to Macworld at special Charter Subscriber rates of only

$24 for 1 year (12 issues)
That's a savings of 20% off the regular $30 subscription rate and 50% off the newsstand price!

And you can save even more by subscribing for 2 or 3 years at Special Charter Rates. Don't Wait...Subscribe Today and Save!
Special Charter Subscription Offer

Save 50% off the Newsstand Price!

Newsstand

Regular Subscription Rate

$24

Special Charter Offer

Order Now to Take Advantage of This Limited Time Offer!
VISA and MasterCard Accepted! Call TOLL FREE: 800-247-5470 (in Iowa 800-532-1272)

Macworld will be published in May, July, and September 1984 and will begin monthly publication in November 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

Special Charter Subscription Offer

Save 50% off the Newsstand Price!

Newsstand

Regular Subscription Rate

$24

Special Charter Offer

Order Now to Take Advantage of This Limited Time Offer!
VISA and MasterCard Accepted! Call TOLL FREE: 800-247-5470 (in Iowa 800-532-1272)

Macworld will be published in May, July, and September 1984 and will begin monthly publication in November 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.

I ACCEPT! Please send me Macworld, the Macintosh magazine.

☐ Please Bill Me  ☐ Payment Enclosed

Please Send Me:  ☐ 12 issues/$24  ☐ 24 issues/$46  ☐ 36 issues/$66

Name ____________________________

Company ____________________________

Address ____________________________

City, State, Zip ____________________________

Please allow 6–8 weeks for delivery of your first issue. Outside the U.S. subscriptions must be prepaid in U.S. funds. Outside the U.S. and Canada add $1 per issue for surface or $5 per issue for airmail. This offer expires July 31, 1984.


State of the Art: User Education

Redefining User-Friendly

An interview with members of the Macintosh User Education team

Edited by Daniel Farber

In the past, you could be sure that when you bought a computer you were destined to plod through weighty manuals, attend seminars, buy additional books, or annoy your dealer with questions. The phrases ease of use and user-friendly did not usually apply to computers or software. The problem was not simply that documentation was obscure to nontechnical users; the computers themselves worked in a way that made computer literacy contingent on an aptitude for bits and bytes or a degree in computer science. The design of the computers and the software reflected the rather limited vision of the engineers who created them and the needs of an elite group of technically oriented users.

Today, ease of use and user-friendly are common terms, often used to describe application programs and personal computers. In most cases, the terms mean that you'll be able to learn the fundamentals of the machine or the program in 20 to 40 hours. You'll probably want to buy a few books to supplement the manuals and attend a seminar, because most manuals don't provide the information you need in accessible form.

The Macintosh, however, was designed with the nontechnical user in mind. In fact, the Mac redefines ease of use and user-friendly. This is expressed in the way the Mac interacts with users (the desktop environment, pull-down menus, etc.) and in the structure, writing style, and graphic design of the Mac owner's manual and the application program manuals (MacWrite and MacPaint) as well as the Guided Tour disks and audio cassettes. The manuals and Guided Tours have set a new standard in the computer industry for user reference tools.

As an integral part of the Mac development team, Apple's Macintosh User Education department was responsible for developing and producing the manuals and Guided Tours. This group worked closely with the Mac programmers, making sure that both the software and the hardware met the needs of users.

Macworld Associate Editor Daniel Farber spent a few hours talking about the Mac manuals and user education issues with members of the Macintosh User Education team: Chris Espinosa, manager of the Apple 32 User Education department, and writers Lynnea Johnson, Carol Kachler, and Hasmig Seropian. What follows is an edited version of that discussion.

Macworld: It's often said that novice users don't use the manuals that come with their computers because they are somewhat forbidding and poorly written. How did you come up with an approach that made the user manuals as accessible to novices as the Mac itself?

Espinosa: Everyone said, "Nobody is going to read the manual because the product is so attractive and easy to use." To a certain extent, that statement is true. A lot of people who have never seen the Mac can pick it up and understand how to use it. But they can go only so far with their own knowledge; at some point they need help in discovering things. Other people are intimidated by the Mac just because it is a computer. You have to give them tutorial experience, take them through the applications and the procedures step by step. We did that in two ways. One is the tutorial sections in the manuals, for people who really feel secure with a book in their hands, and the other is the Guided Tour disks and audio cassettes, which let the machine show off itself.

Macworld: What steps did you take to accommodate both kinds of users?

Espinosa: That was the problem—figuring out who was going to need what. The other problem was making the books so attractive, so compelling that you'd want to read them. If the books, like the machine, are lean, beautiful, and fun, as well as readable, people won't be threatened by them, and they will want to use them.

The MacWrite manual, for example, contains photographs interspersed with the kind of documents you'd create using MacWrite. If you read the text of all those documents, you'll see that they actually tell a story. If you take that kind of creative approach, manuals will not be like the standard kind written by programmers who happen to have taken a few English classes in high school. If you take the attitude that
Macintosh User Education team members, from left: Chris Espinosa, Lynnea Johnson, and Carol Kaehler.
the manuals should be as attractive as the product itself, so much so that they compete with the product for attention, you can develop a useful manual.

Macworld: The most obvious difference between the Mac user manuals and traditional manuals is that they are compact and short. Was writing those manuals more difficult than writing longer, more traditional ones?

Seropian: Writing short documents is very difficult. Who was the writer who said, "If you want a short document you have to give me a week, but I'll write a ten-page document in one night"?

Espinosa: The easiest way to keep documentation short is to have the program do the right thing in the first place and do something useful. Several times when Bill Atkinson, who wrote MacPaint, was reading Carol Kaehler's documentation, he saw that certain things were difficult to explain. That's a sure sign for the programmer that the program needs work.

Kaehler: Whenever Bill read a draft of something I wrote, if there were more than a certain number of words, he would change the program code because that meant that the procedure was too complicated.

Johnson: The Mac programmers were as interested as we were in creating easy-to-use programs. But we had a different perspective. They had been in this industry a long time, and their programming priorities tended to get in the way at times. We would go back and say, "From a user's point of view, this isn't a convenient way to do this, even though it makes good, tight code." They were very receptive. The inter-

relationship between the writing process and programming is nowhere near what it could be in this business.

Macworld: How did you decide on what to call various commands and other features that make up the Mac desktop environment and application programs?

Johnson: Coming up with the terms was really an organic process. We would just start using a word, such as Organizer for the Finder. But when we used Organizer, people felt uncomfortable with it. They would say that it's a plastic thing that you put on your desk, or that it sounds sort of political.

Kaehler: We had a little motto that if we had to talk about something more than once, we needed a name for it. Some people believed that the Finder was not going to have a name. We would just talk about what it does. I remember sitting and

68 May/June 1984

The tutorial sections of the Macintosh manuals take you through the basic skills you'll need to begin working on the Mac and its application programs. The tutorial spread in this photo is taken from the owner's manual.
thinking, I'm not sure I could write 20 pages on utilities without mentioning the program that does it. We were trying to avoid being too "techy" sounding.

Macworld: Did you have many discussions about wording the dialog boxes and other instances in which the Mac "speaks" to the user?

Espinosa: The problem was humanizing the machine without anthropomorphizing it. If you give the machine too much of a personality—it threatens novices who are afraid that it may be smarter and more powerful than they are. You can't have the computer refer to itself as "me" or "my" or have it lecture or scold the user.

The whole basis of using the mouse and the pointer is direct manipulation. The Mac simulates an environment that has objects and commands. You always manipulate those objects and commands directly by pointing to them with the pointer and clicking a button with the mouse. The Mac never does anything until you click the mouse button, just as pieces of paper don't start jumping around on your desk. The only thing on the desktop that the user doesn't control is the programming. We didn't want the computer to come out and grab the user. That's why all the commands are direct verbs; you tell the computer to do something, not the other way around. The whole orientation is to give the user the power.

Macworld: Most user manuals merely document the way a program or a computer works, whereas the Mac manuals present material in a practical, task-oriented manner. How was that overall structure for the manuals conceived?

Johnson: Many manuals in the computer industry have been primarily reference books in which the user has to go through and dig out the procedural infor-
State of the Art

Perfect from the tutorial?

Macworld: How is the cookbook different from the tutorial?

Kaehler: An important difference is that the cookbook is generic, whereas the tutorial section that precedes it uses a specific example that you build on. Because the cookbook is generic, it allows you to apply general rules to what you are working on, separate from what you learn in the tutorial.

Espinosa: The tutorial gets you started, gets you over your fears, and introduces you to the fundamental concepts and methods used to run the program. The reference section tells you in very terse but accurate detail what each tool is, what each command does, and what the fundamental structures and concepts of the program are. That’s how most manuals are set up.

What falls through the cracks is the group of users who go through the tutorial—they are not novices anymore, but are barely intermediate. Most of the skiers I know got over being novices very quickly and became intermediate skiers, but they will remain intermediate skiers all their lives. That’s how most computer users are. They will never be able to jump into a reference manual, look at an abstract definition of a command and its function, and understand how they can use it in interesting ways. You still have to know a lot about computers to do that.

The most powerful thing that computers do is enable you to combine tools in interesting ways to do things you want to do. That’s what the cookbook sections are for. They take the tasks you most often want to accomplish and show you step by step what commands and functions to use. The cookbook sections finish off the learning that the tutorials start. We want to install the user an imagination for combining those tools and to introduce more facets of each tool. That’s what the cookbooks do. They give you instant gratification. They do what you want them to do, and then they show you a little more.

After using the cookbook several times, the user sees many tools that he or she didn’t know how to use before, and sees them in new and interesting ways. It shows the user the principal advantage of computers: that you have a huge toolbox of things you can combine to do interesting things that wouldn’t be possible if you knew only what they did individually.

Kaehler: The cookbook fills in the gaps where the software design isn’t intuitive. You have to pick and choose certain elements that you can get separately from the reference and tutorial sections. It puts together those procedures in an inventive way.

Johnson: If everything were really intuitive, you would need only reference materials. Copying a disk is not intuitive. You can get that information in the Reference section if you feel like reading, or you can go through the sequential steps in boldface at the top of the page in the cookbook sections ["Using the Finder," "Using MacWrite," and "Using MacPaint"].

Macworld: How did you target the level of the cookbook section?

Espinosa: We’ve shown this machine to many people. The question they ask most is, “Now that I’ve done this, how do I do such and such?” You have to tell people how to do the next thing. We often don’t know all the possibilities. I wish it were possible to know all the how-to questions. The difficulty is to come up with just the right questions.

Espinosa: We can never answer everybody’s how-to questions, because there is an infinite number. What we want to hit are the most common ones that people will ask in the first month or two of using the machine, and we want to answer those questions so well that people will be happy with the book and will go back to it. The biggest problem with writing a manual is getting people to trust it and use it. We tried, in writing the cookbooks, to avoid giving too much information about what a tool is or what it does, or confusing readers with superfluous facts. We wanted to help readers solve specific problems so they can go back to what they are really concentrating on—their work.

Macworld: Obviously, MacPaint is the most original manual of the three. It’s like a 32-page cookbook that gives you the fundamental ingredients and various techniques, but no specific recipes. How did you target the particular manual evolve?

Kaehler: I first wrote a traditional manual on MacPaint. When my mother was visiting, she was going to test the manual. She sat down and within about three minutes stopped reading. I said, “Mother, you have to read this.” She’d read another few paragraphs or a couple more pages, and then she’d be off playing with MacPaint again. It was depressing to have your own mother not be able to go through your book.

Bill Atkinson read it and said, “I really want you do to something outrageous to this. This just isn’t right.” It was difficult at first, because we thought we had the guidelines for writing down. We thought we were going to be able to do every Mac manual in a consistent way. Chris said, “Prevent you don’t have any of these directions, pretend you are just going to do something without any guidance from anyone.” For about three or four weeks I didn’t write any words. I had a boot screen I created that said, “I will think in arrows.” All I did for a few weeks was arrows.

Macworld: What do you do mean by “arrows”?

Kaehler: Ways to describe motion. We feel comfortable using words, but words were so unwieldy in describing what was happening with MacPaint. The structured examples just weren’t fun. No one wanted
to study them. Users liked their own examples better, so they just went on doing something else, which is the way it should be.

Seropian: Teaching *MacPaint* is like teaching an art class. You can't teach people how to create art or how to be creative artists. All you can teach them is how to use the tools and what pieces and designs combine well. From there, you have to leave it to people to do their own thing.

*Macworld*: The Guided Tour tutorials are certainly a unique and effective way to introduce people to the Mac. Can you explain how they work?

Seropian: The program makes a record of whatever you do as a user. What we've done is take that and make a record of something a new user would like to see. It's almost like having a tape recorder on the computer itself and recording something that you've done—a certain session. It was a matter of designing those sessions so that the new user would be able not only to learn how to use the computer, but also have examples of what to do. How and what are combined in one package.

Espinosa: In the past, when people tried to do that, the applications were so rigid and so inflexible that to have the computer show you what an application could do, you had to write a simulation of the application. If the application is in control of the machine, you can't get in there and make the application do tricks. Most computers are like that. Simulations are not only inaccurate in places, they are always incomplete. They rarely enable the user to go in and practice playing with the application and exploring, because the simulation is limited. We wanted the advantages of the simulation—having the computer show you the application—but we wanted the application there too. There is a mechanism by which we can do something on the computer and have it play back to the user in short, five-minute segments. The computer shows people exactly what the application does, because it's using the actual application, and when people practice what they've learned in the previous session, they can explore the application if they want to.

Seropian: It's a real situation—exactly what they will be doing when they use the machine. What they see is not something artificially created for beginners. It's teaching them, giving examples.

The Guided Tour also brings voice to the learner, which is an important part of learning. It tells you on tape what is happening. If information goes through one channel—the eyes—a limited amount of learning can take place, but if it goes through two channels, the learning experience is much fuller.

*Macworld*: Do you foresee on-line tutorials replacing typeset manuals?

Espinosa: The computer is the best medium for teaching people how to use computers, as long as you can get their confidence in it. The problem with on-line tutorials up to this point is that they haven't been able to emulate the software accurately. We overcome that with the Guided Tour. If people are intimidated by a computer, they will be afraid of a tutorial on the computer. We're trying to eliminate the fear factor with the mouse and the instant response of the Mac and the graphics.

We should see more on-line learning tools that go much further than the Guided Tours we have now. Putting hard-core references for experienced users on-line is a waste of time. That's the kind of stuff that computer people want in a book, to curl up with at night and read. It's wasting the computer's memory and disk space to put that kind of information at your fingertips. The cookbook section is really the most interesting stuff to put on-line. If you're in a particular situation, you'll want to know how to do something. You really want to push the do-it-for-me button, and the cookbook is the closest thing to one that we've got.

Seropian: A closer answer to your question goes beyond the Mac. It's part of a bigger cultural phenomenon in which people will gradually get information from computers rather than books. It might be the next generation, or two generations down the line.

Espinosa: We want to revise the manuals so they match the software, document new software features, and then leave them alone and do something better. We will try to transcend that kind of book to concentrate on on-line information. If we spend all our time revising and updating those books, we will never get anything great done. We want to do something that makes those books—as good as they are—seem superfluous. ☑
Exploring Microsoft Chart

Andrew Fluegelman

Chart programs have taken a back seat to their spreadsheet cousins on several computer systems, but such is not likely to be the case with the Macintosh. The Mac's high screen resolution and built-in graphics routines make it a natural environment for chart applications. And a powerful program is available early in the Mac's life—Microsoft Chart.

Look through your daily newspaper. How many news or feature items do you find that include spreadsheets? Not many. It's a good bet, however, that you'll see several articles using charts to convey information.

Thrust through the morning edition, and you're likely to see a column chart displaying the trend of treasury bill rates over the past six months, a line chart tracing the rise of local tourism vs. the growth of hotel room availability, or a frightening bar chart depicting the latest update on the weapons race.

Charts strongly influence the news and especially the financial pages, because no other form of presentation conveys so much information with such clarity. Although a listing of sales figures might give each dollar amount to penny precision, it does not readily reveal comparative sales rates. One glance at a chart containing the same data, and the trends jump off the page. One chart is worth a thousand numbers.

New Terminology

The world of computer charting has its own vocabulary, including a few concepts unique to this type of program. One basic unit is the category; any instance with which data is associated. It is customarily plotted along the X-axis of Cartesian coordinates. Each category has an associated value—normally plotted on the Y-axis. Together, the category and its associated value make up a data point. A collection of data points is a data series. The best way to grasp these unfamiliar terms is to see how Chart creates a simple chart out of a data series. (See "Presentation Graphics Primer" in this issue for an overview of the concepts and the history of charting.)

A Clean Slate

When you start the program, Chart presents an untitled window on which the chart will be drawn, and a window entitled New Series having two columns headed "X" and "Y." You can then start entering data.

The program automatically creates a window for a new data series, initially labeled with the current time, when you type any number. The number 1 appears in
the X column of the window, representing category number 1, and the numbers you enter appear in the Y column, representing the value for that category (see Figure 1). This combination makes the first data point in a new data series.

As you enter more numbers, you create additional data points in the series (see Figure 2). On your first exposure to the program, all this activity may seem a bit abstract and disorienting, as well as having little to do with charts. To see the connection, click the box marked Plot Series, then click in the untitled chart window. The untitled window will spring to life with a trimly formatted column chart of the data just entered (see Figure 3).

**Picture Perfect**

Someday, reviewers may become so accustomed to the quality of the Mac screen that they will no longer feel the need to string superlatives when describing it. During these early Mac days, however, we must mention the exceptional resolution with which Chart's graphics are presented. The edges of the shapes are razor sharp, and the type is almost letter quality. The Mac's charts might even be of higher quality than those in your morning paper.

**Data Formats**

Your chart may look great, but so far it lacks a key to what the data represents. For example, suppose the data values represent miles run during seven days of a training program. To make the data (and the chart) more intelligible, first make the series window active again (by clicking anywhere on it), then pull down the Data menu from the top of the screen, and give the data some attributes. If the data you enter represents your daily running mileage, you will probably select the Date option, since your categories are individual dates (see Figure 4).

You will then be presented with a dialog box showing the default values for the data series and the category and value names (see Figure 5). To make the data reflect the real-world model of running mileages, complete the boxes as shown in Figure 6.

When you click the OK button in the dialog box, two things happen. Your window for the data series is updated so that the name for the series and the description of what the categories and values represent are listed in the heading of the window. Simultaneously, the window displaying the chart is updated with the series name and the category and value descriptions (see Figure 7).

**A Different Slice**

One precept of running for conditioning is that your greatest daily mileage should not go beyond one-third of your week's total mileage. The column chart in Figure 7 doesn't give a clear indication of this factor. A pie chart would reveal that information much more clearly.

To change the form of the chart, pull down the Gallery menu and select Pie. You will then see a dialog box showing six optional forms of pie charts (see Figure 8). This is a perfect example of how the Mac interface and Chart's implementation of it excel. Instead of wading through verbal descriptions of chart attributes,
you see pictures of forms that convey a great deal of information without one word. One of the chart types will already be suggested, shown as a highlighted image. Select the type of pie chart you want by clicking on the appropriate image.

Option 6 in the pie chart gallery indicates relative percentages of the pie segments. Choosing that option and clicking OK displays the new chart shown in Figure 9. It's now clear that the training has stayed within its guidelines.

**Figure 3**
Clicking in the Plot Series box and then clicking in the untitled chart window generate a column chart of your data series.

**Figure 4**
To modify your series, first make the series window active by clicking on it; then choose an option from the Data menu (in this case, Date).

**Figure 5**
The Date Series dialog box allows you to format attributes for the data series.

**Figure 6**
Type the appropriate attributes in each box, moving from one box to another by pressing the Tab key. Also set the Increment on Days.

**More Data**
Once the chart is configured, you can easily add more data to it. First, make the data window the active window by clicking on it or by choosing List from the Data menu. Then use the pointer and the scroll bar to locate the last entry in the data series, and type in more daily mileage numbers. Since the data format has already been set to increment each category by one day, you simply type each new number and press the Enter key; the successive dates appear automatically. All the standard Mac editing conventions are available when you enter data, including cutting and pasting, scrolling, and moving or changing the size of the data window.
Since the data and chart window overlap, click on the chart window to bring it to the front for viewing. The data series attributes are now included in the chart.

Since the Plot Series box in the data window has already been checked, each new data entry causes the chart to be redrawn in the chart window. Because this process slows things down considerably, choose Manual Redraw from the Chart menu (similar to manual recalculation on a spreadsheet). To view the chart with the additional data, click within the chart window, and the chart will be redrawn.

A pie chart having mileage figures for a whole month is not very useful, so choose Column option 3 from the Gallery. The resulting chart with the additional data will appear as in Figure 10. (The title of the series has been changed to "April Training" and the categories have been reformatted to show only the day.)

The Basics and Beyond

The foregoing information illustrates the basic steps used in producing charts: creating a data series, categorizing the data, and selecting the chart form. Those three steps can be taken in any order; that is, you can specify the nature of the data or the form of the chart before you create or add to the data series.

New Chart users will have to get comfortable with the meaning of a data series and its relation to a visual chart. The data series concept is not used in
Once you have made the New Series window active, you can start entering new data. Unless you choose to define new data attributes, the new series will have the same attributes as the series previously defined. This feature is convenient in that often the second series will represent the same categories and/or values as the first. Once a second series is entered and its Plot Series box checked, the new series will be plotted with the first series. Figure 11 shows monthly mileages for two runners. Notice the legend indicating which columns represent which runner. It was produced by choosing Add Legend from the Chart menu.

Figure 12 shows the monthly mileages for one runner with a line graph showing the statistical trend of daily runs in miles. This second series was produced automatically from the original series by choosing Analyze from the Data menu and then clicking the button marked "Trend." The chart format was produced by selecting Combination from the Gallery menu.

**Massaging the Data**

Other options available from the Analyze selection enable you to create a new data series that represents the average, the cumulative sum, the differences, and the relative percentages of the original series. Other analysis options compute the statistical growth, the median, and the standard deviation and correlation coefficient of the original series. All these options can be plotted as additional graphs along with the original series. Another option lets you sort any data series by category or value in ascending or descending order.

*Chart* has the capacity to plot up to 63 data points per series and a total of about 120 data points among all series, depending on the memory overhead required by the chart format. This exceeds what can usually be displayed meaningfully on the screen. It also has significantly greater capacity than most microcomputer charting programs. (The memory limitations of the program are discussed later in this article.)

**Formatting the Data**

*Chart* provides great flexibility in formatting data. By choosing Categories or Values from the Format menu when a data series window is active, you can have number categories and values shown in general, dollar, percent, or decimal format. Date categories can display year, quarter, month, date, or day in full or abbreviated form. The effects of these formatting controls appear in the data window as well as in the labels for the categories and the values in the chart window. In addition, specified text can be appended before or after the categories or the values, such as "Division 3" or "DM 2000." This text appears on the chart but not in the data window.

---

**Figure 11**  
A second series and a legend have been added to the chart shown in Figure 10. The chart now shows monthly mileage for two runners.

---

**Figure 12**  
A line graph showing the statistical trend of the daily runs in miles has been added to the monthly figures in Figure 10.
"Canned" Chart Formats

Chart’s Gallery menu provides seven format options that can create a total of 42 differently and completely formatted charts. Each of the basic chart types—area, bar, column, line, pie, scatter, and combination—is included, with four to eight options for each type. You can choose any chart by clicking on it or typing its number. Chart also enables you to further modify almost any element in it.

**Bar Gallery**
1. Simple bar chart
2. Bar chart for one series with varied patterns
3. Stacked bar chart
4. Overlapped bar chart
5. 100% stacked bar chart
6. Simple bar chart with vertical grid
7. Simple bar chart with value labels

**Area Gallery**
1. Simple area chart
2. 100% area chart
3. Area chart with drop lines
4. Area chart with grids
5. Area chart with areas labeled

**Column Gallery**
1. Simple column chart
2. Column chart for one series with varied patterns
3. Stacked column chart
4. Overlapped column chart
5. 100% stacked column chart
6. Simple column chart with horizontal grid
7. Simple column chart with value labels
8. Step chart (no space between categories)
Line Gallery
1. Simple line chart with lines and markers
2. Lines only
3. Markers only
4. Lines and markers with horizontal grid
5. Lines and markers with horizontal and vertical grids
6. Lines and markers with logarithmic scale and grid
7. Hi-lo chart with markers and bi-lo lines

Pie Gallery
1. Simple pie chart
2. Pie chart with all slices patterned the same and labeled with categories
3. Pie chart with first slice exploded
4. Pie chart with all slices exploded
5. Pie chart with category labels
6. Pie chart with value labels expressed as percentages

Scatter Gallery
1. Scatter chart with markers only
2. Scatter charts with markers from the same series connected by lines
3. Markers on horizontal and vertical grids
4. Markers on semi-logarithmic grid
5. Markers on log-log grid

Combination Gallery
1. Column chart with overlaid line chart
2. Column chart overlaid by line chart with opposing scale
3. Two line charts overlaid with independent scales
4. Area chart with overlaid column chart
Regardless of how many data series are plotted, the chart labels are taken automatically from the title, category, and value descriptions of the first series plotted. Accordingly, if you plot more than one series, you will probably have to change the chart title for the chart to make sense. The controls for doing that are described in the following section.

More Elaborate Charts
The other general way in which Chart lets you enhance your charts is with an extensive array of graphic formatting options. The easiest way to reformat charts is through the formats offered in the Gallery menus (see "Canned Chart Formats").

The Gallery formats are just the beginning. Whenever the chart window is active, you can select virtually any element of the chart—title, labels, axes, legend, series or data point elements, even the plot area and the whole chart—and specify their text position, size, font and type style, pattern fill, line weight, and graphic style from an amazingly wide range of options. You can also add text anywhere on the chart, as well as arrows, lines, and borders in a variety of shapes and styles. Some of the creative possibilities using advanced formatting techniques are illustrated in "Creating a Custom Chart Format" and "The Compleat Disk Juggler," both in this issue.

In this area of chart formatting, Chart demonstrates its power and versatility as well as the complex routines that underlie the program. You could spend months investigating the options that Chart makes available by pulling down a menu and clicking buttons.

Yet the program is not without limitations. One useful feature not included is the ability to transform a data series into a smooth, variable curve (the Data Trend and Growth selections produce only straight-line analyses). Chart cannot produce bar and column charts that have the appearance of being three-dimensional, nor does it permit true three-dimensional charts (ones that plot three variables).

Ease of Use
As long as you stick with the preformatted chart options, the program operates simply and performs reliably. Once you venture into the unexplored territory of customizing your own formats, however, be prepared to master a staggering array of commands and possibilities. In this way, Chart demonstrates good program design; it offers automatic operation for the new user without sacrificing flexibility and versatility for the expert.

Before you get involved in customizing your charts, be sure that you understand the relation of the Format menu choices to the Data and Chart menus. The Data menu is the route to selecting the type of data series and specifying some of the data parameters. The Format menu, on the other hand, provides two choices labeled "Categories" and "Values" that further configure the format of the data series.

The Chart menu presents two selections labeled "Main Chart Type" and "Overlay Chart Type" that offer manual selection of the type of graphic presentation. The Format menu takes these further with two selections labeled "Main Chart" and "Overlay Chart." Because all three menus control formats in various ways, the distinction between what is covered in Data and Chart and what is covered in Format is not always apparent.

Another source of possible confusion is the fact that the various Format selections are not available all the time, and that the same command may operate on different elements of the chart, depending on which element is selected. You can eventually understand the underlying logic of the various menus, but not without some experimentation and a thorough reading of the user manual. The documentation is well written and well produced and provides a good reference to the program, but don't read it casually.

Performance
The most notable limitation to Chart's performance is that it makes disk accesses whenever a chart is redefined and redrawn. The cause of this lies more with the Mac's memory limitations than with faults in the program; in fact, the Microsoft programmers are to be commended for squeezing so much functionality into the available memory capacity.

Just as every reviewer can't help but comment on the Mac's superior screen resolution, almost every reviewer (and programmer) will wish for more memory in the machine until larger capacity memory chips become a standard part of the Mac environment. Until the blessed day when more memory arrives (hopefully sometime next year), the greatest inconvenience that Chart's disk accesses will cause is in learning the program. The faster a program responds to your commands, the easier it is to learn by experimenting. Delays in response degrade the interactive quality that generally makes a computer a powerful teaching tool.
Lack of memory also limits the amount of data that can be computed and plotted. On a 128K Mac, a maximum of about 12 series of 12 integer data points each can be charted. That capacity will decrease if complex graphic elements are added to the chart. Although memory limitations are not usually a problem in terms of chart capacity, you might have trouble if you try to chart a complex application.

**Rough Spots**

This program does have a few annoying characteristics. Repositioning or resizing text, the plot area, or the entire chart can sometimes produce unpredictable results, and the fact that the program takes time to redraw the whole chart with each intermediate adjustment can make fine tuning somewhat tedious.

A number of shortcut key options are provided to select, show, and redraw the chart window. It would be helpful if there were a key alternative for the Data List command, which is used frequently.

Another sticky point is the procedure for eliminating a data series once it has been created. You must select the entire series by dragging the pointer across both headers in the data window and then cut the selection. A dialog box asks whether you want to cut the series along with all its points. The procedure isn't difficult, but it's not obvious either.

Similarly, it is somewhat confusing to clear the program. Selecting New from the File menu causes the chart format to revert to the start-up default if the chart window is active. If any data window is active, the New command will erase all the data series in memory. (In both cases, a warning asks whether you want to save changes.) To start with a completely clean slate, however, you have to give the New command twice: once for the chart and once for the data. A dialog box giving you the choice of clearing the chart, the data, or both would be more straightforward.

Some of the more advanced techniques involve choosing the right combination of options from various menus. Two examples of such techniques are inserting value and key labels for data series and points, and creating and scaling a separate value axis for the second multiple data series (see "Tips for New Chartists" for advice on adding these features).

As mentioned previously, not all options in all the menus are always available. Their accessibility depends on the current state of the program and the context in which the menu was called up. You'll have to become familiar with the program before you can reliably direct your pointer to the command you want.

None of these peculiarities detracts from the program's utility. You won't even encounter them unless you try to stretch the program to its absolute limits. But if you do set out to explore *Chart*’s secrets, you probably will discover a few strange phenomena in the program's outer reaches.

**Printing and Filing**

Returning to the safe boundaries of *Chart*’s more common features, you'll find a series of printing routines that works without surprises and produces superb results. Selecting Page Setup from *Chart*’s File menu leads to a dialog box that offers choices for paper format, page orientation, header, footer, and margins (see Figure 13). By embedding commands in the header and footer texts, you can center text as well as insert page, date, and time references. This dialog box is identical to the one included in *Multiplan*.

An unusual feature is that the printed chart will be scaled automatically to fill the specified margins, regardless of the size of the chart on the Mac screen. The ImageWriter produces a printed document of fine quality in high resolution, even though it takes about 1½ minutes to print an average chart in standard resolution and up to 3 minutes to print in high resolution. The first minute of both those times is spent saving the chart image to a disk file for printing.

Another interesting feature, accessible through the Edit menu, enables you to copy the image of the current chart to the Clipboard in either screen size or printed size. This feature makes it possible to include
Tips for New Chartists

Andrew Fluegelman

Two types of skills are needed to master any new tool. Naturally, you have to learn to use the tool for what it was designed to do. Beyond that, you quickly learn shortcuts around the tool's limitations or ways to work with the tool that may not have been anticipated in its original design. Microsoft Chart is no exception. The following are a few tips gleaned from several weeks of experimenting with the program.

Data Manipulation

If you have many data windows and want to shift them around on the screen, hold down the $key before you drag the window. You'll be able to move any window without making it the front window. This feature is part of the Finder's (the Mac's equivalent to an operating system) set of tricks and will work within any application or on the desktop.

If you are going to be working with many different data series, move the chart window to the screen's upper-right corner, which makes it easier to select the data windows.

Chart Formatting

If you are charting a series that has many data points, your chart might look better if you omit tick marks from some categories. Select the category axis on the chart, choose the Format Axis command, and specify the number of categories there should be between tick mark labels (see "Format Axis Menu").

If you want to reposition a text label on the chart, make sure that you "unattach" the label by checking the appropriate box after giving the Format Text command.

You may find it easier to position text accurately if you align it in the upper-left corner of the text selection box (check Horizontal Alignment Left and Vertical Alignment Top after giving the Format Text command).

You can create a text label that shows the value and the key (a small square of appropriate shading) of a data point or series. First create your chart and choose an insertion point for text. (It doesn't particularly...
matter where the point is.) Then type some text (again it doesn't matter what—two X's will do). While the text is still selected on the chart, choose Format Text and click the boxes to attach the text to a data series or a point. Then click the Show Key or the Show Value box, depending on what you want to show in the label. (You can check both.) The last step is important: be sure to click the Automatic Text and Automatic Size boxes. You should be able to create a text label that shows either the pattern used for a series or the value of a data point (see "Format Text Menu").

If the chart contains a lot of information, you can enlarge the chart with the following steps. First, drag the chart window to the upper-left corner of the screen. Then drag the window's size box (lower-right corner) so that the window fills the screen. At this point, the chart itself will not be positioned properly. Select the chart with the appropriate command from the Chart menu (or press Shift-#) and drag the chart image by the lower-right selection square so that the chart area fills the window. When the chart gets redrawn, it still won't be positioned properly. Drag the chart area into the center of the chart window. (After making this adjustment, you'll have to use the Data List command to revise your data.)

If you have experimented with formatting your own chart and have run into problems, you can revert to the preformatted options in the Gallery, but you have to remove any previous formatting commands you may have put into effect. The most reliable way to do this is to make the chart window active (bring it to the front) and give the New command from the File menu. Then choose the format you want from the Gallery. (Remember, choosing New when a data window is active will clear all your data.)

**Memory Management**

If you get an "Insufficient memory" message, a sizable chunk of memory may be occupied by material in the Clipboard. To clear the Clipboard, select a small piece of information, such as a single character, and copy the selection twice to the Clipboard. This procedure minimizes data held in the Clipboard and may free up enough memory for you to complete your task. (You must copy to the Clipboard twice because the previous command is saved in the Undo buffer; you will also want to reduce that buffer to a single character.)

**Linking with Multiplan**

When pasting data from Multiplan, you cannot copy a discontinuous area of the spreadsheet into the Clipboard. The obvious solution is to arrange your spreadsheet so that you can cut several data series as a contiguous area. This technique makes the creation of multiple data series easier when you enter Chart.

If your spreadsheet data resides in several disconnected sections, you can copy each selection separately to the Scrapbook. Then, when you enter Chart, you can paste each selection from the Scrapbook.

**Printing**

If you are preparing a chart for presentation, you can include it in a MacWrite document. Choose Copy from the Edit menu when the chart is the active window. However, choose the As Shown on Screen option—not As Shown When Printed. This command puts a screen image of the chart in the Clipboard. Then you can exit Chart, enter MacWrite, and paste the chart into your document.

You can also paste a chart into MacPaint for further graphic enhancement using the same procedure. Make sure that you have not enlarged the screen image of the chart, or it won't fit when you try to paste it into the MacPaint easel area.

You can create a MacPaint document that incorporates the whole screen by giving Mac's "snapshot" command: Shift-#-3.

Finally, if you want a quick printout of the chart window, remember that Shift-#-4 always prints a copy of the active window. If you use this technique, the printout will not be sized to fill the whole page, as with Chart's File Print command.
Review

chart pictures in documents from other applications such as MacWrite, or to copy the image to MacPaint and then add further graphic enhancements.

The filing commands work the same as in other Mac applications, enabling you to save the current version of the chart or save it under a different name on any disk.

When opening a file, you have three options:
- You can read in just the data of a file, in which case it is added as additional series data to the current chart.
- You can read in the format of a file, in which case it replaces the current format.
- If you read in both the data and the format, the current file is abandoned and the new data and format take over.

The Multiplan Link

Although Chart provides full facility for entering data from within the program, the data for a chart very often will come from a spreadsheet. This is where Chart makes a link with its cousin, Multiplan.

The common procedure for importing data is as follows:
- Enter Multiplan and open a document.
- Select one or more rows or columns that will represent categories and/or values in the chart, and copy the selection to the Clipboard.
- Exit Multiplan, enter Chart, open a new document, and specify the data type.

- Paste the Clipboard contents. Chart automatically creates one or more data series, the first row of the pasted data being used to create the data categories, as applicable. The series can then be charted as usual.

A more powerful extension of the above procedure enables you to paste and link the data, creating a permanent link between the Chart and Multiplan documents. Whenever the Chart document is opened, a dialog box will request that the disk for the Multiplan document be inserted, and any revisions to the Multiplan document will automatically update the Chart document.

The pasting procedure, with or without linking, can also proceed in the other direction, moving Chart data into a Multiplan document. If several selections must be pasted, the Scrapbook can be used to transfer them from program to program.

Although the foregoing features provide for the flexible exchange of data between different applications, they do not make for a truly integrated application. You cannot instantaneously view in chart form the results of your successive spreadsheet "what ifs." The fastest time from spreadsheet to chart, even with previously linked data, is about 1½ minutes. To approach even this level of integration, your system would need an external disk drive.

A New Tool

Well-produced charts have always been powerful, effective presentation tools. But the ability to create them has usually been confined to highly skilled (and expensive) specialists. As such, fancy charts generally have been the tools of slick publications and large corporations that have business graphics departments.

A program such as Chart on the Mac puts all that in the past. It's now easy and affordable for anyone who works with data to analyze and prove a point with more than just numbers. Furthermore, the charts that the program produces—whether on screen or printed—have the look of professional presentation graphics.

Because Chart is one of the first applications available on the Mac, people are likely to experiment with it before they get too caught up in word processing and spreadsheets. They will discover the added dimension that a chart can bring to many decision-making situations, and this will accelerate their awareness of graphics power. The day will soon come when a spreadsheet alone won't be enough.

FLASH! THE MICROCOMPUTER INDUSTRY SUPPORTS MACINTOSH!
AND MICRO FLASH COMPUTER SYSTEMS WILL BE SELLING THOSE INNOVATIVE PRODUCTS AS THEY BECOME AVAILABLE!
DEPEND ON LIGHTNING SERVICE AND SUPPORT THROUGH TELEMARKETING

MICRO
COMPUTER SYSTEMS
1110 Burnett Avenue, Suite K
Concord, CA 94520
For product information, price quotes, technical support, and California orders, please call
415/680-1157
To order from outside California, call
800/458-2433

Circle 3 on reader service card

Microsoft Chart
Microsoft Corporation
10700 Northup Way
Bellevue, WA 98004
206/828-8080
List price: $125
There are twelve million businesses in this country with fewer than ten employees. They’ve been called the backbone of the nation’s economy. They’ve been promised that new computer technology will give them a new competitive edge—eventually.

Apple has delivered the computer to fulfill that promise. And now Chang Labs has the software.

Chang Labs
The family of software solutions

(800) 972-8800 In California (800) 831-8080
5300 Stevens Creek Boulevard, San Jose, CA 95129
Review: Languages

Macintosh Pascal Preview

A look at a new Pascal, the likes of which you've never seen

Lon Poole

With one well-placed blow, Think Technologies has knocked aside the critics' major objection to Pascal—that it is too cumbersome. How? By developing an instant Pascal (scheduled for release in June) for the Macintosh. Macintosh Pascal is an interpreted, not a compiled, language. On the surface, using interpreted MacPascal means that you no longer have to wait while a compiler translates your entire Pascal program into machine language just because you changed a few program lines. An interpreter translates each statement while the program is running. Dig beneath the surface, and you will uncover several more advantages of using an interpreted language (see "Interpreters vs. Compilers").

Windows Galore

MacPascal can display up to six windows. Open the ones you want, then close them at will. Move them around, change their sizes, and overlap them, just like other windows on the Mac. One window displays the program listing. Two other windows display the program output; text appears in one and drawings in the other.
The pipeline that traverses these pages is an example of the kind of drawing you can create with a short Macintosh Pascal program.
(see Figure 1). The Pascal statements READLN, WRITE, and WRITELN normally output to the text window the same way they would on any other computer. This feature makes it easy to run existing Pascal programs on the Mac. Programs can create graphics and pictures in the drawing window. The MacPascal WRITEDRAW statement displays text in the drawing window along with the graphics. By carefully juxtaposing the listing and output windows, you can see part of the program listing while you watch the program run and display its output.

Two other windows facilitate program debugging, and another shows the Mac Clipboard. In addition to MacPascal's six windows, the Mac's desk accessories are also available. You can use them anytime a program is not running.

Program Listings
The first thing you'll notice about a MacPascal program listing is its orderly appearance. The lines are indented to show program structure, and key words stand out in boldface type. Pascal programmers call this feature "pretty printing." You can buy programs that will similarly enhance compiled Pascal listings, and a few Pascal compilers can do it themselves. Pretty printing is automatic in MacPascal; all you do is type in the program lines.

All MacPascal text appears in one font (presently Geneva), but you can select one of three sizes: small (9 point), medium (12 point), or large (18 point). When you choose a new font size, all the text changes to the new size immediately. Of course, the font size affects how many characters you can see in a window at one time. You're more likely to have to scroll the listing left and right if it's displayed in larger type.

Interpreters vs. Compilers

Andrew Singer
Currently, almost all computer programs are written in high-level languages. These languages use English phrases and mathematical notation to express complex operations in an intelligible form. BASIC, Pascal, COBOL, FORTRAN, and Ada are examples of high-level languages. The formulas in programs such as VisiCalc and Multiplan can also be thought of as high-level languages. These languages are often designed for specific applications. For example, FORTRAN was the first high-level language used for scientific computation; VisiCalc was designed for financial analysis; and Ada was developed by the United States Department of Defense for programming military information systems.

To be executed by a given computer, a program written in a high-level language must be expressed in that computer's machine language and loaded into its memory. Two basic strategies have evolved for effecting this operation, and although the end result is the same, the strategies themselves are radically different.

The most obvious method is to create a program called a compiler or translator, which reads the high-level language statements and generates the appropriate machine language for each statement. Using a compiler involves four separate stages: preparing the program, compiling it into machine language, loading it into the computer's memory, and finally, executing it.

The alternate approach is to create a program called an interpreter, which is loaded directly into the computer's memory along with the high-level language program. When the interpreter program is executed, it reads the statements in memory and immediately performs the appropriate machine language actions for each statement. A computer running an interpreter can create the illusion that it is directly executing a high-level language program.

Like most types of writing, computer program writing requires a good deal of revision and editing, usually between successive trials of the program. This process is called debugging. Since a program must express every detail necessary to perform a task, and every detail must be correct, debugging is an essential step.

When programs are developed using a compiler, the cycle of program preparation, compilation, loading, and execution must be repeated each time the program is tested and revised. In practice, each of these stages involves loading and running different programs. This procedure is both complex and time consuming. Furthermore, the machine language translation of the high-level language program is actually in code. If it fails to work correctly, the information that explains what went wrong is also in code.
Programming development with an interpreter is very different. Because the high-level language program resides in memory with the interpreter that executes it, it is easy to provide built-in facilities for program preparation and editing. Once the program and the interpreter are loaded, the user can run the program, stop it, examine it, or modify it immediately without any intervening steps. Furthermore, because the interpreter creates the illusion that it is executing the statements directly, information about problems can be given in terms of the statements; the underlying machine language and coded information can be completely concealed. A thoughtfully designed interpreter allows you to interact with and watch the program as it executes. This feature can be very helpful when you are trying to determine the source of a program error.

A vast difference exists between using a compiler and using an interpreter. An interpreter is a self-contained system; program development is immediate. Using a compiler requires more effort and detailed technical knowledge. Compiler-based and interpreter-based versions of the same high-level language are substantially different from the user's point of view. The experience of using interpreters for two languages is more comparable than using a compiler and an interpreter for the same language.

Given the preceding, you might ask why compilers are used at all. Interpreters are not without their drawbacks. They generally require more memory than compilers because both the interpreter program and the high-level program must reside in memory at the same time. A high-level language program is often longer than its machine language equivalent, and it executes more slowly when interpreted than when compiled. Finally, several technical problems have delayed the development of reliable interpreters for the more advanced high-level languages.

Until recently, these drawbacks have limited the use of interpreters. Technically sophisticated users working with expensive computers necessarily put a premium on performance. Simplicity and ease of use are greater concerns for the nontechnical user than performance, assuming that the performance is adequate. Thus, as the cost of memory declines and computing speed progressively increases and as the range of people using computers broadens, interpreters will become an increasingly attractive alternative to compilers.

Editing

If you can edit documents in MacWrite, you’ll be able to edit MacPascal programs. Almost all the standard Mac editing features are included. You get mouse selection of program code, along with the standard editing commands Cut, Copy, Paste, and Clear. (The missing ingredient is Undo.) With cut-and-paste editing, you can build a new program with very little typing. Start with a working skeleton, and tack on bits of code clipped out of other working programs and transferred via the Clipboard or the Scrapbook.

MacPascal can display up to six windows.

A Find command helps you locate variables, procedure names, or any other text in a program. A Replace command is also available in case you want to change selected instances (or every instance) of a variable or a procedure name, for example.

Debugging

MacPascal excels in the area of program debugging. You can halt and restart the program, and execute a program one statement at a time. A pointer in the listing shows which statement is being executed, making it easy to trace execution flow. You can establish breakpoints anywhere in the program by putting stop-sign icons in the listing’s margin (see Figure 2). A special window allows you to monitor the values of selected variables and expressions as they change during program execution (see Figure 3).

While the program is stopped, you can type any Pascal statement for immediate execution in a special window (see Figure 4). And because Pascal allows compound statements, one statement can be quite effective.
**Review**

**Compatibility**
MacPascal is similar to Apple's Lisa Pascal, which also makes it similar to UCSD (University of California at San Diego) Pascal. All three have the same data types, expression operators, control statements, input statements, and output statements. As for predefined procedures and functions,

MacPascal excels in the area of program debugging.

expect to find enough new ones in MacPascal to give you access to part of the Mac's ROM-based (read-only memory) User Interface Toolbox. You will have control over the extensive QuickDraw procedures for drawing, but control of windows, menus, icons, dialog and alert boxes, and buttons will be limited. Sometime this summer expect to see an advanced version of Pascal that provides full access to the Toolbox. This version will make it possible to develop software on Macs—autonomous, commercially viable applications with their own menu bars, windows, and program segmentation overlays.

```pascal
program PipeLine;

const
WindowWidth = 200;
WindowHeight = 200;
PipeRadius = 10;
NumberOfPipes = 1;
NumberOfSections = 30;
NumberOfSegments = 20;
SegmentSpace = 5;

var
PipeNumber, SectionNumber, SegmentPosX, PosY : integer;
HorizDirection, VertDirection : integer;

procedure DrawCircle;
begin
EraseOval(PosY - PipeRadius, PosX -
FrameOval(PosY - PipeRadius, PosX
end;
```

Figure 1
MacPascal has separate windows for program listings, text output, and graphic output.

```pascal
function RandomSize : integer;
begin
sign := random mod 3 - 1;
```

Figure 2
Stop-sign icons in the margin establish program execution breakpoints.
Think Technologies claims that MacPascal will be compatible with Lisa Pascal to the extent that you should be able to compile a MacPascal program on a Lisa using its Pascal compiler. MacPascal is also compatible with ANSI (American National Standards Institute) Pascal, which has extensions for MacToolbox support. If your MacPascal program uses only ANSI Pascal standard features (meaning that it doesn't include any predefined QuickDraw procedures, for example), you will be able to move it to any computer system that also supports the ANSI Pascal standard.

**Popularity Contest**

Will Pascal surpass BASIC in popularity? Who knows? The College Entrance Examination Board has cast its vote for Pascal, choosing it for their new achievement test in computer programming. That decision puts students and teachers everywhere on the Pascal bandwagon. MacPascal, with its instant no-compile execution, cut-and-paste editing, and impressive debugging aids, leaves many programmers with few reasons to choose BASIC over Pascal. If they could just get rid of those pesky semicolons at the end of almost every Pascal line... □

---

**Figure 3**
The Observe window monitors the values of variables during program execution.

**Figure 4**
The Instant execution window accommodates one (compound) statement for immediate execution.

---

Macintosh Pascal
Think Technologies
420 Bedford St.
Lexington, MA 02173
617/863-5590
Distributed by Apple Computer
List price: $125
Macware News

The latest developments in Macintosh hardware and software

Edited by Erfert Nielsen

Macware News announces new Macintosh products. In the premier issue of Macworld, we reported on many Mac products, including those under development. During the next few months, we will begin to see a repetition of the Apple II and IBM PC product explosion. The products listed this month are available now or will be in the near future. Product information offered in the premier issue will be updated as release dates and prices become available. If you're a developer who needs information about creating products for the Mac, contact Apple's Developer Relations Department, 20525 Mariani Ave., Mail Stop 23-AF, Cupertino, CA 95014, 408/973-4538.

Hardware

■ Artsci
5547 Satsuma Ave.
North Hollywood, CA 91601
213/925-2922

MAGICphone
A telephone accessory for the Macintosh that enables you to select and dial displayed phone numbers using the mouse. The unit connects to the phone line and to the Macintosh's speaker port, and can be mounted on a wall or on the side of the Mac. MAGICphone monitors two incoming phone lines and offers call holding, automatic redialing of the last number called, and a clock/calendar. MAGICphone can also record the length of calls and compute costs. List price: $200.

■ Cuesta Systems
3440 Roberto Ct.
San Luis Obispo, CA 93401
805/541-4160

Datasaver
A 90-watt battery-powered AC power backup that keeps the Mac operating during AC power interruptions or transients. The Datasaver includes overvoltage transient suppression and EMI noise filtering. Waiting time while running on the built-in battery is typically 5 to 15 minutes. External battery jacks offer extended running time. Other features include a rechargeable sealed battery, an automatic battery charger, a solid-state power supply, an AC line-voltage monitor and cutout switch, two outlets, visible and audible alarms, and a remote alarm signal for interrupt-driven computer applications. List price: $395.

■ Electronic Specialists, Inc.
171 S. Main St.
Natick, MA 01760
800/225-4876, 617/655-1532

Kleen Line Conditioners
**Practical Peripherals**
31245 La Baya Dr.
Westlake Village, CA 91362
213/991-8200

**MBIS Microbuffer**
A serial interface buffer that can be used with modems, printers, and other RS-232C devices. The Microbuffer can hold data that is sent from the Macintosh at speeds ranging from 75 to 19,200 baud to peripherals or can be used to store incoming data. The buffer comes with 32K or 64K of memory and can be expanded to 256K. The copy feature of Microbuffer allows the user to transmit data held in memory up to 255 times while continuing to input data into the buffer's memory. Additional features include odd/even/no parity, form-feed character recognition for single-sheet applications, and a reverse channel (unbuffered) for bidirectional communications. The buffer is 5½ by 7¾ by 1¾ inches, weighs ½ pounds, and comes with an AC adapter and a 6-foot power cord. List price: 32K model $299, 64K model $349, 64K memory expansion module $179.

**Accessories**

**Danefurn**
425 Huebl Rd.
Northbrook, IL 60062
312/441-7464

**Computer Furniture**
A modular workstation designed to accommodate a microcomputer and accessories. The workstation consists of a walnut-veneer computer table (47½ inches long by 24 deep by 27½ high), to which a number of extensions can be added, including a pedestal, a desktop monitor stand, a pull-out keyboard shelf, a cabinet module on casters, a stand-alone cabinet, and a desktop unit that has two adjustable shelves. List price: basic table $224, add-ons $50 to $210.

**Microdisk Minder**
A microdisk storage unit that holds 36 3½-inch micro-floppy disks. Made from molded plastic, the container has a hinged plastic lid and comes with index dividers. List price: $27.95.
Software

Harvard Associates, Inc.
260 Beacon St.
Somerville, MA 02143
617/492-0660

MacManager
A management simulation program designed to improve the user's strategic management skills. By making business decisions based on financial data, users try to maximize a hypothetical company's profits. Rather than simply displaying columns of numbers, the program uses the Mac's graphics capabilities to enable the user to view production, observe plant capacity, and monitor inventory. Documentation is included. List price: $49.95.

Megabaus Corporation
5703 Oberlin Dr.
San Diego, CA 92121
619/450-1230

MegaFinder
A data management program that has report and form design capabilities. The user can design custom forms for home, business, and personal finance applications, or use the program's ready-made forms, which include Checks, Home Inventory, Mail List, and Travel Costs. MegaFinder provides a "help" file to assist users. The program's report generator enables the user to store report formats, and a preview mode displays the report before printing. List price: unavailable at publication time.

Books

Although the Macintosh has been on the market for only a few months, publishers have anticipated the public's demand for information about this new computer. The following list represents a sample of the new releases. Several publishers have announced plans for other books on the Mac to be released in late summer and early fall.

The Apple Macintosh Book
Cary Lu
320 pages, softbound, $17.50
Microsoft Press
10700 Northup Way
Bellevue, WA 98004
206/828-8080

Introducing the Apple Macintosh
Edward Connolly
188 pages, softbound, $12.95
Howard W. Sams & Co., Inc.
4300 W. 82nd St.
PO Box 7092
Indianapolis, IN 46206
800/428-SAMS, 317/298-5566

Macintosh: The Appliance of the Future
Gerard Lewis
288 pages, spiral-bound, $29.95
Banbury Books, Inc.
533 W. Lancaster Ave.
Wayne, PA 19087
215/964-9103

Macintosh Complete
Doug Clapp
329 pages, softbound, $19.95
Softalk Publishing Inc.
11160 McCormick St.
North Hollywood, CA 91603
213/980-5074

Presentation Graphics on the Apple Macintosh
Steve Lambert
256 pages, spiral-bound, $16.50
Microsoft Press
10700 Northup Way
Bellevue, WA 98004
206/828-8080

Using MacWrite and MacPaint
Tim Field
160 pages, softbound, $11.95
Osborne/McGraw-Hill
2600 Tenth St.
Berkeley, CA 94710
415/548-2805

Macware News uses information provided by manufacturers; it does not evaluate products or corroborate manufacturers' claims. Send a description and a photograph of your new product to Macware News, Macworld, 555 De Haro St., San Francisco, CA 94107, 415/861-3861.

Macware News

MIND OVER MAC: A SERIES OF MIND CHALLENGING GAMES.
Think Educational Software
10 Market St.
Potsdam, N.Y. 13676
315-265-5636

THINK. THINK. THINK.

THINK EDUCATIONAL SOFTWARE
NEW PRODUCTS ABOUND

NEW MIND GAMES BARRETTES BANK

WASHINGTON D.C. 1983

INSTANT POWER

Circle 1 on reader service card

Our Datasaver provides spike-free, continuous AC power. Its battery keeps your system up while you shut down. 90W @ $396 — 200W for Lisa II @ $695.

Dealer or direct - VISA/MC or COD
CUESTA SYSTEMS, INC.
3440 Roberto Court
San Luis Obispo, CA 93401
805/541-4160

Datapower

Presentation Graphics on the Apple Macintosh
Steve Lambert
256 pages, spiral-bound, $16.50
Microsoft Press
10700 Northup Way
Bellevue, WA 98004
206/828-8080

Using MacWrite and MacPaint
Tim Field
160 pages, softbound, $11.95
Osborne/McGraw-Hill
2600 Tenth St.
Berkeley, CA 94710
415/548-2805

Macware News uses information provided by manufacturers; it does not evaluate products or corroborate manufacturers' claims. Send a description and a photograph of your new product to Macware News, Macworld, 555 De Haro St., San Francisco, CA 94107, 415/861-3861.

Macware News

MIND OVER MAC: A SERIES OF MIND CHALLENGING GAMES.
Think Educational Software
10 Market St.
Potsdam, N.Y. 13676
315-265-5636

THINK. THINK. THINK.

THINK EDUCATIONAL SOFTWARE
NEW PRODUCTS ABOUND

NEW MIND GAMES BARRETTES BANK

WASHINGTON D.C. 1983

INSTANT POWER

Circle 1 on reader service card

Our Datasaver provides spike-free, continuous AC power. Its battery keeps your system up while you shut down. 90W @ $396 — 200W for Lisa II @ $695.

Dealer or direct - VISA/MC or COD
CUESTA SYSTEMS, INC.
3440 Roberto Court
San Luis Obispo, CA 93401
805/541-4160

Datapower
Only One Company Offers The First, Most Comprehensive Book About The Macintosh.

Sams presents INTRODUCING THE APPLE® MACINTOSH—the first and only comprehensive book about the long-awaited Macintosh computer.

Like the computer itself, INTRODUCING THE APPLE MACINTOSH is designed for anyone who wants to improve his business productivity, but doesn't have a lot of time to learn about computing. Its many photos, two-color text and illustrations provide the technical and factual information you need to learn about the Macintosh fast and easy.

It's written by Edward S. Connolly, a respected computer author and one of the first to use the Macintosh. And like all Sams books, INTRODUCING THE APPLE MACINTOSH is easy to read and understand, no matter how much you know about computers.

If you're thinking about buying the Macintosh for your business, or you already have, this book is a must for you. Watch for other Macintosh books from Sams.

So for the first, most comprehensive book about Macintosh, get Sams INTRODUCING THE APPLE MACINTOSH, No. 22361, $12.95. Visit your local Sams dealer. Or call OPERATOR 156 at 317-298-5566 or 800-428-SAMS.

What Technology Is All About.

SAMS

HOWARD W. SAMS & CO., INC.
4300 West 62nd Street, P.O. Box 7092, Indianapolis, IN 46206

Offer good in USA only. Prices and availability subject to change without notice.
In Canada, contact Lenbrook Electronics, Markham, Ontario L3R 1H2.
Apple is a registered trademark of Apple Computer, Inc. Macintosh is a trademark licensed by Apple Computer, Inc.

Circle 16 on reader service card
Hands On: Business Graphics

Presentation Graphics Primer

Steve Lambert

Programs that enable you to create charts rapidly from raw data have increased in power and ease of use. The Macintosh uses its sophisticated operating system to make complex application programs, such as Microsoft Chart, easy to learn and use.

A chart is a mixture of art and science. In Bertrand Russell's words, it is a geometric metaphor. The numbers you have to chart may express pinpoint accuracy, but the way they are displayed greatly influences how the numbers are interpreted. An effective business chart is an editorial comment—designed not only to present facts but also to help make a decision, communicate information, or influence someone else's decision. As such, a business chart can express your opinions and point of view.

In more specific terms, a chart is a visual representation of numeric information. When you are using Microsoft Chart on the Macintosh, for example, information can be entered manually for each chart or gathered automatically from outside sources such as the Dow Jones News/Retrieval service. Once stored in the computer, numbers can be manipulated in Multiplan and passed to Chart for final distillation. (See "Exploring Microsoft Chart" for a comprehensive review of the program.)

Basic Components

A chart used to display numeric information can take many forms. The most common types of charts are column, bar, line, pie, area, and scatter (see "Types of Charts"). Although they differ in appearance, each expresses the relationship between two variables: independent and dependent. Chart refers to these variables as the category (independent) and the value (dependent). A chart is created by plotting the points corresponding to the category/value combinations, called data points. This process is demonstrated in Figure 1, which identifies the components of a basic line graph. The box on the left contains all the data points to be plotted; the category is in the left column and the value in the right column. The set of data points that describes the specific event you are plotting is called a series. Most charts can display more than one series, which means that they will have several lines or sets of bars.

Column, line, and area charts measure the category along the horizontal axis and the value along the vertical axis (see Figure 1). Bar charts reverse this relationship, measuring the category along the vertical axis and the value along the horizontal axis. Pie and scatter charts have their own methods of expressing the relationship.

Any chart's usefulness as a communication tool is due largely to the fact that the human mind, through a process known as preattention perception, comprehends a visual representation much faster and retains it far longer than words and numbers explaining the same relationship. This concept is more pleasingly expressed in the familiar proverb, "One picture is worth a thousand words."
A computerized chart program allows you to represent numerical information in a visual context that conveys meaning quickly and clearly.

Charting History

Just as it is difficult for a ten-year-old of today to imagine a world in which video arcades did not exist, most adults assume that business charts have been with us since the first enterprising ancient philosophers offered their services as business consultants. Graphic representation of numeric information is hardly a new concept, but it is not as old as one might think.

The logic behind this method of communication can be traced to Rene Descartes, the seventeenth-century mathematician and philosopher who lent his Latinized name to the Cartesian coordinate system we currently use to plot charts. The idea wasn't exactly a box-office hit at the time—the civilized world was still dogmatically caught up in Aristotelian reasoning, and proponents of "new" ideas were often called upon to support them with their lives.

Not until more than a hundred years later, in the late 1700s, did references to the use of charts in the study of history, genealogy, chronology, and finance start appearing in books. By the early 1900s graphs were in common use. Unfortunately, everyone had ideas as to how they should be created and used; the results were often confusing or misleading. In an attempt to solve this problem, a Joint Committee on Standards for Graphic Presentation was formed in the United States in 1915, in hopes of promoting universal acceptance of graphic methods by establishing standards.

Standards vs. Distortions

The passage of time has eroded many of the standards established in 1915, and changes in taste and methods of production have further modified them into less stringent guidelines. Chart takes these guidelines into account as it automatically offers numeric information in a variety of graphic formats. Whether you choose to plot a basic bar chart or a sophisticated scatter graph, the information you enter will be presented in an acceptable form. You are then free to modify it to meet your special needs.

Chart cannot force you to adhere to graphic standards when you modify the charts you create, but you will find that doing so beautifies your charts and adds credibility by discouraging some of the more blatant editorial tricks. Here are a few examples of what can happen when a person tries a little too hard to prove a point.

It is possible to change completely the apparent value of a graph by varying the length of one axis relative to the other. The three graphs in Figure 2 plot the same series of numbers: 2a follows accepted standards, but 2b and 2c have been modified to the point of distortion.
Although gathering and plotting data would seem to be the most significant aspect of creating a chart, it really isn’t. Once the other decisions are made, this part is fairly mechanical—the Mac does the difficult work for you.

It is amazing how often people will go to the effort of gathering and plotting information and then present their chart without checking to see if the numbers actually got on it correctly. Although this procedure takes only a few minutes, it can help avoid a lot of embarrassment.

**Good Taste in Graphics**

Many charting standards deal more with taste than with honesty. People judge you, your company, and its products by the quality of your letters and charts. It is to your advantage to stick to the standards in the areas of shading, labels, scales, and legends.

Shading and hatching can be used to attract attention, add interest, emphasize a point, or differentiate between chart segments. Chart and MacPaint together offer countless patterns, but don’t try to use them all on the same chart. If you think you need more than five or six patterns, it’s probably time to redesign the chart. Multiple patterns should be arranged in order from dark to light (see Figure 5).

Titles and labels should be descriptive and short enough to be printed on one line. If you are charting

---

**Creating a Chart**

The process of creating an effective business graph can be divided into four stages. You must identify the purpose, select a format, gather and plot the data, and check for accuracy.

Every graph should have a well-defined purpose. The same information can be presented in a variety of ways, with implications from positive to negative to nonsense. If you are going to take the time to create a graph, make sure that it works for you.

Many graphic formats are available, but usually only one is appropriate for both the type of data you want to present and the audience to whom you are presenting it. Choose both carefully.
sex in the suburbs, the title of your graph should be "Sex in the Suburbs," not "Courting and Reproductive Rituals Practiced in Outlying Residential Communities."

Your choice of scales should make it easy for readers to interpret the plotted points. Measurements should start from zero, if possible, and extend to a value just greater than the maximum (or minimum if negative) number plotted.

When a graph displays more than one series, each is represented by a different pattern. A legend, as shown in Figure 6, can be used to relate each pattern to the series it represents. Chart will provide a legend at your request. If you change its size or location, consider the overall weight and balance of the chart.

Fortunately, Chart consistently follows these standards. You have to be concerned with them only if you make modifications. Some creative people have become rich and famous by disregarding standards and adding their own imaginative flair to everything they do, while others remain unemployed due to the same flair. Unless you have absolute confidence in your creative genius, you should follow the established guidelines.

**Purposeful Business Charts**

Charts created for business purposes fall into three broad categories: personal decision-making, peer information, and presentation. The methods used and the standards applied differ for each aim.

Personal decision graphics help you make decisions based on the rapid manipulation of data. A practical method of doing this is to link a chart created with Chart to a model created in Multiplan. Each time you instruct the Mac to plot a linked chart, it reads the current values of the variables from the Multiplan file.
Types of Charts

Whichever category your chart falls into—personal decision-making, peer information, or presentation—a number of graphic formats are available to present your information. The format you select should be determined by the audience the chart is intended for and the type of information to be plotted. Here are the six basic chart types and a few standards that apply to each.

- **Column.** The column chart is commonly used to show variations in the value of an item at equal time intervals. You can compare the variations of several items by plotting the values of each on the same chart, either by stacking the resulting columns on top of each other or by placing them side by side. The figure labeled "Column Chart" displays the same information in different column formats.

  When you plot multiple columns, the order of plotting, the amount of overlap, and the spacing between groups affect the balance of the chart and therefore its effectiveness.

- **Bar.** Although a bar chart looks like a column chart rotated 90 degrees, there are other significant differences. The main difference is that bar charts usually compare the values of different items at a specific point in time. The figure labeled "Bar Chart" shows a multiple-series bar chart in the 100-percent stacked format. In this format the segmented bars extend the entire width of the plot area; each segment's length is proportional to its contribution to the whole.

  • **Line.** The line graph effectively presents large amounts of quantitative information in a form that enables readers to recognize trends and relationships quickly. The fluctuation of the line indicates variations in the trend, while the distance of the line from the horizontal axis at any given point indicates a quantity. By plotting multiple lines on the same axes or placing several graphs on the same page, you can evaluate information rapidly and form opinions about cause-and-effect relationships. This type of chart is particularly popular with financial forecasters and other prophets; they often put as many as 20 small charts on one page, tracking all aspects of a company's financial condition.

  • **Pie.** The pie chart is universally recognized and understood. It is the least intimidating of all formats, probably because it is impossible to express a complex relationship with it. Pie charts are used to compare relative proportions of parts that make up a whole. A circular pie represents...
the totality, and the size of each sector shows its share. The arrangement of sectors allows you to compare them to each other as well as to the whole.

• **Area.** You can create a simple area chart by filling in the space below the line on a line chart—perhaps with a pattern from *Microsoft Chart* or an illustration created in *MacPaint*. More complex area charts are created by plotting several series on the same axes. Each series is represented by one band—the thickness of the band at any point indicates its value at that point. The bands are stacked one on top of another, so the distance from the horizontal axis to the top of the upper band indicates the sum of all the bands at that point. The order in which you choose to plot these bands can have a significant effect on the finished product, as shown in the figure labeled "Area Chart," which charts the same information twice with the bands arranged differently.

• **Scatter.** The scatter chart is used to determine the relationship between two variables, which can vary from none at all to very substantial. This relationship is measured by computing the correlation coefficient (referred to as $r$) for the graph; *Chart* will perform this task for you. The value of $r$ will always fall between -1 and +1. A positive value indicates that as one variable increases in value, so should the other. If $r$ has a negative value, you can expect that one variable will decrease as the other increases. The closer $r$ is to plus or minus one, the more direct the relationship between the variables; a value of zero indicates a random association. A typical use of scatter charts is to discover an unusual condition buried in a mass of similar conditions, such as a deviation in the expected return rate of a product when certain production parameters change. The figure labeled "Scatter Chart" shows two scatter charts and their correlation coefficients.

*Chart* allows you to select a chart format from a gallery of stock variations by pointing to a picture. Your data will be plotted automatically in that format, and you can modify it to suit your specific needs. Combinations of these formats are also possible, both in *Chart* and by sending the individual charts to *MacPaint* and combining them there.

---

**Area Chart**
The two charts show the same information with the bands arranged differently.

**Scatter Chart**
The two charts show a low and a high correlation coefficient.
Hands On

Presentation graphics are charts of the highest level, designed to prove your point emphatically and impress your audience. With a little practice and some artistry, you can create charts of this quality using the Mac, and for some occasions you can use them just as they come out of the printer. Often, however, when you need illustrations for an important sales presentation or inclusion in an annual report, you will use the Mac to produce rough drafts in a variety of sizes, shapes, and styles.

Special symbols, a logo, or an illustration can be added in MacPaint, and once you decide which charts to include in your presentation, the rough drafts can be given to a graphic artist to use in producing the final version by hand. Better yet, they can be telecommunicated to an agency that can reproduce them in minutes on a high-resolution (over 2000 lines) graphic terminal. Colors, three-dimensional views, or pictorial overlays can be created from your draft, and slides, transparencies, or color photos can be produced and returned to you almost immediately.

Know Your Audience

The audience for which your charts are intended has a definite bearing on which format you select and how complex you let the chart become. An audience familiar with graphing techniques and with the information you are plotting can be expected to appreciate complex relationships expressed in a sophisticated fashion, such as a multiple-line graph with logarithmic scales. The same information presented at the stockholders’ meeting might be understood more easily if displayed as a series of separate line graphs on different scales.

In today’s fast-paced business world, in which busy executives are called upon to make split-second decisions that have long-term effects, the picture generated by a computerized charting program may be worth far more than a thousand words.

Microsoft Chart
Microsoft Corporation
10700 Northup Way
Bellevue, WA 98004
206/828-8080
List price: $125
We have to make this announcement.

(But we’d rather be playing with our Macs.)

In other words, there is about to be an entire industry dedicated to the Macintosh, and we’re getting ready to put it all together for you.

While we’re waiting, let’s get personal.

So, what is happening at Mac Connection to prepare for this onslaught of Macintosh-related products? Well, every morning we get up, hop in our ‘64 Ford Pickups, ‘70 Pontiacs, and Saab Turbos, and drive to work in scenic Marlow, New Hampshire (pop. 542). All day long we play with Macintosh computers. Our excuse is that we have to know as much about the Mac as we possibly can.

But that’s just an excuse. Actually, we’re hopelessly in love with the machine.

When we’re not sending our mice careening all over our desks, we’re examining and evaluating forthcoming products for the Mac. And soon we’ll be talking to you on the phone. Telling you what works best for what you want to do. And offering you not-quite-unbelievable-but-very-impressive low prices for Mac products.

How and when to beat a path to our door.

Do not call, write or visit... yet. No operators are standing by. And our trained consultants are still in training. We call them trained consultants because they will guide you through the maze of potential Macintosh add-ons and software. They don’t earn commissions. They just give good advice.

Very soon, MacConnection will have its very own 800 number, its very own warehouse, its very own showroom, and its very own very knowledgeable consultants. Be looking for details in subsequent issues of this magazine.

For now, just remember the name—MacConnection.

And since we’ve made our pitch, let’s all go back and play with our Macs.
Creating a Custom Chart Format

A tutorial that takes you beyond Chart's preformatted options

Andrew Fluegelman

Once I had experimented with some of the options Microsoft Chart offers, I started to become aware of how professional-quality charts are formatted. Looking at several local and national newspapers, I noticed that they routinely illustrate their stories with a unique style of column chart. The most noticeable features of these charts are that the value axis is on the right of the chart and that the background of the chart is shaded, with white horizontal grid lines.

The twelve figures that follow show how to create this format, which I have dubbed "newspaper style." The steps will take you through some of the more advanced custom features of the program. They particularly illustrate how the Patterns choices from the Format menu change according to which element of the chart has been selected.

To reuse your custom format, save the chart, then choose Open from the File menu. You'll get a dialog box; click Format Only to call up your format. It will be instantly available for any new data you wish to illustrate.

The finished "newspaper style" chart shown above uses several of Microsoft Chart's custom features. To begin the chart, create and plot one or more data series, choose Manual Redraw from the Chart menu, and make the chart window active.
Choose Column from the Gallery menu and select option 4 to make the columns for different series overlap.

Choose Axes from the Chart menu. Click off showing the values axis and click on showing the values major grid lines.
Select the categories axis by clicking where the axis appears on the chart. Then choose Patterns from the Format menu and make the major tick marks invisible.

With the categories axis still selected, choose Axis from the Format menu and specify the other axis to cross at category number 63. (This will ensure that the values axis will be at the far right regardless of the number of categories.)

Now select the values axis by clicking on one of the values labels on the chart. Choose Axis from the Format menu and specify a "high" label position. (This positions the labels to the right of the values axis.)
Next, select one of the grid lines by clicking on it. Then choose patterns from the Format menu and select the white line pattern and the medium bold line weight.

Choose the Select Plot Area option from the Chart menu. Then choose Patterns from the Format menu and select the 25% gray background pattern.

Select the chart title by clicking on it. Type in a new title if you wish, then choose Text from the Format menu and specify bold type.
Choose Add Legend from the Chart Menu. Once the legend appears on the chart, select the legend by clicking on it and then reposition the legend by dragging it to the upper-left corner of the chart.

With the legend still selected, choose Patterns from the Format menu and select a white background for the legend.

Choose the Select Chart option from the Chart menu. Then choose Patterns from the Format menu and select a black, shadow-style border. De-select the chart by clicking outside the chart window.
The Maccessories SWIVEL is a lightweight, durable lazy susan that fits neatly under your Macintosh. The SWIVEL revolves a full 360° and lets you adjust the viewing angle of your Macintosh with the touch of a finger.

Since the SWIVEL attaches to the bottom of your Macintosh computer, it goes everywhere your Macintosh goes, even inside the Macintosh carrying case.

The Maccessories SURGE SUPPRESSOR protects your Macintosh against power problems. Its circuitry stops surges and spikes, and filters out aggravating line noise. Simply replace your Macintosh power cord with the Maccessories SURGE SUPPRESSOR and you're ready to go.

Maccessories STARTER PACK. Start your Macintosh off right with this money-saving kit containing the SWIVEL, SURGE SUPPRESSOR plus an anti-static DUST COVER to keep your Macintosh dust-free.

Maccessories are exclusive products of Kensington Microware, at Apple dealers everywhere.
How the Macintosh Works

The bits and bytes of computing on the Mac

Cary Lu

Computers process information—numbers, words, and graphs. To be practical, a computer must take in information (input), manipulate the information (processing), get the information out (output), and save it (storage). These jobs are handled by the key hardware components of the Mac and the programs that tell them what to do. Even if you know how other computers work, you'll find that the Mac works differently.

Building Up a Mac

Let's start with the most basic components: a keyboard to enter information, a microprocessor to manipulate it, and a video screen to display the output (see Figure 1). Suppose you want to type the letter A. When you press the A key, the keyboard generates an electrical signal that corresponds to the letter A. This signal is sent to the microprocessor, which turns it into a different electrical signal and sends it to the screen.

These steps are physically accomplished by the Mac's hardware: the keyboard, the microprocessor, and the video screen (and the wires and the screws that connect them).

Computer programs, or software, control all the hardware. Software is nothing more than a set of instructions for the microprocessor. It enables the microprocessor to understand the keyboard's signal for the letter A and to create the dot pattern that produces an A on the screen.

Adding Storage

The hardware and the software constitute no more than a video typewriter—interesting perhaps, but not very useful. A computer needs to be able to move, copy, and otherwise work with keyboard entries. To do this, it requires a kind of scratchpad, a place to keep the keyboard characters while manipulating them.

Random Access Memory (RAM)

The computer's scratchpad is an electronic storage area called random access memory, or RAM (see Figure 2). RAM is fast; characters can be stored or retrieved
in a microsecond (one millionth of a second). "Random access" means that the microprocessor can go instantly to any spot in the storage area for information, without having to look at any other part of memory first, and can then jump forward or backward to another spot without having to read information in between. RAM has one major limitation—it is transient. When the power goes off, anything stored in RAM disappears.

A special area called video RAM is set aside as a map of the screen. Software controls this area to produce the images you see.

**Read-Only Memory (ROM)**

Programs must be held in electronic memory to instruct the microprocessor, but not all software operates from random access memory. Because RAM offers only temporary storage, some instructions, such as the program that tells the microprocessor what to do when the power comes on, can't stay there. These programs are held in another form of electronic memory called read-only memory, or ROM (see Figure 3). ROM is permanently stored on a wafer of silicon, or chip.

In all computers, ROM contains the initial instructions for starting the computer. The Mac's ROM also contains essential programs for controlling how a disk drive works, interpreting input from the keyboard and the mouse, and drawing graphics or text on the screen.

From the microprocessor's standpoint, ROM is simply another information source, just like RAM and just as fast. But whereas RAM is transient, ROM is fixed. Once the computer leaves the factory, its ROM is permanent, whether the power is on or off. The only way to change it is to replace the ROM chip itself. Because ROM is not quite as permanent as hardware, ROM programs are sometimes called firmware.

Like text or graphics information, computer programs may also be stored on disk files. Before a program can be used, it must be read (temporarily transferred) into RAM for fast, effective operation. When you insert a MacWrite disk, for example, and use the mouse to select the program, the computer transfers a copy of the MacWrite instructions from the disk into RAM. If you quit MacWrite and change to MacPaint, the MacWrite instructions are replaced with a copy of the MacPaint instructions. In both cases, the programs also remain permanently stored on the disk.

Now let's look briefly at how information is coded and how it travels through the computer.

**Bits and Bytes**

A computer can process only information it understands. Computers understand electronic signals having two states: on and off. They process information as individual on/off signals, or bits, coding each bit as 1 (on) or 0 (off). (In some cases, 1 is off and 0 is on, but the principle remains the same.) Because one bit can't convey much information, a computer strings many bits together to create something useful. A single character (a letter of the alphabet, a number, or a punctuation mark) is coded by eight bits in sequence, or one byte. The letter A, for example, is 01000001, B is 01000010, and so on. Each hardware component—keyboard, memory, or disk drive—codes the letter A the same way.

And because the information content of a single byte is limited, it is measured in kilobytes. One kilobyte (K) equals 1024 bytes. Although kilo ordinarily means 1000, a kilobyte isn't an even 1000 bytes, because the computer's counting system is based on the number 2, not the number 10. Two multiplied by itself ten times is 1024.

Disk file size is customarily measured in kilobytes. A 6K file contains about four pages of text, or 6144 characters (a typical double-spaced typewritten page holds about 1500 characters). A 6K file doesn't have to consist solely of characters; it can also be a program or a picture of equivalent length.
A CPU's power depends on three factors:
- How much information it can work on at once, measured in how many bits (called input/output, or I/O, bits) the CPU can take from and put onto the bus at one time (16 bits in the 68000), and how many bits the CPU processes internally at one time (32 in the 68000).
- How many different kinds of instructions it can perform.
- How fast it operates (how much time each instruction requires).

By current standards, the 68000 is a more powerful chip than others commonly used in microcomputers, but the differences among chips are less important than some advertisements claim.

The CPU is powerless by itself. To do anything useful, it carries out, one at a time, step-by-step instructions provided by software. An instruction might read: "Take the information stored in memory location 125, add 1, and put the result in location 240." Or it might say: "Take the character placed on the bus by the keyboard and put it in memory location 300." Each step is simple. Computers do useful work because they can perform millions of steps in rapid succession.

**ROM Software**

Software comes in many forms, some built-in and some available on disks. Some essential software tells the microprocessor how to read a disk drive, while other programs can draw a picture of a disk drive.

The Mac's 64K ROM contains the key to its operation. Among current microcomputers, only the Lisa and the Mac have such a comprehensive collection of programs in ROM. These programs make the Lisa and the Mac what they are—the first microcomputers to have a powerful visual interface.

The ROM software controls the interface. It draws most of what is displayed on the screen, monitors the mouse, and does much more. It defines the way we deal with application programs—the word processors or the spreadsheets that we use for our work. ROM programs make up a kind of programmer's toolkit, to be used by both professional and amateur programmers. This unique interface enables different Mac applications to work in much the same way.

The Mac's ROM programs include the following:
- QuickDraw creates complex graphics on the screen quickly.
- The Font Manager uses QuickDraw to create typefaces on the screen.
- The Event Manager keeps track of what you do with the mouse and the keyboard.
- TextEdit is a basic text entry and editing program.
- The Window Manager draws and controls windows on the screen.
- The Control Manager creates and monitors the dialog boxes and the buttons you choose within the boxes.
- The Menu Manager creates and monitors the pull-down menus.
- The File System creates and controls files in memory and on disk.

**The Operating System**

A fundamental program called the operating system acts as a traffic cop, keeping track of and directing all Mac operations. It manages everything in memory and keeps track of information going to and from each component: disk drive, printer, keyboard, and screen.
In conventional microcomputers, the operating system is read from a disk and stays mostly in RAM when the computer is working. Some popular operating systems are Apple DOS (Disk Operating System) for the Apple II, CP/M-80 (Control Program for Microprocessors), and MS-DOS (Microsoft Disk Operating System).

In contrast, most of the operating system (which has no name) resides in ROM. The rest is stored in a file named System on the disk used to start the Mac. This file is read from the disk into RAM when the computer is first turned on; it adds to or modifies the ROM instructions.

The System file contains information such as the specific keyboard layout. Storing this information on disk makes changing to a foreign language keyboard easy; Apple merely changes the System file used with foreign versions of the Mac.

The System file contains many other programs, including the following:

- **Utility programs.** Some of these are nearly as important as the operating system; others are simply handy. When you select a file icon and then choose Get Info from the File menu, for example, you are actually starting a small utility program that checks that file and displays information about it.

- **Desk accessories.** The menu under the Apple symbol (far left on the menu bar) lets you choose functions such as Clock, Calculator, and Note Pad. Because these programs are short, they can usually share RAM space with an application program.

- **Font data.** This information dictates the font (the actual shapes of the letters you see on the screen). Several fonts are essential to the Mac's operation, such as the ones you see in the Finder and the main menus. Many additional fonts and type sizes are also available from this file when you are using MacWrite, MacPaint, and other programs. To create these fonts, the operating system transfers the information from disk to RAM. If you change fonts or greatly change type size, you may have a short wait while the Font Manager program in ROM goes back to disk to bring the new information into RAM.

Because information about each font takes up considerable disk space, you may want to use the Font Mover program to store rarely used fonts on a separate disk when working with applications that do not require multiple fonts.

- **Messages.** Both warning and advisory messages reside in the System file. For foreign versions of the Mac, Apple can change this file to give messages in another language. (The ROM programs contain no text in any language—only graphics.)

**You may want to use Font Mover to store rarely used fonts on a separate disk when working with applications that do not require multiple fonts.**

**The Finder**

Another important program stored on disk and read into RAM when you first turn on the Mac is the Finder (sometimes called the Desktop Manager). The Mac Finder includes many functions traditionally performed by a computer's operating system. It handles most operations that involve disks: creating the disk window with its file icons, copying files, copying disks, and so on. The Finder doesn't work alone; it uses many programs in ROM for actual disk access, in effect acting as a liaison between users and the ROM programs that control the disk drive.

Each disk has a directory that functions as its table of contents. The directory contains a list of files on that disk, along with each file's icon and other attributes. When you insert a disk, the Finder puts this directory information into RAM, where it remains even if you change disks. You can display the directory of an ejected disk on the screen, but if you want to open a file on it, the Finder asks you to change disks.

For each disk, the Finder creates a hidden Desktop file to hold information about each file on the disk. The Desktop file notes whether the file is an application program or a data file. If it's a data file, it records which application program created it, and it keeps track of the icon images associated with that file. Because the Desktop file stores information about which application created a data file, the operating system loads that application if you merely open the data file.

**The Clock/Calendar**

The Mac has a battery-operated clock/calendar whose time and date are read into RAM. Every time you create or modify a disk file, the date is automatically stored with the directory entry. This time-and-date keeper drives the desk accessory clock also.

**Application Programs**

Application programs are designed to do work. MacWrite produces written documents, MacPaint creates illustrations, and Multiplan works on financial calculations. Permanently stored on disk, application programs are read into RAM when you need them. Because these programs are large and complex, only one will fit in RAM at a time. If necessary, the operating system moves programs or files from RAM to disk to make space for the application.

Even such maneuvering cannot free enough space for some large programs. Many sophisticated applications simply won't fit into RAM all at once. These programs operate with a core program that stays in RAM, plus subsidiary components called overlays that remain on the disk until needed. As you select functions—sorting routine or trigonometric calculations, for example—the core program brings needed overlays into RAM. Each new portion replaces other overlays not currently in use.
Although the overlay procedure enables you to use powerful programs, it slows operation. On a Mac having more memory, overlays would usually be unnecessary; RAM could contain an entire application, and the programs would run much faster. With enough memory, several application programs could be in RAM at the same time, and you could switch applications instantly, without waiting for the disk drives to read the new program into RAM. The Lisa works in this way.

The Many Uses of RAM

The Mac has much more activity going on in RAM than a conventional microcomputer. Its RAM holds a lot of software including video memory, parts of the operating system, utility programs, desk accessories, current font data, icon images, the Finder, disk directories, and the Clock/Calendar. RAM also contains two forms of data: that used in the application program and the Clipboard.

The point of all this software, of course, is to do something with information. You may enter data into the computer through several routes: the keyboard, the mouse, from a disk, or from another computer—either over a telephone line or through a network that links computers.

From an application program's standpoint, the source of the data doesn't matter. In most cases, the program will put the data into RAM before beginning work. If the data won't fit in RAM, the program will read some into RAM and leave the rest on disk, swapping chunks as needed.

The Clipboard

Whenever you cut or copy anything from the screen, that information goes into the Clipboard, an area of RAM set aside for information exchange between programs. For example, you may want to cut a series of numbers from a Multiplan spreadsheet and paste it into a MacWrite document to include a financial statement in a memo. You can store text, a drawing, or numbers in the Clipboard, but only one item at a time. If you need to store more items, paste the Clipboard contents into the Scrapbook, which leaves room in the Clipboard for another item.

Using MacWrite

The following is a brief outline of what happens when you start MacWrite. The outline is not complete, and events don't occur quite so linearly, but it will give you an idea of how the Mac system works.

When you turn on the Mac, a ROM program called Boot tells the microprocessor to check whether a disk has been inserted in the drive. (The term boot comes from the idea that the computer is pulling itself up or on by its own bootstraps.) If there is no disk, the Boot program puts on the screen an image of a disk with a question mark, in effect asking you to insert a disk.

Once a disk is in the disk drive, the program instructs the disk controller circuitry to send the proper electronic signals to the disk drive to move the disk-drive head to the disk's outer edge and begin transferring information from the disk into RAM. First, the System file containing the RAM portion of the operating system is read from the disk. The Mac then reads in the Finder from the disk and creates the Finder display.

To find out what program and data files are stored on the disk, you select the disk image by clicking on it using the mouse pointer, then choose Open from the File menu. The Finder creates a window showing the file icons and names.

Move the mouse so that the pointer is over the MacWrite icon. The Event Manager (in ROM) detects the mouse position. Double-click on the icon. The Event Manager tells the Finder about the clicks. The Finder checks the pointer location and concludes that you want to open the MacWrite file.

The Finder checks the disk directory for the location of the MacWrite file and passes the file location to the disk controller, which starts turning the disk and moves the disk-drive head over the beginning of the file.

As the disk-drive head reads the MacWrite file, the disk controller puts the information on the bus. From the bus, the information passes into RAM, in space allocated by a special ROM program called the Heap Manager.

Once in memory, MacWrite begins changing the screen. It replaces the Finder menu bar with the MacWrite menu bar, showing the MacWrite selections. The Window Manager (in ROM) puts a window on the screen, complete with scroll bars and title.

The Font Manager (in ROM), which has been busy creating the text on the screen, also checks the System file to see which fonts it contains. It passes on the number and the available sizes of each font to the Menu Manager (in ROM), which sets up the Fonts menu.

As you can see from this list, even something as simple as starting a program requires many steps. That the procedure works at all is amazing; that it works so well is a tribute to thousands of engineers and programmers who, during the last 50 years, have made computers possible.

Ellen Chu made a major contribution to the writing and editing of this chapter, along with Joyce Cowen.

The Apple Macintosh Book
Cary Li
Microsoft Press, Bellevue, Washington, 1984
383 pages; $18.95
This month's Open Window includes two unique items. The first unveils one of the Mac's hidden features. In fact, this feature is so well hidden that no amount of computer expertise could have helped you discover it. Only luck and wild fingers on the keyboard would have unearthed this treasure. An unnamed source at Apple clued us in to what we now call the Mac's secret characters.

The other item is a useful tip not included in the Microsoft BASIC manual: a short terminal program for opening and configuring the Mac's communications port.

Secret Characters

The graphic characters shown on the following pages can be produced by holding down the Option and Shift keys and pressing the tilde/accents key (the uppermost key on the left side of the keyboard). The font and font size that produce each character are listed next to the corresponding character. The characters in the chart were created using MacPaint; MacWrite also provides the secret characters, but its font selection does not include San Francisco (cars) and its font sizes do not extend beyond 24 point.

The outlined font sizes in the Style menu tell you which sizes are optimum for displaying a particular character. For example, 14-point Venice is best for displaying the decorative graphic character. In other font sizes, the Venice graphic character loses its smooth, curved shape and has a boxy appearance.

The secret characters are ideal for enhancing MacWrite documents, especially since you don't have to cut and paste them from MacPaint. You can use them in creating decorative letterhead stationery, placing doodads in your letters, or as a new form of expression in your text. Invent your own ways to use the secret characters. For example, you can add underlining between birds on a wire (14-point Geneva) so that the birds are less cramped on the line. You can also use features such as Bold or Shadow from the Style menu to enhance the characters.

If you are printing in high resolution, the Mac scales down characters from larger font sizes to create higher resolution. For example, 24-point Geneva rabbits are scaled down to create 12-point Geneva rabbits in high resolution. That's why 9- and 18-point, 12- and 24-point, 18- and 36-point, and 24- and 48-point characters are the same in New York, Geneva, and Toronto. The 14-point characters in those fonts are available in one size only.

A few of the fonts and font sizes (Chicago, London, and some of the Monaco font sizes) give you the "missing" character symbol (a white box), but these symbols might be replaced by other secret characters in future versions of the software.

Eventually, you may even be able to create your own customized set of "secret" characters. All Mac programs use the Resource Editor for creating and modifying the Mac system resources such as fonts, dialog boxes, icons, and cursors. This utility allows software developers to define the appearance of system resources.

The secret characters are created in a part of the Resource Editor called the Font Editor, which displays characters at the dot-by-dot level, as if they were in FatBits in MacPaint. Characters can be redrawn by applying the same technique used in FatBits. A key-mapping procedure translates keyboard signals into ASCII (American Standard Code for Information Interchange), a numerical binary code that the machine can understand.

This code tells the Mac which key or combination of keys was pressed; then the corresponding character in the Font Editor is displayed on the screen. A separate version of the Font Editor that allows users to create their own fonts and "secret" characters may be available sometime in the future.

Who knows what other treasures lurk within the Mac? Stay tuned.
Open Window

MBASIC Term

The program listing "MBASIC Term" will let you open the Mac's communications port, set the bps rate, data bits, parity, and stop bits, and operate as a simple terminal program written in Microsoft BASIC.

This program is just a shell—you will have to add your own bells and whistles—but it works.

Corbett Thompson
Bellerue, Washington

Perhaps you've come up with a nifty routine, gained some insight into how the Mac or an application program works, or even written a short program that performs a useful function or creates an interesting diversion. Tell us about it, and we'll pass your discovery along. We'll also pay $25 to $100 for each Open Window item published. Send Macintosh discoveries to Open Window, 555 De Haro St., San Francisco, CA 94107, or electronically to CompuServe 74055.412 or The Source STE908.

```
10 '***** MICROSOFT BASIC TERMINAL PROGRAM *****
20 ' define the communications hardware constants
30 NO.PARITY=0;ODD.PARITY=&H1000;EVEN.PARITY=&H3000
40 STOP 1=&H4000;STOP 1.5=&H8000;STOP 2=&HC000
50 DATA5=0;DATA6=&H800;DATA7=&H400;DATA8=&HC00
60 BAUD110=1023;BAUD300=380;BAUD1200=94
70 BAUD2400=46;BAUD4800=22;BAUD9600=10
80 ' initialize the Macintosh hardware
90 DIM CODE%(55)
100 ' *** change the following assignment for different ***
110 ' *** stop bits, data bits, baud rates, and parity ***
120 CODE%(28)=STOP 1+DATA 7+BAUD 300+EVEN.PARITY
130 '******************************************
140 MASK%=255:IF (CODE%(28) AND &HCOO)<> &HCOO THEN MASK%=127
150 FOR I=0 TO 13:READ CODE%(I):NEXT I
160 COMINIT=VARPTR(CODE%(0));CALL COMINIT
170 DATA 16890, 26, 12668, 8, 26, 12668, -7
180 DATA 24, -24572, 12668, -6, 24, -24572, 20085
190 ' choose Monaco-9 as the text font
200 CALL TEXTFONT(4):CALL TEXTSIZE(9)
210 ' open the communications port
220 OPEN "com 1; AS #1
230 ' *** Main Terminal Loop ***
240 ' display any available characters from the command line
250 IF LOC(1)=0 THEN 290
260 CH=ASC(INPUT$(1,1)) AND MASK%
270 IF CH<>10 THEN PRINT CHR$(CH)
280 ' transmit any available characters from the keyboard
290 K$=INKEY$
300 IF LEN(K$)>0 THEN PRINT #1, K$;
310 GOTO 250

MBASIC Term
```
The Macintosh has a new ring.

The ARTSCI MAGICphone™ creates an entirely new aspect to the APPLE Macintosh™, that provides a spectrum of voice/telephone communications.

Software is provided to manage and dial hundreds of phone numbers and will record and print the details (time, number, and charge) of each call. The phone log can be printed on a daily, weekly, or monthly basis. The mouse is used to select and dial any phone number, and MAGICphone uses TONE dialing to any of the lower-cost telephone carriers like SPRINT and MCI.

The MAGICphone also allows control of two separate phone lines. A “hold” feature for each line with lighted indicators is provided. You can then call someone to the phone or pick up an extension and continue the call. The MAGICphone can temporarily stop incoming calls, and the caller will hear a busy signal.

The MAGICphone can be used as a stand alone telephone without Macintosh control. Tone dialing and last number redial are standard features.

Installation is a snap. You simply plug the MAGICphone into your Macintosh speaker jack, and into your phone line.

Available now. $199.95.
Visiting scholar Yoshihoro Taki, a professor of mechanical engineering at the University of Tokyo, was standing with his wife just outside the door of the computer demonstration lab at Stanford. The university’s first two Macintoshes were on display, having been on campus less than a week. The Takis were first in line when the lab opened at noon. They spent their allotted hour taking the Guided Tour (the Mac audio cassette and programmed disk tutorial) through the MacPaint graphics program. Then, as a crowd of eager students and faculty members surrounded the machine, they worked their way outside.

“I have to have a Mac,” Taki proclaimed. “There is nothing else like it.” His wife nodded enthusiastically. She found the machine every bit as fascinating as her husband did and was as disheartened as he at the prospect of returning to Japan Mac-less.

“Maybe my school can join the University Consortium Program in Japan soon,” he added hopefully.

What caused the Takis such consternation? A combination of the capabilities of the Mac and the advantages of the Apple University Consortium Program. This fledgling
Some Stanford students get their first look at the new Macintosh. Apple's "seeding" program will make Macs accessible to the entire campus.
Macintosh community is one of the first signs that computers are about to graduate into the world of advanced learning.

In an unprecedented move, Apple Computer has agreed to "seed" a large number of computers in member schools that signed a consortium agreement prior to public release of the Mac. In return for a substantial commitment from each consortium participant to purchase equipment yearly, Apple is offering sharply reduced bulk-purchase prices that universities can pass along to faculty and students, and also the tools, the program debuggers, and the technical support necessary to enable the schools to create their own software and networking.

Apple's goal is to generate a flurry of educational software development for the machines shortly after they reach the market. The colleges, having access to large numbers of Lisa 2s and Macs at prices that make them affordable for every student and professor, can move into 1984 with the biggest step forward in education since Dewey devised his decimal system for the card catalogue. In the words of one of the consortium's members, the Mac is the first computer that's "more like a textbook than a calculator."

The Consortium Begins

On the day the Mac was released, the members of the consortium were (in alphabetical order) Boston College, Brigham Young, Brown, Carnegie-Mellon, Chicago, City University of New York, Columbia, Cornell, Dartmouth, Drexel, Harvard, Michigan, Northwestern, Notre Dame, Pennsylvania, Princeton, Reed, Rice, Rochester, Stanford, Texas, Utah, Washington, and Yale. The plans at these institutions range from ambitious (at Drexel each of the 1800 freshmen will have a Mac by the time this magazine goes to press) to conservative (several schools plan to offer only discounts on machines).

Following are profiles of futuristic programs being implemented at three of the consortium schools. The challenge of using this new tool and the success (or failure) of the consortium's attempts will have an enormous impact on the way thousands of students gain their higher education.

Brown University

"If you go into a first-grade classroom, you'll see hundreds of learning tools for all levels and styles of learning," explained William Shipp, associate provost at Brown. "We're talking about doing a similar thing at the university level.

"We want to be the first 'wired university,' and unlike several programs at other schools I've heard of, we are aiming our efforts at the entire university. We want to put the library card catalogue on-line, set up a network for mail and dialogue among all members of the university, continue developing innovative courseware, and keep refining and honing our approach in response to studying the impact of this experiment upon scholarly life.

"We want to create an advanced system of electronic workstations, because we'd like to see a true sharing of information. Brown University wants to lead the way in the innovative use of computers, both within and outside traditional scientific disciplines."

The Mac is the first computer that's more like a textbook than a calculator.

The jargon is new to this environment and the plans are exciting, but who will pay for this influx of technology?

"For the first time, we will ask students to 'capitalize' a portion of their education," Shipp said, "not just to take information passively, but to acquire a machine that they can continue to use."

"There's another important thing we want to encourage," Shipp explained. "Why not extend your connection with the university after you've left, through continued access to university networks? The Mac is the first affordable machine that everyone should be able to use. Here, everyone will."

Brown University opened a campus computer store in October 1983. In its first month it did $537,000 worth of business. Macs at substantially reduced cost will continue to be available to students. Although owning one will not be compulsory, the idea is eventually to generate enough work on the Apple systems to make them indispensable. There will be clusters of Macs (and Lisa 2s) in various locations around the school, such as the library, dormitories, and departmental offices. Planned networks and the capability for leaving comments about one person's paper for everyone else in a course to read might change the way that students and faculty interact. Truly "synergistic" education, in which the input of many people stimulates each class member, might be at hand.

Brown University intends to make a number of the more powerful Lisa 2s available to its faculty. Through the Institute for Research in Information and
The Mac Matriculates

Janet McCandless

The Mac's entry into the higher education market will yield immediate and long-term advantages for Apple Computer. The benefits range from direct user analysis to future courseware developed in the universities. According to Dan' Lewin, college marketing manager of Apple's University Consortium Program, "higher education is the focal point of the marketplace for research and creativity. What happens there migrates." The endorsement of the Mac by 24 major universities will influence the business community and enhance Apple's reputation as a technological innovator.

Apple entered the academic market with a new product at a crucial time. "Major institutions were making serious decisions during the latter part of 1983 for academic 1984 and 1985. The Apple II and III family was not being considered," says Lewin. Within the universities, decision makers were being advised against purchasing 8-bit computers.

Apple had a 32-bit processor with the Mac, but "we needed to expose the decision makers to our system." Apple targeted well-known institutions in the middle of their planning process, schools that had a history of faculty involvement in courseware.

Apple built a market in the educational community with the Apple II. In the late 1970s and early 1980s, Apple went to the Minnesota Educational Computing Scholarship (IRIS) set up on campus, faculty will be given assistance with computers and developmental aid in generating courseware, as well as time off and the help of programmers. The school hopes to create a number of unique applications for computers by making access to them broadly based enough to include the entire university.

"Hypertext" is an innovative approach to scholarship that was pioneered at Brown. Imagine an annotated version of Shakespeare, James Joyce, or Tennessee Williams that, instead of referring you to other works by references and footnotes, allowed you, in effect, to travel down the knowledge tree to the passage cited. Hypertext allows the program creator to insert levels of notes "behind" any part of a text (or a drawing or a set of figures). Readers can highlight a word, bring up successive windows with layers of meanings, and climb through one to another. In a pilot program conducted in 1976, students in a poetry survey course were able to do just that, by using a mainframe computer tied to a terminal. In those days, windowing wasn't so refined. Now, "sound windows" aren't far from joining the Mac's text and graphics capabilities.
Community

Courseware development proposals have come from all areas of the liberal arts: Archeology wants to plan excavations, Architecture to design buildings, Theater Arts to design sets and keep track of ticket sales, Linguistics to do research on dictionaries and thesauruses, Athletics to design and store game plans, and Music to design a music editor that generates scores for all the instruments in an orchestra or that, hooked up to a sound synthesizer, creates music. Languages that don't use the Roman alphabet will be able to write in alternate character sets.

Courseware development proposals have come from all areas of the liberal arts.

Brown is making an aggressive $50 million investment in workstations and networks over the next five years. Perhaps most intriguing is the fact that this program is not targeted for the hard sciences and traditional engineering disciplines but for the overall liberal arts education, especially the arts and humanities divisions. The program is a bold move toward taking the computer out of the scientific back room and putting it into the study.

University of Michigan

Joseph Wein, 22 years old and a senior computer engineering student, works in one of the University of Michigan engineering school's computer workrooms, where more than 60 Lisa workstations line up under one roof. "We opened in September and for the first few days people just came in to look around," Wein explained. "The system has a good introduction program, with the graphics and windows and all, but the place was just too huge. Now, three months later, everyone has discovered that it's easy to do work that's not 'unique' to a computer, like writing resumes and reports, and the Lisas are getting busier and busier. People are already starting to rely on them. We can't wait to get the same thing going with the Macs." (Michigan's Lisas will be upgraded to the Lisa 2s within the year.)

By fall of 1984, the College of Engineering, which has 5500 students, 350 faculty members, and a dozen disciplines, will have more than 700 Macs clustered in groups of 20 to 30 throughout the seven buildings that house the college. There are plans to place Macs in residence and study halls as well as in libraries and departments. The faculty is being encouraged to buy Lisas with $5500 "blank checks" from the college—money apparently collected from university "overhead" payments on faculty research grants. College of Engineering students are being levied a computer use fee of $100 per semester. That's a pool of more than $500,000 per year for equipment, networks, and maintenance.

"We're ready to resell all our obsolete equipment and completely turn over the system every four years," asserted professor Richard Phillips, director of the Computer-Aided Engineering Network for the college. "You can't tell students that you'll take their money but that by the time they graduate, their equipment will be out of date.

"We'll turn out engineers used to more advanced equipment than is available in many industries. In return for the computer use fee, we've promised them an opportunity to work with the latest equipment. If that means scrapping 'new' equipment, so be it.

"We've also developed important corporate and government sponsors, as well as major university support for the development of courses and research utilizing these tools. Our goal is a fully operational college-wide network within two years. With the consortium price advantage and the introduction of the Mac, we just felt we couldn't wait any longer."

Although only the College of Engineering is involved in this particular program, the rest of the university is watching the experiment closely. But the 40 to 45 percent price breaks that Michigan will be able to offer its entire student body through the University Consortium should make for some brisk sales at the student store. With 36,000 students and over 3500 faculty, the Ann Arbor campus should do a tremendous amount of computing.

Stanford University

"It's the hottest box I've ever seen," insisted Dr. Michael Carter, director of the Instruction and Research Information Systems (IRIS) Center at Stanford, referring to the Mac. "Whether you put it in front of computer scientists, engineers, programmers, or people who've never used a computer before or even actively hate them, in minutes they all love the little engine. The ease of putting one together is also very significant, because you can use it immediately."

"The lab opens at noon, and all day long there's a crowd around the Macs. We have at least one of each
There are plans
to place Macs in residence and study halls as well as in libraries and departments.

a Mac, and I'll make it sing. Others need to be taught and given student programmers to write code. Either way, that's what we're trying to do—get our faculty into the box.

The big advantage of the Mac is that you can 'storyboard' an application. Even if you don't know much about programming, you can draw what you want the machine to do for you, put the pictures into files, and then bring in someone who can translate them into code. With the Toolbox routines, all our applications will have standard user interfaces. The object of our development program is to get the faculty to create their own applications for their courses. The Mac makes that feasible.

According to Carter, Stanford has no intention of requiring all students to have a Mac or any other personal computer, at least not in the near future. The university intends to pass on the pricing discount to students, faculty, and staff through a combination of institutional negotiation and the University Consortium's price break, but the computers will be the personal property of each buyer.

The machines will be available through a non-profit campus organization called MicroDisc (Microcomputer Discount), but the intention is not to sell a full line of peripherals and enhancements. Stanford will provide the basic Mac, a printer, and some software at a substantial discount. Upgrades and more advanced software must still be purchased at computer stores. MicroDisc will be solely a warehouse that fills orders.

There will be clusters of Macs at various locations throughout the campus for those who opt not to buy their own machines. Already in operation is an experimental computer classroom called SMILE (Stanford Microcomputer Instructional Laboratory Experiment) where a dozen Macs sit side by side with a dozen IBM PCs. When classes aren't being conducted in the room, student volunteers chosen by ads in the campus newspaper will be given a minimum of instruction and then asked to document their experiences in learning to use and subsequently operate the computers.

"The ideal for us would be to have groups of Macs in public places like the library," Carter concluded, "so a student could go to a reserve room, check out the current assignment for a course on a Sony microflop disk, and get to work. Or, if he had his own machine, he could download the program to his disk and go back to the dorm to study.

"But we're not going to demand that a student have a machine. Through its purchase agreements, the university is giving people advice on their own personal devices. We want to fill in the gaps and provide access to excellent machines for everyone on campus. Through programs like the University Consortium, we'll make the best equipment that we can find available to our community at favorable prices.

"The university's own financial investment will come in putting money into programming and the development of courseware. We're hoping to generate a Lisa/Mac 'lore' here on campus. Someday, the microcomputer will be more like a textbook than a calculator, and the Mac is the first one I've seen that really shows such potential."
The International Macintosh

Jonathan Littman

It seems my Italian wasn't as rusty as I had imagined. I discovered this not by reading an Italian book or ordering cappuccino, but by computing with a Macintosh personal computer—the Italian version. Face-to-screen with an Italian Mac, I saw Italian words where I was used to reading familiar file headings: Archivio and Composizione instead of File and Edit. Though the words were Italian, I could operate this Italian Mac just like any Mac. I simply moved the pointer over Archivio and double-clicked the mouse button to open a file. Then I could write a letter in whatever language I pleased. When I finished writing, I just opened the Archivio menu again, this time moving down to where I was used to seeing "Close" on the English version, and I gave the Italian command to close: Chiudi.

Since I knew the English commands, I could guess the meaning of the Italian words by their positions. But what makes the Italian Mac easy to use is that it is based on pictures. And even though each picture on the Italian Mac has an Italian label (for example, Cestino for trash can), you don't need words when you have pictures.

The team that developed the Mac was in a unique position to create an international computer. Since Macintosh was originally a separate division of Apple Computer, it had both the freedom to develop its own product and the support of a large corporation. That support, says Joanna Hoffman, international product manager for the Mac, put the Macintosh division in the enviable position of "designing a computer the way we wanted it." Unlike at other computer companies, there was no need to convince management of the worth of an innovation. Steve Jobs, chairman of the board at Apple, led the original Macintosh team and wanted the Mac to be an international machine from the beginning.
Since the United States is by far the largest consumer market, most computer companies don’t bother to take on the expense of designing international computers. The French ambassador of the Mac team, product manager Alain Rossman, explains why Apple decided to take that extra step with the Mac: "We wanted the Mac to reach the most people possible. The best way to do that was to be global."

Most European computers are based on current American operating standards such as CP/M or DOS, making knowledge of at least some English necessary. Hoffman feels that English is still part of European computers because European manufacturers think their customers will put up with it. "Ironically, we are more concerned about their customers. Because we are interested in a much broader base of users, we are eliminating the need to know English." Perhaps only a European can understand the importance of that change. As Frenchman Rossman puts it, "I remember when learning to use a computer meant always having a dictionary on my knees."

The desire to make the Mac international is common among the people working on it. "Since I know all the software engineers, if there’s something I want changed, they do it because they too are excited about our project," says Rossman. Hoffman adds, "When they come in to show us something and we tell them it won’t work internationally, they don’t argue—they just realize that that’s the way it has to be." Commitment was only the start. Creating a truly international computer required much more than simply giving the computers intensive language courses and one-way tickets to foreign ports. It meant exploring new ways of learning and working with computers to cut across languages and cultures.

Talking Pictures
Much has been said about how the Mac’s graphics capabilities make it an easy computer to use. Those same graphics help to make the machine international, and the graphics don’t stop with the Mac’s software. The back of the computer and even the box the Mac comes in speak an international picture language. Holding the Mac box, Joanna Hoffman explains, "You’ll notice that there are no words on the box. We have pictures and symbols for virtually everything. We call them icons. Some people think that the pictorial orientation is a gimmick, but it’s not. We have the same box and the same hardware for every country. Pictures can communicate to the whole world."

Once you open the box, you don’t have to worry about which plug goes where. The back of the Mac’s plastic case has icons (wherever possible, international symbols) instead of words above the ports (see Figure 1). Each icon represents a device that can be plugged into the Mac. For the external speaker there is a picture of a musical note, for the disk drive a picture of a disk drive, and so on. And when a picture isn’t necessarily worth 1000 words, as with the on/off switch, the numbers 1 and 0 have been used to represent power and no power.

While the icons on the Mac’s box and plastic housing are helpful, it is the Mac’s internal hardware that distinguishes it from other “international” computers. The ROM (read-only memory) chips, the memory the Mac uses to store its operating programs, have not a word of English. Rossman says, "There is no ‘Ready’ in the code—nothing depends on words. We have one ROM for the world, and we are not going to burn new ROMs for Italy, France, Germany, or other countries." All the programs are written in assembly language, which is the most fundamental programming language, next to the computer’s actual machine language. And that is why no alphabet or character sets are in ROM; individual languages and the different alphabets they may require are handled by the Mac’s software.

Real World Software
The Mac’s software communicates with users graphically. It uses icons that make the world of computing less complicated and more familiar. When a disk is started up, the screen resembles a desktop; it has icons of files, folders, application programs, desk accessories, and even a trash can in the bottom corner. That’s why I could use an Italian Mac even though I understood only half the words on the screen. No need to remember and type commands—I simply moved and manipulated icons on my desktop. (Each icon is also conveniently labeled with a word or words.)
Figure 1
The back of the Mac. Instead of words, the case has icons above the ports that represent devices that can be plugged in.

Also, the mouse makes operating a computer more like a game than a chore. And because you don't have to type to control the computer, a major barrier to international personal computers dissolves.

People who have struggled with language-based computers, such as those made by IBM, Apple, and Commodore, may be surprised that an international computer can be simple to operate. Rossmman thinks that when users run the Mac for the first time, "they see that the computer emulates the real world. And once they realize that you can grab and drop objects, they understand the rules of the Mac, which are very much like our world."

What Rossmman and Apple are betting on is that the world of the Mac will be addictive: someone initiated into the graphics-oriented, international world of the Mac won't be interested in the tedious, mechanistic world of traditional computing. "It is very unlikely that first-time users will ever want to use another computer. Why should they want to type commands like "copy: b"? when they can do that on the Mac with a simple movement of the hand?" he pondered.

International Resources

The Mac's worldwide graphics are an international language in themselves. By eliminating the need to understand English, the Mac has opened itself to Europeans and other non-English-speaking peoples. How does the Mac avoid English when other computers and software inevitably lapse into it? The Mac international group decided that all Mac applications should work similarly and that all translations should be consistent. Bruce Horn of the Mac software development team discovered that only certain parts of programs vary from country to country and that those parts could be "separated" from the body of a program. Basically, he "glued" to the side of every program a place for its language/cultural support system. That part of a Mac program is called the resource files. It's an ingenious way to make it easy to adapt a program for another language and culture—without changing the basic functioning of the original program. For example, the Italian Mac has an Italian set of resource files. They give Italian labels to the icons, have Italian words for the menus and dialog boxes, and accommodate the European forms for dates, numbers, and words.

The modular aspect of resource files facilitates translation of software developed on the Mac. Only the resource files must be changed. To encourage this international exchange of software, Apple has set up in participating countries "localizers" who will act as intermediaries. When individuals or companies in one country express interest in software created in another country, the localizer translates and adapts the resource files for the countries that desire the software and arranges for translation of the accompanying documentation.

Why was translating software difficult before the invention of resource files? There were problems with licensing programs in other countries, and often authors lacked the knowledge or the time to modify their programs for other languages. Hoffman hopes that resource files will eliminate these problems: "Now the third party never has to see the software.
developer's secrets—how they do their algorithms and how they code. All they need to see is the resources.” Rossman thinks that resource files and third-party localizers may go a long way toward unifying the traditionally fragmented European market: “The Mac offers all software developers (including Americans) the prospect of European and worldwide markets. Now, if someone in Germany writes a great program, it can be translated and published in the rest of Europe and even the rest of the world.”

The resource files for the Mac's standard software have already been completed for many of the international versions of the Mac. Curiously, most of the original creators of those programs have never seen the international clones of their software. Just for fun, the Mac international group is planning to re-release the software to its authors. Rossman thinks that it will be interesting to see how the authors react to “new” versions of their own creations. “Bill Atkinson, who developed the graphics routines of the Mac and Mac-

Paint, was in Quebec for an unveiling of the French Canadian Mac. He was really excited to see his work in another language.”

The Right Accents

To ensure that the words used in independently written international software are consistent, localizers have been given a data base of terminology for European languages that provides all the Mac-specific words. “We want consistency—one word for window in each language and one word for mouse. We don’t want them to end up calling it a rat in one language and a hamster in another,” says Hoffman. This same care has been taken in translating the software that comes standard with each international version of the Mac. In some cases, more than one version was necessary for a language. For example, a special French version was written for French Canadians and another for the Swiss.

The words that appear on the screen and in menus are not merely translated. Hoffman says, “We spent an inordinate amount of time going after each word and asking what makes sense in each language, who is our customer in each country, what kind of word is right, and what approach seems proper? We asked questions such as, ‘Should we talk to this person formally or informally?’ The translated software is then tested in its native country. Because of this painstaking process, each Mac and its software end up reflecting the people and

Because all the Mac keyboards are modular, you can plug in keyboards for several languages on the same Mac.
the language for which they were designed. For example, the Italian Mac treats you like a buddy, whereas the relationship between the user and the German Mac is more formal and polite.

Federico Vitaletti, who was in charge of translating software for the Italian Mac, explains why he chose an informal style:

**The Mac’s icons make computing less complicated and more familiar:**

"In Italy the second-person singular is very friendly, and it is used more often than in languages such as French and German. Since Italians are comfortable using the second-person singular with their friends and co-workers, we decided to talk to the Mac in the same way.” Such a distinction is impossible in English. To open a file on the American Mac, the pull-down menu on the screen just says *Open*. On the Italian version of the Mac it says *Apri* (You—the Mac—open). Loosely and probably more meaningfully translated, this would be more like ‘Hey Mac, open up a file.’

The nature of Italian (and other Latin languages) creates a special relationship between users and the machine. What appears in menus more closely simulates spoken commands. You are talking to the machine, giving commands, and the machine, if not a friend, is at least a co-worker. English is neutral to this fine distinction. Since English-based computers seldom clarify who is talking, there is little sense of dialogue. Latin languages make it easier to create the idea of an almost human interchange between you and the computer. They also make it clear who’s in the driver’s seat.

**Multilingual Computing**

With the Mac, people will not only be able to compute in their native language, they’ll also be able to write letters or other documents in many different languages. The Key Caps desk accessory in the Apple menu displays a keyboard on the Mac’s screen that shows the full international (or alternate) character set, including things such as accents and Greek letters. These characters are implemented when you press Shift, Caps Lock, or Option in combination with another key. Using the international characters, an American could write a German report in the morning, an
Community

English memo at lunch, and a French love letter in the evening—all with the standard American keyboard. The international character set makes one keyboard (whether French, German, or American) good for all Latin-alphabet languages.

Each international Mac comes with its own keyboard, which has 59 keys (the international standard used throughout Europe and the United Kingdom). The French Mac has a French keyboard with French accents, and the Italian Mac has an Italian keyboard with Italian accents (see Figure 2). Also, the keyboards are based on international design standards. But since the keyboards are modular, attached by plug to the Mac, other keyboards can also be purchased for the same Mac. If you bought an American Mac and then purchased an extra French keyboard and software, you would have a truly bilingual computer. Simply by changing the keyboards and inserting the French software, you could transform your computer into a French Mac. It is easy to imagine how universities might take advantage of this capability: Students of different nationalities could share the same Mac by using different keyboards and software.

An international computer should promote international communication, and the Mac promises to do just that. Computer communications is highly regulated in Europe, unlike the relative freedom in America. The sale of modems (communications devices) is tightly controlled in most countries. Since Apple can't sell modems in Europe, they've done the next best thing. Each European Mac comes with a EuroConnector, a plug that converts the Mac to accept the European standards for modems. Since all Macs have the same communication ports (serial ports), information can be sent easily from one Mac to another by telephone. Making communications easy on the Mac will hopefully case some of the international controls on communications.

On the Horizon

Remember resource files? Although they were developed initially to meet the specific needs of international and domestic software developers, at some point even the most technically unsophisticated users may be able to use them to customize or "internationalize" their Macs. Ron Sebok is one of the Mac team programmers working on the resource editor. She reports that, without having to do any programming, you could use the editor to change virtually anything in your resource files, including the language used by your Mac or even the way your programs look.

Eventually, you may be able to do something like the following. Suppose you don't like the picture of the trash can on the screen. You will be able to change it into a wastebasket simply by arranging dots in a gridded box 32 by 32 bits (dots). No programming will be necessary. You'll simply save the new picture you've drawn.

![A French MacWrite document. The ruler is scaled in metric units, and accented letters are included in the standard character set (as they are on all European versions).](image)

![A French MacPaint document with the Goodies (Facilités) menu pulled down. Standard letter paper in France is approximately 8¼ by 11¾ inches, and MacPaint's proportions were modified to take this measure into account.](image)
The program will identify that icon (the former trash can), and the next time you use the Mac you’ll be able to dispose of your trash in your new wastebasket.

One thing Sebok likes about the resource editor is that it lets people “program without actually realizing that that’s what they’re doing.” She hopes to introduce people throughout the world to a kind of programming with pictures that everyone can understand. Each user will decide how the computer looks and feels. And the whole world will enjoy this freedom.

The first international delivery of Macs will be to the United Kingdom, Germany, France, Italy, and Australia. The second international delivery will be to Holland, Spain, Switzerland, Belgium, and Latin America. Languages that don’t use the Roman alphabet, such as Japanese, Arabic, and Hebrew, require much deeper reworking of the Mac. Rossman remarks, “The Japanese version presents a dual problem. First, we have to make the machine capable of an 8000-character set. There will have to be changes in the hardware inside the machine. Then we’ll need to design a keyboard capable of accepting that huge character set. We will also have the task of translating all the documentation and software.”

Rossman admits that it’s going to take a lot of work to get the Japanese version out. “Remember, it will be the first time that Japanese people type. There is no standard for that task because all business communication in Japan is handwritten.” He estimates that Japanese Macs will be available in six to ten months.

The changes necessary for the Arabic and Hebrew versions should be less extreme since the character sets of those languages are a standard size. Still, problems must be worked out, such as changing the machine to read and write text from right to left as is characteristic of Hebrew and Arabic.

What will the international design of the Mac mean to the people around the world who will use it? Perhaps they will be able to take advantage of software development going on at various companies and universities. They may also take part in a relatively new phenomenon: international personal computer communications. The Mac international group has worked to create a computer that people can understand and share intuitively, regardless of nationality or language.
Macworld Gallery

An exhibition of Macintosh graphics

Edited by Erfert Nielsen

This month's Macworld Gallery presents the work of seven Mac artists. Their drawings range from loose, freehand illustrations to meticulously executed copies of photographs and woodcuts. Although their backgrounds are as diverse as fine arts major and "absolutely no artistic ability in the past," the creators all share an enthusiasm for the Mac's graphics capabilities. Several drawings represent contributors' first efforts on the Mac.

To be considered for exhibition in Macworld Gallery, send a paper copy of your drawing and a short paragraph describing the techniques you used to create it to Macworld Gallery, 555 De Haro St., San Francisco, CA 94107. Macworld pays $25 for each drawing exhibited. If your drawing is selected, we will ask you to send a copy of it on disk.

Sky and Water
**Sky and Water**
This drawing is a copy of an M. C. Escher print. It began with the bird and fish shapes in the center, which were drawn freehand. I made copies using the lasso and the Option key, and dragged them horizontally across the screen. All detail work was done in FatBits. The border began as rectangular, filled patterns, but a good deal of work in FatBits produced the irregular quality of the lines.

*Scott Kronick*
*Berkeley, California*

**Two Intersecting Planes**
This drawing is also based on an Escher print. I used the lasso to make copies of the birds and the fish. I flipped objects horizontally and shrunk them proportionally (by holding down the Shift and ` keys simultaneously). FatBits took care of the majority of drawing and cleaning up. Once the shapes were drawn, I created four custom patterns using the Pattern Edit feature and applied them to fill in the outlines.

*Scott Kronick*
*Berkeley, California*
Taj Mahal
This picture was created without drawing freehand, except for the brushwork in the wisps of cloud, the water, and the shading on the domes and the towers. I made copies of portions of the building and flipped them horizontally to create the opposite halves. I flipped the image vertically to make the reflection in the pool, then used a few paintbrush strokes to break up the reflection and make it more realistic.

It was difficult to copy portions of the picture and move them around, because the whole picture was larger than the active screen. I had to copy fairly small portions, flip them horizontally or vertically, and move them little by little as I adjusted the active window. Although the process was painstaking, I think this technique is much less time-consuming and tedious than drawing all the pieces separately.

David Axworthy
Oklahoma City, Oklahoma

Archaeopteryx
One of my hobbies is paleontology. I have always wanted a tool with which to create detailed free-form drawings. MacPaint fills the bill.

The drawing was done completely freehand. The first step was to rough in the outline. Next, I used the paint bucket to fill in the black sections. The feathers and the underbody I brushed in with the single-dot and small, diagonal brushes. The head, the forelimbs, and the legs were done one dot at a time in FatBits, as were other detailed features such as the eyes, the teeth, and the talons. FatBits was also ideal for providing the “scaly” appearance of the legs and the claws.

Carl Flygare
Englewood, Colorado

Archaeopteryx lithographica
Chinese Shrimp
I thought the Mac's black-and-white display would be ideal for an Oriental-style brush painting. I selected a shade of gray from the pattern palette and drew the shrimp with the small, round brush (except for the antennae, which I drew with the single-dot brush). Then I added a little shading in a darker gray. To make the "seals" I used the rectangle tool, then drew the characters in FatBits. The calligraphy in the lower-right corner was drawn with the small, diagonal brush and cleaned up in FatBits. I had to shrink and elongate the bottom character (using the $ key) to make it match the size of the other characters. The border pattern is from the pattern palette, painted with the large, square brush while holding down the Shift key (to paint in straight lines).

Dolores Hays
Oakland, California
Chessboard
Since my chessboard happened to be set up near my Mac, I decided to draw a few of the pieces. I drew the board using the straight-line tool, and filled in the black squares with the paint bucket. Then I sketched the chess pieces freehand with the single-dot brush and tidied them up in FatBits. I used the spray can to paint in gray to shade parts of the pieces and later sprayed over that in white when the shading was too dark. The original version of this drawing had another piece in it, but I didn’t like the way it looked so I erased it. It took me only a few minutes to erase the figure and redraw and fill in the squares of the chessboard. I couldn’t have done that with a pen-and-ink drawing.

Rhonda J. Hinton
Boulder, Colorado
Illuminated Letter

This type of letter used to appear as the first letter in illuminated manuscripts and illustrated books. The background was created using freehand drawing. FatBits was used to smooth outlines and add fine shading, and special keys helped reproduce panels and rotate the frame corners. The letter itself is the result of an outlined, boldface, London character, enlarged using the $k$ key; the outline was redrawn in FatBits to smooth it out. The letter was then centered over the background with the lasso. Note the apertures “cut” into the center spaces of the letter to allow the background to show through; these were patched up after the letter was properly positioned.

Charles A. Schleper, Jr.
Olathe, Kansas
Cobra and Bentley

I used transparencies made from photographs of the two vehicles (the Bentley from an original and the Cobra from a magazine) and scaled them to the size of the MacPaint window. A little water on the back of the transparencies affixed them to the screen. I blocked in the outlines and the major shapes using the hollow polygon and the hollow circle. Then I cleaned up the outlines and rounded the sharp corners in FatBits. The paint bucket was used for block shading. More than once I was rescued by the Undo command after the shading “spilled out” through an overlooked opening! Next came blending, shading, highlighting, and detail work in FatBits.

I’m pleased with the details in both drawings. Note, for example, the nearly legible “GOODYEAR” on the front tire of the Cobra.

Bruce Kirkpatrick
Phoenix, Arizona

1965 Cobra Daytona Coupe

1937 Bentley
World Events

A calendar of regional and national events

Edited by Erfert Nielson

World Events lists computer-related conferences, conventions, workshops, symposiums, trade fairs, and shows. If you know of an upcoming event, we'd like to hear from you.

April 26-29
Third Annual New York Computer Show
Nassau Coliseum
Long Island, New York
A general computer show featuring hardware and software.
Northeast Expositions
822 Boylston St.
Chestnut Hill, MA 02167
800/343-2222, 617/739-2000

May 14-18
Technical Introduction to Apple 32 Systems
Palo Alto, California
A technical seminar conducted by Apple for experienced Pascal programmers who are involved in software development for the Macintosh and the Lisa. The seminar includes an introduction to the Mac Toolbox development tool.
Apple Computer
Developer Relations Dept.
20525 Mariani Ave.
Mail Stop 23-AF
Cupertino, CA 95014
408/973-4538

May 22-25
COMDEX/Spring
Georgia World Congress Center/Atlanta Apparel Mart
Atlanta
A computer trade show with emphasis on personal computers, peripherals, and software.
The Interface Group
300 First Ave.
Needham, MA 02194
617/449-6600

June 3-6
Consumer Electronics Show
McCormick Place
Chicago
A trade show with displays of computers, peripherals, and other electronic devices.
Consumer Electronics Shows
3 Illinois Center
303 E. Wacker Dr. #945
Chicago, IL 60601
312/861-1040

July 9-12
National Computer Conference (NCC '84)
Las Vegas Convention Center
Las Vegas
A general computer show with 370,000 square feet of exhibits, 90 technical sessions, and 25 professional development seminars. This year's theme is Enhancing Creativity.
AFIPS
1899 Preston White Dr.
Reston, VA 22091
703/620-8900
Macworld Authors

David Bunnell, Publisher of Macworld, is the founder of Personal Computing, PC, and PC World magazines. He participated in the creation of the first personal computer, organized the first personal computer trade show, and published the first magazine having a bound-in floppy disk.

Daniel Farber is the Associate Editor of Macworld.

Andrew Fluegelman is the Editor-in-Chief of Macworld and PC World. He is the author of the popular communications program PC-talk and coauthor of Writing in the Computer Age.

Steve Lambert is a freelance writer and the author of Presentation Graphics on the Apple Macintosh, forthcoming from Microsoft Press.

Jonathan Littman is a freelance writer based in San Francisco and a regular contributor to PC World.

Cary Lu is an Executive Editor of High Technology magazine. He has worked as an independent film producer for "Sesame Street," as an associate producer for "NOVA," and as the science and technology adviser for The Children's Television Workshop.

Janet McCandless is the Editorial Manager of Macworld.

Erfert Nielsen is a copy editor for Macworld and PC World.

Lon Poole is a Contributing Editor of Macworld and the author of several computer books including The Apple II Users Guide and MacWork, MacPlay, forthcoming from Microsoft Press.

Andrew Singer is a Vice-President of Think Technologies of Danvers, Massachusetts. He is the principal designer of the Pascal Assistant, an educational environment designed for CDC Pascal, and the coauthor of Elementary Pascal and Elementary BASIC.

Charles Spezzano is a clinical psychologist in the Denver area. He has written articles for several computer magazines, specializing in word processing and data management for professionals.

Jeffrey S. Young is a Contributing Editor of Macworld and a freelance journalist who has written for several national publications including Esquire. He is currently working on a book about MacPaint for Microsoft Press.

Advertisers

Reader Service Number Advertiser, Page

7 American Training International, 10
8 Apple Computer, 21
12 Chang Labs, 85
15 Cuesta Systems, 94
17 Davong Systems, 145
9 Hayden Publishing, 45
16 Howard W. Sams, 95
11 Kensington Microware, 18, 109
6 Leading Edge, IFC
2 Manhattan Graphics Corporation, 65
17 Media Systems Technology, 27
3 Micro Flash Computer Systems, 84
Microsoft, 6-7
15 Microsoft Press, 15
13 Odesta, 46-47
1 MAC Connection, 103
14 Tecmar, Inc., BC
10 Think Educational Software, 94
5 Verbatim, 17
Reader Inquiry Service

Would you like further information on a product that's advertised in Macworld? Well, it's easy and best of all—FREE!

Just follow these simple instructions:

• Print or type your name and address on the attached card. One card per person, please.
• Circle the number(s) on the card corresponding to the Reader Service number in the Advertiser Index.
• Drop the card in a mailbox and wait to receive the literature that will be mailed to you free of charge from the manufacturer.

The address on the attached card is for product information only.

Send editorial comments or inquiries to: Macworld, 555 De Haro St., San Francisco, CA 94107.

MACWORLD
The Macintosh Magazine

Survey

Will you please take a few minutes to answer the following questions? Your answers will be kept in strict confidence and used only in combination with others to develop a profile that we will use to learn more about our readers.

A. Please check whether you are:
   - Male
   - Female

B. What is your age?
   1. 18-24
   2. 25-34
   3. 35-44
   4. 45-54
   5. 55+

C. Please state your title and industry:

D. What was the last level of education you completed?
   1. Completed high school
   2. Some college
   3. Completed college
   4. Post-graduate work
   5. Post-graduate degree

E. What category best describes your family's total annual income before taxes?
   1. Under $15,000
   2. $15,000-$24,999
   3. $25,000-$49,999
   4. $50,000-$74,999
   5. $75,000 or more

F. Do you currently own a Macintosh?  
   - Yes
   - No

   Are you thinking of purchasing one?  
   - Yes
   - No

   If yes:  
   - For your home
   - For your business
   - For use in both

G. Do you own another computer or use one at work? Please indicate the system(s):

H. Computer experience:
   - less than a year
   - 2-5 years
   - 4 or more years

I. What kind of software programs do you find most useful?
   - Word processing
   - Spreadsheets
   - Graphics
   - Accounting
   - Data base management
   - Integrated packages
   - Games/entertainment
   - Other

J. Programming:
   - BASIC
   - PASCAL
   - FORTRAN
   - FORTH
   - COBOL

K. What kind of articles interest you?
   - 1. Software reviews
   - 2. Hardware reviews
   - 3. Personal/Home management
   - 4. Games/entertainment
   - 5. Education
   - 6. Communications

MACWORLD
The Macintosh Magazine
Meet Your New Business Team. 
Macintosh & Davong.

Apple’s new Macintosh™ is the most exciting development in personal computing since the original Apples started it all.

Teamed with Davong peripherals, the incredibly easy-to-use Macintosh becomes a powerful, flexible and expandable business tool.

Available at more than 1,000 Davong dealers nationwide is the new Davong Mac Disk system, providing from 5 to 32 megabytes of hard disk storage. Mac Disk gives you the increased capacity and enhanced functionality you need for your business applications. All at a very reasonable price and with no sacrifice in the speed and ease of use built into your Macintosh.

And coming very soon from Davong are a 28 megabyte streaming tape backup system, for fast and secure backup of your files, and a multi-tasking local area networking system to allow all of the Macintoshes in your organization to share information, programs, and the advantages of Mac Disk.

See your local Davong Dealer today for details.

Davong Systems, Inc.
217 Humboldt Court
Sunnyvale, CA 94089
(408) 734-4900
Telex: 176386

Apple and Macintosh are trademarks of Apple Computer Inc.
Tecmar supports the Macintosh with a full line of Candy™ Apple peripherals. See page 1 for further information.

*Trademark of Apple Computer, Inc.